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here’s always a big buzz around September 
and October for Apple fans. They have 
become the biggest months in the calendar 

for Apple launches, and the incredible features of the 
iPhone 6s and 6s Plus once again cement Apple’s as 
the world’s best smartphones. We were equally blown 
away by the tech inside the iPad Pro and its Pencil, 
and the new Apple TV looks to finally come of age 

in both capabilities and content. Our hands-on 
experience of the new devices is over on page 6.

 Of course, it’s also finally time for iOS 9. 
We’ve been busy using the betas for months, 
uncovering the exciting new ways you can use 
your iPhone and iPad more efficiently. Find 
out exactly how your iOS device has been 
given a free refresh on page 26.

We’ve also recently seen the full UK 
rollout of Apple Pay, Apple’s contactless 
payment system. Our guide on page 76 
shows where and how to use it. Talking of 
paying, if you started your free Apple 
Music trial when the service launched 
you’ll now be paying for it every month. 
Turn to page 45 to solve some of the 
small issues that are still going on.

Also, to keep your Mac in tip-top 
condition, turn to page 40 to wise up on 
the best Mac monitoring tools.
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T
he eyes of the tech world once 
again fell on an Apple event in 
September, where the 
company showed us its latest 
iPhones. The 6s and 6s Plus 

were hotly tipped to introduce a Force 
Touch-like interface (which Apple called 3D 
Touch), and big camera improvements. As 
ever, Apple had other things up its sleeve.

Perhaps the biggest wow factor came 
from the iPad Pro. The audience at the Bill 
Graham Civic Auditorium in San Francisco 
was stunned by Apple’s powerful and larger 
tablet, which seeks to inject new life into 
a declining iPad market. It wasn’t just the 
huge screen space (12.9 inches) and 
2732x2048 resolution that whetted our 
appetites, but the introduction of a Smart 
Keyboard and stylus, which Apple, in a 

typically understated way, called Pencil. iPad 
Pro bridges the gap between iPad Air and 
MacBook, and it’s a truly exciting product 
that’s likely to see huge interest from 
developers creating touchscreen apps that 
would previously have been in the realm of 
more powerful desktop machines.

Apple also showed off new Apple Watch 
models and bands which are available right 
now, just in time for watchOS 2.

We weren’t left short on the Apple TV 
rumours though, and it turned out to be 
a big upgrade to Apple’s little black box. 
It now has its own App Store for apps 
and games, and comes with a Siri Remote 
for improved control and gaming fun!

Read on to find out exactly what we 
thought of the new iPhones, iPad Pro and 
the fourth-generation Apple TV.

The giant iPad Pro comes in the same three finishes as the iPad Air and mini: Gold, Silver and Space Grey.

Apple’s brave  
new world
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T 
he iPhones 3GS, 4S and 5s 
were all rather dull 
compared to the phones 
that launched in the years 
either side of them. That’s 

because there’s usually very little 
difference in the ‘s’ models from their 
predecessors, making it  hard to get 
excited about them.

This time around it’s a little different: 
the 6s is a great upgrade for those ‘stuck’ 
on a 5s, and it’s a decent phone in its own 
right. If you’re ready for an upgrade from 
the old design and keen to stick with 
Apple, this is a great time to go for it.

Design
The same stick that some use to beat 
iPhone fans still exists: yes, the 6s and 6s 
Plus look almost identical to last year’s 
models, with the same ceramic feel and 
slightly protruding camera; placed side 
by side with that model, you won’t really 
notice the difference. The only marginal 
change is the additional thickness, likely 
to facilitate the new 3D Touch technology 
and hopefully a larger battery, although 
there’s no word on that from Apple.

Compared to other phones available, 
the latest iPhones still manage to mix that 

feeling of premium build with a light and 
thin body that’s a joy to hold. Apple’s nod 
to the improved build as having reinforced 
7000 Series aluminium is clearly a direct 
result of the iPhone 6’s ‘Bendgate’ 
controversy, where some believed the 
phone was slightly prone to changing 
shape if pressure was applied. Though 
Apple doesn’t need sympathy, it was still a 
bit harsh that it got singled out for this 
when many other handsets could also 
bend if you tried hard enough. Either way 
it’s now much less prone to bending.

Of course, the 6s Plus needs a bigger 
battery than the 6s, but the 5.5-inch 
display feels so much more swamped by 
the iPhone’s frame compared to other 
phones, such as LG’s G4. Apple’s largest 
phone is still very light and easy to hold, 
but you can’t forget it’s a phablet. If you’re 
coming at this from the iPhone 5s, you’re 
going to be blown away by how 
gargantuan it is to hold, and even 
Reachability (double-clicking the Home 
button to bring the top of the screen 
down within reach) doesn’t really help. 
However, you’re buying a phablet, not a 
mini phone, and the bigger screen and 
battery that such a phone offers – and 
that comes with compromises.

3D Touch, but 
the same screen
Now onto the biggest 
change in this year’s 
iPhone: 3D Touch. This 
changes everything about 
using iOS, and while it’s not 
enough of a reason to 
upgrade from the previous 

Hands-on
with iPhone 6s 
and 6s Plus

The reinforced 7000 
Series aluminium is 
clearly a direct result 
of the iPhone 6’s 
Bendgate controversy



On top of 3D Touch’s shortcuts to help you get things done more quickly, the new iPhones 

ship with iOS 9, of course, and so benefit from all of its new features.

3D Touch introduces a new shortcut to open the App Switcher – a press on the left side of the screen. However, this seems to only work from the Home screen.

You’ll struggle to tell the 
the new iPhones and last 
year’s models apart; the 
new ones’ dimensions are 
0.2mm thicker at most.

model, it is a pretty nifty 
trick that promises to make 
iPhone 5s owners feel like 
they’re getting a real upgrade 
with their new phone.

The main difference it brings 
is the ability to interact with 
on-screen elements in different 
ways. It’s too early to delve into 
all the ways that it will work, but 
it’s simple: you can tap like 
before, but press a bit harder on 
an icon or a message and a new 
menu will pop up. Imagine it’s 
like right-clicking with a mouse 
to get a contextual menu and 
you’re pretty much there. It’s a 
cool new feature, although one 
that app developers will need to 
work with for a while to really get 
the best out of it.

The main barrier is remembering that 
the option is there – the act of tapping on 
a touchscreen to make things happen is so 
ingrained in most people’s consciousness that 
it’s hard to remember there’s a ‘secret door’ to 
some things. It’ll be intriguing to see how Apple 
deals with that. When you remember, it works 
nicely, and the Taptic Engine underneath buzzes 
pleasantly to confirm an action is successful.

The screen, new touchy-powers aside, is 
pretty much identical to the one seen on the 
iPhone 6. That’s not necessarily a bad thing. 
While it’s true that Apple has one of the lowest 
resolution screens of all the flagship phones, the 
way it’s displayed (laminated to the glass, highly 
colourful) means it looks beautiful nonetheless.

The 6s Plus retains the previous model’s 
1080p resolution. With other phone makers 
trending towards QHD displays (Sony even has 
a 4K phone display), content to show on them 
is still sparse. They improve the image, and it 
would’ve been nice to see Apple do something 
cool here, but given how fragile iPhone batteries 
are, this possibly isn’t the best idea.

Camera
The anticipated upgrade of the iPhone’s camera 
camera has arrived: both new iPhones have a 
12MP snapper and it looks like it’ll deliver in 
spades. The need to jump in megapixels is rarely 
warranted beyond the need to impress with 
higher numbers, but this year things are starting 
to jump forward. The Samsung Galaxy S6 takes 
stunning photos with its 16MP camera, and 

Sony’s Xperia Z5, packing a 23MP sensor and 
super-fast autofocus, actually puts its additional 
pixels to good use. Apple needed to keep up.

Just 12MP might not sound like a lot, but it 
means that the shutter speed is faster than ever, 
the clarity looks crystal clear on the larger 
5.5-inch screen of the 6s Plus, and the iPhone’s 
overall photography quality is improved once 
more. Apple must have spent a lot of money on 
its ‘Shot on iPhone 6’ campaign last year, and if 
this phone can outdo those snaps (and there’s 
no reason to say it can’t), then it will have a 
promising camera on a good phone.

While we’ve only tested the new camera 
briefly, there’s no doubt that it’s an upgrade. 
It retains the speed of snapping we’ve come to 
expect from an iPhone, while the clarity is there 
to see too. The useful features available in 
previous iPhones are also still present. Apple still 
hasn’t fixed the most annoying part of the 
camera – sliding a finger up and down to 
change the exposure as the only way of altering 
the photo, which is basic and actually quite hard 
to do; we had hoped to see a manual control.

The new Live Photo option takes a 1.5-second 
video either side of a photo 
to bring a kind of Harry Potter 
element to things. That’s 
cool, but it also feels more 
like a gimmick than a really 
useful option. What’s really 
impressive is that it doesn’t 
seem to affect the shutter 
speed – it should take a 
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of its predecessor (though, as ever, this is unconfirmed by 
Apple), with 2GB now powering your apps and creating a 
decent snap under the finger. It might not seem like much of 
an upgrade, but we expect it to blitz the iPhone 6 and 
especially the 5s in speed tests.

Early verdict
This is the most impressive ‘s’ variant of an iPhone we’ve seen 
yet, and one 5s owners will flock to. While it’s disappointing 
that Apple ‘gets away’ with releasing the same phone visually 
– no other brand could do that – this is the fourth time it has 
done so, and people still like buying iPhones. If the iPhone 
were to have a new frame, then this would be a brilliant new 
phone without exception. The new 3D Touch, upgraded 
camera and improved speeds offer tangible benefits, and 
combined with the solid upgrade to iOS 9 and the impressive 
build, Apple has made a very good phone.

If you’ve got an iPhone 6 or 6 Plus already, there’s less 
incentive to get a 6s model. For anyone on an older iPhone, or 
thinking of defecting from Android, the 6s and 6s Plus are 
worth checking out. Both new iPhones are obviously going 
to command a high price, and it’s up to you whether the 
3D Touch technology and upgraded camera are enough to 

keep you from buying last year’s 
cheaper model. But, apart from 
being so similar in design, this feels 
like quite an upgrade from Apple.

3D Touch introduces two new gestures. 
A light press on an item such as an email 
or a photo ‘peeks’ at its content. Let go 
and you’re returned to the previous view. 
Pressing deeper ‘pops’ an item open.

while either side, but it buffers while you’re taking a shot. Live 
Photos will be more a ‘remembered delight’ rather than 
something you aim to do with your pictures. 
It’s something you’ll need to remember to 
‘3D Touch’ in order to enable.

An A9 chip and upgraded RAM
As usual, Apple has thrown in an upgraded 
chip in the shape of the A9, which brings a 
number of changes. The battery will last 
longer, the device will run faster and the 
gaming experience will, once again, be better 
than anything we’ve seen before. Once again, 
it’s a 64-bit architecture, though that still isn’t 
used to its full potential to address 4GB of 
RAM; word is that the 6s has double the RAM 

All of the familiar camera features are present, for better or worse. They’re joined by Live Photos, but you need to remember to perform a deep press to capture one of those.
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T 
he iPad Pro is the device we thought we’d never 
see – it’s Apple finally taking on the enterprise 
market, but like with its MacBook range, the 
new, larger iPad makes non-business folk 
thinking about whether they’d fancy one too.

The reason is simple: this thing has got a massive 12.9-inch 
screen with an impressive resolution of 2732x2048 pixels and 
a bunch of fancy new tricks that, combined with iOS, offers a 
really compelling experience. The main thing you’ll notice is 
that it is, well, huge. Really big in the hand, to the point of 
feeling like you might be able to defend yourself from an 

attack if you’re holding it the right way.

Design
The iPad Pro is a little hefty at 713g, but that 
doesn’t tell the whole story. This is a tablet with 
a brilliant screen, powerful speakers and a great 
accessory ecosystem. We can’t help but feel that 
Steve Jobs would have had something to say 
about the Apple Pencil, which allows you to 
annotate and sketch among other things, but 
if you’ve watched Adobe’s demo, laying out 
magazine pages, you’ll understand it.

The iPad Pro might sound like it’s designed for 
the enterprise sector, but it’s just a really decent 
work tool fused with a top-of-the-range tablet. 
With no new iPad Air on offer this year, this is 
Apple’s most advanced iPad, and so it has to be 
seen as much a consumer item as anything else.

It’s clear iOS 9’s split-screen view was made for 
the iPad Pro, as there’s so much that you can do 
with that screen real estate. It’s infuriating when 
companies show a tablet’s power by shrinking a 
movie to the size of a stamp so you can do other 

things in the background, 
but again Apple’s done it. 
However, this isn’t a new 
trick – the Samsung Galaxy 
S3 could do it in 2012.

The split-screen view is 
good because most of the 
time it’s not proper split 
screen, and that’s the right 
thing to do. This is still a 

The Apple Pencil’s Lightning connector is 

longer than others so you can top up its 

charge even when the iPad Pro is in a case.

Hands-on 
with iPad Pro

tablet, not a laptop replacement, so you don’t need a million 
windows open at once. Keeping an eye on news while using 
Excel is good when it’s just a column slid in to the right.

Pencil and Smart Keyboard
The upshot of the iPad Pro is that it’s fantastically powerful, 
and can do pretty much anything offered by app developers 
today. From hi-res graphics to pressure levels from the Apple 
Pencil… it’s all well within its capabilities.

The Pencil is an odd thing to have added in. It’s very good 
at sketching – one of the best we’ve tried when it comes to 

The iPad Pro is huge, and 
running two full-size apps 
is appealing. It feels like it’ll 
be as good for entertainment 
as it will be for business use.
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rubber-clad. You think you haven’t hit the spacebar and a few 
letters, then you check to see it’s all been registered perfectly.

It’s similar to the new MacBook’s keyboard, where the travel 
doesn’t feel traditional, but still works really well. Its magnetic 
dock works great as a cover, and the Smart Connector could 
bring good things to the aftermarket as it can send power and 
data to the device from the cover. Even with so many pixels, 
battery life is apparently iPad Air-like, which is impressive.

Early verdict
The iPad Pro is a large beast, no doubt, but it takes the Air’s 
endearing stylings and creates something that straddles  
business and leisure. Apple will hope it will be a revelation to 
its brand like the Surface 3 has been to Microsoft. A lot will 

depend on cost, but given Apple’s clever software 
tweaks and accessories, there’s a lot to be 
intrigued by. Whether that converts to sales 
remains to be seen. It’s almost a shame that 
it likely won’t enjoy iPhone-level sales, as 
developers might not rush to make apps for 
it. While Tim Cook was quick to point out the 
alliance with IBM and Cisco, this feels more 
like a consumer device. We can see it being 
perfect for leafing through papers or comics 
on a lazy Sunday, or as a replacement for 
watching Netflix in bed using a laptop. 
It’s not even that expensive... which feels 
odd to say about an Apple product.

The iPad Pro uses a Lightning connector, thankfully, rather than confusing the iOS range with USB-C.

Split View is a revelation on the iPad Pro as the screen is large enough to show two full-size iPad apps (in portrait) side by side when the device is in landscape orientation.

The Apple Pencil 
is reckoned to 
take 15 seconds 
to build up  a 
30-minute charge.

handwriting recognition – and it didn’t 
get confused by a fist rubbing the screen 
at the same time. But for $99 (around 
£64), it’s a costly add-on to an already 
expensive tablet. However, the ability 
to shade, annotate and more is really 
impressive, and the response from the 
iPad Pro is perfect.

The Smart Keyboard is also nifty. 
While it’s expensive, the keys have a 
very accurate travel despite feeling 

Picture in Picture mode enables you to watch 

web videos and those in the Videos app in the 

corner of the screen as you use apps.
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is a touch-sensitive surface that replaces the old 
remote’s awkward ring-like directional control.

The remote communicates your input over 
Bluetooth 4.0, so there’s no need to point it just 
to navigate menus. This helps to facilitate its key 
feature: you press a button and then speak to tell 
the Apple TV what you want. It ought to work 
better in the relative quiet of a living room than 
in public, and this implementation of Siri seems 
smart – necessarily so to justify Apple’s claim of 
revamping the way TV works – so you can, for 
example, request action films and then ask it to 
filter results to those starring a specific actor. 

Set in motion
The Siri Remote also contains a gyroscope and 
an accelerometer. If that makes it sound a lot like 
the controller for Nintendo’s original Wii console, 
that’s exactly it; an on-stage demo at Apple’s 

event showed a rhythm 
action game, Beat 
Sports, using similar 
movements to the 
memorable (and nine-
years-old!) Wii Sports.

A Remote Loop, sold 
separately, attaches to 
the Lightning port to 
stop you flinging the 
remote across a room. 
We hope it has a strong 
locking mechanism.

It might be some time 
before we see whether 
Apple can kickstart the 
legacy laid down by 
Nintendo, which seemed 

A
t long last, Apple has unveiled its 
fourth-generation Apple TV with 
the feature we’ve been clamouring 
for: apps and games. The device is 
at long last growing up – literally 

so in the case of its body, which is the same 
width and depth as before, but 12mm taller.

Yet Tim Cook’s proclamation that “The future 
of TV is apps” sounded a little bit blind to what 
the world has been doing with games consoles 
and some other set-top boxes for years. But apps 
and games aren’t the whole picture.

The special sauce in this new TV experience 
lies in the accompanying Siri Remote. It’s a similar 
size and shape to the old aluminium one, but 
with six buttons clustered around its middle. 
Below them the body is glossy, and above there’s 
a different finish that tips you off that there’s 
something different going on up there. That part 

to have been thoroughly exploited by game 
developers over the last nine or so years. Even 
with some significant titles on the way, such as 
Ubisoft’s Rayman Adventures, would-be buyers 
need to justify the higher cost of this Apple TV – 
$149 (32GB) or $199 (64GB), with UK prices to be 
confirmed. Apple TV also works with proper 
game controllers certified under Apple’s Made 
for iPhone programme.

There are additional hurdles for developers to 
overcome. Within hours of the device’s unveiling, 
they discovered a 200MB limit on the size of 
apps, with additional content having to be 
downloaded as needed. That might stifle games 
at least, or at least dent the experience of some 
games on slow connections.

Why is that the case when the Apple TV 
comes with a minimum of 32GB of storage? 
That’s double the entry-level iPhone, which 
Apple excuses on the grounds of its persistent 
connection to the cloud. There might be an 
element of futureproofing, given the few 
Apple TV models to date, but it feels more like 
Apple has something else to reveal about its 
plans in the not-too-distant future.

The new Apple TV

Capacities 32GB, 64GB Processor A8 
Connectivity HDMI 1.4, 802.11ac Wi-Fi 
with MIMO, Ethernet, Bluetooth 4.0, 
IR receiver, USB-C (for service only)  
Includes Siri Remote, power lead, 
Lightning to USB cable (to charge remote) 
Optional extras Remote Loop, HDMI cable

The Remote Loop, sold separately, mimics Nintendo’s effort to avoid broken TVs during gaming.
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AppleWORLD

On our  
APPLE TV

What we’re watching on 
the iTunes movie store

We select the best apps  
& games out there

Film
Avengers: 

Age of Ultron
£13.99 (to buy) HD

Spectacular scenes ensue 
when Marvel’s lengthy 

roster of superheroes goes up 
against a misguided artificial 
intelligence that’s put the fate 
of humanity on a knife’s edge.

TV
Inside Amy 

Schumer
£13.99 (HD), £2.49 per episode

This risqué comedy show is 
even better in its second 

run. If you were a fan of Sarah 
Silverman’s long gone show, 
this is bound to give you big 
belly laughs because Schumer 
also treats nothing as sacred.

Emulsion looks  
like the Aperture 

replacement we’ve 
been looking for

Emulsion
£39.99 Developer The Escapers, emulsionapp.com 
Requires OS X 10.10 or higher

We’ve been treated to some great Mac 
photography apps of late, with the likes 
of Affinity Photo and Tonality. Now it’s 

the turn of photo-cataloguing apps, and this one 
looks the business! It’s much like Adobe’s 
Lightroom in that it can work as your default 
photo organiser and non-destructive image 
editor. Emulsion looks very much like the 
Aperture replacement we’ve been looking for. 
(Photos doesn’t cut it for everyone when it comes 
to organising images.) Emulsion actually works 
with Aperture plug-ins too.

The app allows you to keep your images 
organised by collections, albums, tags, places, 
and people, as well as by search queries, which 
can look at all of the metadata and ratings 
attached to your pictures. It seems it’s time to 
give your photo library a lick of paint!
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From the Store

On our  
PLAYLIST
What’s on the office speakers

Company of Heroes 2
£29.99 Developer Feral Interactive Ltd,  
www.feralinteractive.com 
Requires OS X 10.10.3 or higher

The original Company of Heroes was a 
tough, detailed and engrossing real-time 
strategy title from 2006. The sequel 

came to PC in 2013 and now it’s finally on your 
Mac. You have to direct your troops through 
real-time battles in the fight to turn the tide of 
World War II, from Stalingrad to Berlin.

The Guides
£1.49 Developer Kevin Bradford, theguidesapp.com 
Works with iPhone, iPod touch, iPad

You will have heard such claims before, 
but The Guides really is a puzzle game 
with a difference. There’s an inherent 

air of mystery about it, from the lack of 
backstory and minimal instructions to the 
references to popular conspiracy topics and even 
a fake newspaper’s website. It’s a seriously tricky 
and fascinating experience for iOS gamers.

music
Tom Misch,  
Beat Tape 2

£6.99

The basslines of Tom 
Misch’s music are firmly 

rooted in soul and hip hop, but 
there’s a gentle piano melody 
working its way through his 
latest tunes. The 12 tracks are 
diverse but all possess Misch’s 
trademark late night chilled 
sounds. This is definitely one 
for the eclectic music lover.

POdcasT
Seriously…

Free

Seriously… is the BBC’s 
replacement show for 

Radio 4’s Documentary of the 
Week. Presented by Ashley 
John-Baptiste, the half-hour 
programmes look at a wide 
variety of under-the-radar 
topics; from the fascinating 
tale of the Bin Laden audio 
tapes that were almost wiped 
over, to the curious origins of 
timeless children’s game Rock, 
Paper, Scissors.

Arcadia
£2.99 Developer Touchpress, touchpress.com 
Works with iPhone, iPod touch, iPad

This isn’t the first time that the 
excellent Touchpress has departed 
from science, history and music to 

look at literature. Arcadia by Iain Pears is a 
far cry from The Waste Land, which was a 
historical analysis of T.S. Eliot’s 
masterpiece. Arcadia is an original novel 
written just for iOS devices. It charts ten 
characters across three storylines and is 
similar to create-your-own-adventure apps 
such as Scorcery! and 80 Days. However, 
those are firmly on the gaming side of 
things, whereas Arcadia is most definitely 
a novel, weaving its tale of intrigue and 
adventure through intersecting and 
diverging stories, and placing all in the 
hands of the reader.
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Hot gear on the horizon... what’s got us excited?

The drone rises  
to form a vertical, 

electronic sail  
that powers  
the hydrofoil

What is it? The latest drone from Parrot combines a miniature drone with 
a hydrofoil – when the two are attached, the drone rises to form a 

vertical, electronic sail that powers the hydrofoil. It can then be unclipped 
and flown separately like a regular drone. 
When’s it due? Sailing into view right now.
Why are we excited? It’s Parrot’s first foray into the world of hydrofoils and it 
looks good to us. Combining aquatic and aerial electronics means you get 
the best of both worlds, all at a much more affordable price than most 
drones. We’re looking forward to seeing where Parrot takes this line next.

£140 parrot.com

We’re most excited about...

Parrot Hydrofoil 
Minidrone 
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Reserve Strap
$249.99 (about £160) reservestrap.com

Nebia
$399 (about £260) nebia.com

What is it? A shower’s a shower, right? Not so with 
the Nebia, whose creators say will save you money, 

help the environment and give you a ‘superior 
experience’. Backed by Apple among others, it’s setting 
out to change the way we bathe.
When’s it due? Available May 2016.
Why are we excited? Nebia claims to use 70% less water 
than a standard shower. Combine that with the clear 
demand for it (it raised $3m on Kickstarter from a target 
of $100,000) and there’s a real possibility it could 
significantly reduce water consumption, and thereby 
help the environment – hurrah!

Sphero BB-8 droid
£130 sphero.com

What is it? As soon as it appeared in the 
Star Wars: Force 
Awakens trailer, the 
characterful BB-8 
rolling droid has 
become something of 
an unofficial mascot 
for the film. And, to 
the joy of many a Star 
Wars fan, you can now by an iOS-controlled 
replica for yourself.
When’s it due? Rolling into stores now.
Why are we excited? The tennis ball-sized 
droid has bags of energy and intelligence. 

You control it from an iPhone app and 
can tell it to patrol your home 

through voice commands – 
although intruders are more 

likely to be paralysed 
by cuteness rather 

than fear!

Decidedly off-the-wall

What is it? Forget about waiting until 
you get home to charge your Apple 

Watch, the Reserve Strap tops up your 
wearable on the move. It’s the first Watch 
band with an integrated battery charger, 
meaning you don’t even need to take it 
off your wrist to keep your wearable 
juiced up for days.
When’s it due? Charging up 
November 2015.
Why are we excited? Apple Watch 
battery life is a sticking point for many 
potential buyers, so a strap that promises to 
boost that by 30 hours is bound to turn heads 
and ease some of those concerns. It looks good 
too and fits in well with the Watch aesthetic.

Exploride
$499 (about £325) exploride.com

What is it? Smart cars are the talk of 
the tech world amid rumours of 

Apple’s involvement (see MF287). But 
rather than shell out on an expensive 
vehicle kitted out with smart features, 
you could simply buy an Exploride, which 
promises high tech for a low price.
When’s it due? Hitting the roads  
January 2016.
Why are we excited? It’s a head-up 
display that lets you have smart features 
in a not-so-smart car. You can view maps, 
access music, take iPhone calls and more 
using gestures or voice commands, 
making it much safer than blindly 
fumbling for the car radio dial.
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Steve Jobs could have 
driven any car in the 
world, but he chose to 
drive a Mercedes-Benz. 
Of course he did. 
Mercedes are the Macs of 

the motoring world, and the silver AMG SL55 
Jobs preferred is the Mac Pro of cars: 
beautifully engineered, ridiculously powerful 
and incredibly expensive.

Apple and Mercedes have a lot in common. 
Mercedes has a long history of bringing 
cutting-edge technology to the masses (the list 
of things it did first includes the internal 
combustion engine, all-wheel braking, ABS, 
airbags and much, much more) in a way that 
manages to be both aspirational and inclusive. 
It’s the car you dream of when budget or bean 
counters mandate a Mondeo; the car that 
transports CEOs and cabbies, pop stars and 
plutocrats, mourners and models; the car that 
you might admire for its engineering, lust over 
for its looks, or buy for both. And because 
Mercs are so well made, they go on forever. 

Just like Macs.
I’ve just put my 2007 MacBook Pro into 

semi-retirement. It’s had one careful owner – 
me – and three considerably less careful 
owners – my wife and kids – and it’s still 
going strong after eight years of daily driving, 
the only bill an unnecessary but effective 
upgrade from a hard drive to an SSD. 

The only reason I’m putting it out to pasture 
as a back-up writing machine is I can’t run the 
latest OS X on it, so I can’t enjoy features such 
as Handoff or some apps I want to run.

Its replacement isn’t new, though. It’s a 2011 
MacBook Air, which I got really cheap on 
eBay. Bar a couple of little bumps it looks as 
good as it did when it was first made, and 
thanks to its lovely former owner sending it in 
the original packaging I got that new-Mac 
unboxing joy that’s such a part of the Apple 
experience. Its SSD means it’s blindingly fast 
compared to its predecessor, and unless I’m 
really unlucky it should have years of 
productive life ahead of it.

To a non-Mac owner, that probably looks 
like a daft decision. The same money I spent 

on a four-year-old Mac would have bought me 
a shiny new Windows 10 laptop, maybe even 
a convertible. And that’s true, but that wasn’t 
what I wanted: no matter how well-specced, 
a Windows PC is a Mondeo to the MacBook’s 
Merc. That’s not a slur; Mondeos are really 
good cars and Windows 10 PCs are often 
really good computers. But having owned 
both Mondeos and old Mercs (and enjoyed 
driving both) I know that only one of them 
makes you smile every time you use it.

Just like a Mac.

The Macs Of 
MOTOr cars

If OS X were a car, what kind of car would it be?  
Here’s a clue: it probably isn’t a Kia

One more thing...

Freelance writer Gary Marshall is saving up for an 
S-Class. “I’ve got dreams”, he says, “and plans”. 
So far he’s saved about 70p.

What I spent on a 
four-year-old Mac 

would’ve bought a new  
Windows 10 laptop
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Craig Grannell investigates what Apple’s new graphics API means  
for Mac apps and games, for consumers and developers alike

ry to imagine riding a 
bike with square 
wheels. To move, 
more effort is required 
than when using 

ordinary wheels. This is how Eternal 
Storms Software founder Matthias 
Gansrigler (eternalstorms.at) describes 
OpenGL on the Mac. Until now, OS X 
has been lumbered with square 
wheels – a problem, given that 
OpenGL is a key system component; 
as Apple puts it, the API “gives your 
app access to amazing 3D graphics 
capabilities”, and it’s especially 
important in games, creative software, 
and medical solutions.

OS X’s relatively poor-performing 
OpenGL implementation has seen the 

Mac lag behind Windows in these key 
areas. Apple’s Metal aims to be the 
solution, offering improved rendering 
performance and efficiency. In this 
feature, developers explain how Metal 
will impact on the apps and games 
you love, and what it means for the 
future of the Mac.

For the uninitiated, software 
engineer and writer Warren Moore 
(metalbyexample.com) explains that 
Metal is “a graphics application 
programming interface (API), which 
means it’s a way for apps to get visual 
content like text and images on to the 
screen”. More particularly, it’s a “3D 
graphics API, useful for 3D elements 
commonly seen in games, and visual 
effects – lights, shadows, materials – 

that bring such games to life”.
First introduced in iOS 8, Metal is a 

sort-of successor to the broadly-
adopted graphics API OpenGL, which 
Moore notes was, until recently, the 
only 3D graphics API supported on 
the Mac, and “until its latest revisions – 
not yet available on OS X – had 
significant systemic inefficiencies”. By 
contrast, Metal gives developers more 
direct access to your Mac’s graphics 
processor unit (GPU), which results in 
improved performance and efficiency. 
This, says Moore, means developers 
can “build faster, more efficient apps 
using hardware already in the hands 
of millions of Mac owners”. And since 
Apple “rebuilt some chief components 
of OS X on top of Metal, this will bring 

T

Down to
the Metal
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competitive with their Windows counterparts, 
through developers gaining access to tools for 
writing the most efficient, high-performance 
algorithms for your graphics card.

MetalGL’s Bill Hollings (metalgl.com) says 
this should “provide additional headroom for 
those highly-tuned games and apps pushing 
at the limits”, although developers will need 
plenty of investment and effort to make use of 
such capabilities. Through reducing CPU 
usage, Gansrigler posits Metal-based titles 
could offer improved physics, AI, audio or 
game logic over OpenGL equivalents. And 
freelance developer Andreas Monitzer 
(monitzer.com) reckons “professional games 

will be able to provide the same visual fidelity 
as on Windows, while reduced battery drain 
means you’ll be able to play for longer”.

Performance leap
Unsurprisingly, high-profile games studios 
have already confirmed interest in Metal, 
seduced by Apple’s promises of up to a 50% 
leap in rendering performance (meaning 
higher frame-rates) and 40% higher efficiency. 
But Hollings warns there is a snag: “This is, 
remember, a technology that does not 
provide cross-platform support”. Professional 
tools, he says, will generally be able to ‘hide’ 
this from the developer, using Metal for Apple 
devices and other frameworks elsewhere. 

On the box
Developers speculate 
on how Metal could 
affect new Apple TV

much higher performance to every app, 
regardless of whether its creators directly use 
the Metal API”.

Developer and programmer Simon 
Gladman (flexmonkey.blogspot.co.uk) adds 
that there are further advantages to Metal: “It’s 
important because it enables software 
vendors to create high-performance graphics-
based applications, such as games and 3D 
content-creation software, with a common 
code-base between desktop and iOS devices. 
A common code-base means a faster time to 
market and lower costs associated with 
software development and maintenance.”

Playing the game
On hearing ‘Metal’, Gansrigler isn’t 
alone in first thinking of games, 
largely because Apple’s been 
pushing the technology in iOS 8. 
He’s hopeful Metal will boost Mac 
gaming in a similar way to how it 
improved things on mobile: “For 
years, Macs have lagged behind Windows PCs 
with similar specs when it comes to games 
performance. Even on the same machine, 
when running a game on OS X and then on 
Windows using Boot Camp, the difference has 

often been, to say the least, noticeable.”
Giant Spacekat founder Brianna Wu 

(giantspacekat.com) provides examples: 
“Civilization V runs drastically worse on OS 
X, and Final Fantasy XIV was suspended. 

The latter uses OpenGL on Windows and 
Mac, but because the same code was 

so inefficient on Mac, they had to 
pull the game from sale.” With 
Metal, she says, Mac games 
will finally become more 

“A common code-base means a faster time to 
market and lower costs associated with 
software development and maintenance” 

The new Apple TV is A8-powered, the 
same chip found in the iPhone 6 and 6 
Plus. It helps to drive its intelligent 
search capabilities of the all-new Siri 
and will change the way we interact 
with our TV. It is able to run complex 
games, rather than just a few Apple-
approved apps and act as an AirPlay 
receiver, and it’s here that Metal could 
make a real impact.

“The new Apple TV will, in part, be a 
games console”, explains developer 
Glyn Williams. “If my guesses about the 
hardware are right, the resulting 
machine will in performance terms sit 
somewhere between the Xbox 360 and 
the Xbox One. Not the fastest machine, 
but running Metal, it would be a very 
credible and inexpensive gaming 
platform”. The iPhone 6 and 6 Plus are 
some of the best mobile gaming devices 
around, so it’s a safe bet that all will go 
swimmingly for Apple TV gaming.

Williams reasons Metal is the “key 
component in making the Apple TV into 
something quite disruptive”, and he’s 
not alone. “With a new Apple TV being 
based on the A8 processor, there’s an 
opportunity to create games and other 
applications for it”, says developer 
Simon Gladman. “A common code-base 
allows developers to write once and 
deploy across a variety of devices. 
Because Metal is cross-platform, my 
own ‘engine’ can be reused across Macs, 
iPhones, iPads, and now Apple TV!”

The one concern, suggests Eternal 
Storms Software founder Matthias 
Gansrigler, is whether Apple pegs back 
Metal so it can’t fully shine on desktop: 
“Will Apple focus on feature-parity, 
making sure that porting 
between platforms is easier? 
Desktop GPUs are more 
powerful than mobile ones, 
and that could hold the Mac 
back if Apple decides to keep 
the available APIs the same.”

Glyn Willams says Metal will 
make Apple TV into a genuine 
console to be serious about.

At WWDC 2015, Metal for Mac was unveiled, with Apple showing how it can 
massively enhance the performance of pro apps like Adobe Illustrator.
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Moore adds this will “allow game 
programmers who use such tools to 
immediately see the benefits”. But otherwise, 
Hollings says developers are left to use 
incompatible technologies, such as OpenGL 
and DirectX, elsewhere. Naturally, he suggests 
MetalGL – an implementation of the OpenGL 
API that runs on the Metal platform – can 
assist under such circumstances.

Developer Glyn Williams, though, urges a 
touch of caution when it comes to Metal’s 
potential for any growth in Mac gaming: “I 
don’t ever see the Mac becoming a first-class 
gaming platform. The economics of the 
industry do not favour a smaller platform 
where most users have mobile GPUs.” In other 
words, the inherent nature of the hardware 
may still count against the Mac, although it’s 
arguable Windows isn’t immune to such 
issues, with the majority of sales being 
notebooks rather than desktops, let alone 
powerful gaming rigs.

Apptastic
Gladman is keen to note Metal isn’t just for 
games: “As well as ‘vertex’ and ‘fragment’ 
shaders which are used for 3D, Metal includes 
‘compute’ shaders. These allow parallel data 
computation for tasks such as data visualisation, 
image processing and physics simulations. 

MacFormat: What do you see as the key 
benefits of Metal?
Wu: It’s easy to talk about Metal in terms 
of how it’ll affect people who consume 
games, but the Mac’s always been the 
premiere operating system for creation. 
The most exciting thing about Metal for 
me is how it will solidify Apple’s position 
as the best platform for developing 
creative content.

MF: In what specific ways will Metal 
help developers?
Wu: You’ll see better performance for 
creative apps like After Effects and 
Illustrator. I use Unreal Editor 4, and for 
years have had to use it in Windows via 

Interview

Brianna Wu
Founder, Giant Spacekat 
(giantspacekat.com)

Brianna explains why Metal 
is a boon for creatives and 
consumers everywhere

Boot camp. But now it’s out for Mac, and if 
Metal realises its potential, my next Mac 
could be a maxed-out MacBook Pro rather 
than a Mac Pro. MacFormat readers will find 
similar advantages. If you play games, you 
might think the new MacBook is sexy as hell 
but wonder if it’ll be enough. Metal will let 
any Mac be enough for a lot more people 
— you’ll get more bang for your buck!

MF: Some devs claim Metal is a blow to 
the indies, what’s your take on it?
Wu: When we made revolution 60, Unreal 
Engine 3 didn’t support Metal. We had to 
downgrade the graphics in several areas, 
because they’d have hurt the overall 
performance of the game. Metal would 
have helped. our next project’s a lot bigger 
than a smartphone game, and Metal will 
similarly drastically influence how it will look 
when you play on your Mac. honestly, when 
we as a company asked ourselves if we were 
going to support the Mac in the future, 
Metal was one of the main reasons we 
decided to. It makes oS X a viable platform 
in a way it wasn’t before. Im
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Simon Gladman has 
started developing 
in Metal for 
producing real-time 
video effects using 
particle systems. 
Metal provides the 
processing power to 
control each of the 
million particles 
individually.

Giant Spacekat’s 
ambitious Revolution 
60 had to be simplified 
visually to achieve 
better performance. 
Apple’s Metal will ease 
such limitations.



Epic showed off 
Fortnite at WWDC 
2015. Metal 
improves things 
from a development 
standpoint, for the 
many layers of 
rendering, and 
when playing the 
game itself.
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MacFormat: Why is Metal for the Mac 
such a big deal for developers and Mac 
users alike?
Greasley: Graphics APIs, across all 
platforms, have become pretty bloated 
and complex over the years. The 
enormous complexity of writing modern 
GPU drivers causes problems with stability 
and performance. By stripping things back 
down to basics, Metal removes years of 
accumulated cruft, making it much easier 
to write fast, stable, performant code. 
Multi-threaded programs are finally able 
to make efficient use of the GPU, leading 
to higher frame-rates and more cPU time 

Interview

Jack Greasley
head of technology, The 
Foundry (thefoundry.co.uk)

Jack worked closely with the 
Metal Group. Here’s why he’s 
excited about Apple’s plans

for tasks such as audio and artificial 
intelligence. having a simple, easy-to-use 
API for GPU processing, Metal future-proofs 
the Mac platform and ensures Mac 
applications are as fast as they can be.

MF: How do you see Metal actually 
improving Mac apps?
Greasley: At The Foundry, we write digital 
content creation (Dcc) tools. our software – 
like Modo, Nuke and Mari – is used by 
designers, artists and movie-makers to 
create stunning images. We’ve been big Mac 
fans for years and most of our software runs 
on oS X. our applications make heavy use 
of the GPU, performing lots of heavy image 
processing and making use of high 
resolutions and complex pixel formats. 
 Writing software with the highest 
possible GPU performance can be a black 
art as there are multiple layers of drivers and 
oS between you and the hardware. Metal 
simplifies this task for us. Given greater 
control and visibility about what is going on 

with the GPU, we can give users better 
performance and stability. They’re getting 
more for the money they spend on the 
hardware and that’s a good thing.

MF: How does Metal compare to 
equivalent technology elsewhere, and 
what’s it really like to use?
Greasley: We’ve done early development 
work with Metal and found it a joy to work 
with. The API is nice and clean, the tools are 
well written and well integrated. other 
solutions exist on other platforms, but none 
have the deep integration with both the oS 
and also development tools that Metal has.
 As the API is much ‘thinner’ than existing 
solutions, cross-platform development isn’t 
as complex as you might think it is. As long 
as your GPU-specific code is well-structured, 
Metal provides a good model for how high-
performance code should be written on any 
platform. By following and implementing 
this model on other platforms, you will get 
good results.

Already companies such as The Foundry and 
Adobe are using Metal to speed up their 
content-creation software.”

In fact, Moore explains Metal potentially 
benefits every app on your Mac: “Apple has 
re-architected key display technologies like 
Core Graphics and Core Animation to reduce 
CPU usage, reduce energy use, and increase 
graphics performance. This means actions like 
moving windows and transitioning between 
windowed and full-screen modes are snappier 

on OS X El Capitan than Yosemite on 
comparable hardware. In this sense, 

users will feel the difference 
without any action on the part 
of application developers.”

Naturally, creative apps have the most to 
gain from Metal, though (rather than the 
relatively tiny gains the likes of Finder will see), 
and Gansrigler’s excited about the possibilities. 
He reckons pro apps that could particularly 
benefit include Final Cut Pro X and Adobe’s 
After Effects, through “being able to live-
preview more effects at the same time and 

render the resulting video more quickly”. 
(Indeed, at WWDC 2015, Apple Senior Vice 
President Craig Federighi said Metal helped 
Adobe improve the effects rendering engine 

within After Effects up to 8x.)
Such performance boosts could, according 

to Gansrigler, turn content creation on its 
head. “For example, in 3D model creation, it 
isn’t uncommon to deactivate complex 
shaders when working on a model, because 
turning it around becomes sluggish and 



Matthias Gansrigler 
believes Metal could 
inspire developers to 
take Mac games 
more seriously.

Civilization V on the 
Mac is far less 
performant than on 
Windows. Metal will 
change this though.
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Games like Asphalt 8 take advantage of Metal on iOS, 
enabling complex effects and more on-screen items. 

Similar benefits will soon come to the Mac.

unbearable”, he explains. “Metal might make it 
possible to leave those shaders active”, thereby 
giving the designer “a much better look at 
what they’re working on at all times”, and 
resulting in a superior end product through 
quicker iteration. And regardless of your 
chosen field, desktop displays are now 
following mobile in ramping up to high-
resolution, which makes graphics performance 
increasingly important.

resources required
Despite the potential afforded by 
Metal, developers are cautious 
about singing its praises too 
much. Indie Mac/Linux porter 
Ethan Lee (flibitijibibo.com) 
complains it’s restricted to “those 
with resources to dedicate 
towards Apple-specific products”, 
claiming that “the rest of us are basically going 
to get nothing out of this”. Monitzer counters 
that some gaming indies will at least be 
covered through “Metal being adapted by large 
game engines, meaning anything developed 
with them will use it automatically”.

Gladman echoes Lee’s concerns about 
Metal, saying it “requires a fair amount of effort 
to really get up and running”, and wonders 
whether Apple should deliver a high-level 
framework to exploit its power: “This could 
mean extending SceneKit, for example, with a 
suite of new features, such as photorealistic 
renderers and GPU-based solvers for cloth, hair, 
smoke and liquid simulations”. Alternatively, he 

mulls the emerging open-source community 
around Metal could fulfil that role.

More positively, Moore says we’ve already 
seen Metal “bring new gaming experiences to 
iOS by enabling more immersive effects and a 
greater amount of content on the screen at 
once”, and the Mac could enjoy improved 
games and OS snappiness. And Gansrigler 
wonders whether Metal could usher in more 
Mac ports, due to a combination of the 
platform’s increasing sales and developers 
being enticed by the new and impressive API.

The competition
Still, it’s worth remembering Apple is not alone 
in this space. Microsoft is working on a Metal-
like version of its own DirectX, and The Khronos 
Group recently announced Vulkan, a cross-
platform spiritual successor to OpenGL. Moore 
believes if you saw an architectural diagram of 
the three APIs, “the similarities would be 
striking, because the idea of reducing CPU 
overhead is part of a sea change that’s been 
underway for years”; Lee, though, is irked Apple 
has taken a proprietary route: “Metal is 
downright irritating for anyone who ships for 
more than one platform. OpenGL meant I 
could ship basically wherever I wanted. With 

Vulkan happening at literally the exact same 
time, I can’t help but be incredibly annoyed 
we’re now looking at another proprietary API.”

We’ve heard similar complaints elsewhere, 
and therefore wonder whether rather than 
seeing more Mac software, as Gansrigler 
hopes, Metal’s proprietary nature might result 
in the platform getting less. Wu doesn’t think 
so. She’s not only excited about the prospect 
of a well-implemented Metal giving OS X 
parity with Windows, but also the advantages 
Apple enjoys: “With Windows machines, there 

are so many graphics cards, it’s 
impossible to address them all. 
With OS X, Apple’s only working 
with so many, and so can write 
specific shortcuts and tricks for 
your graphics card, in ones and 
zeroes. This is something only 
Apple can do.”

She continues by arguing developing for 
Apple users always requires a trade-off: “Cross-
platform technology might be easier for you 
as a developer, but gives a worse experience 
for the consumer, and that’s not an experience 
Apple customers are comfortable with. If that’s 
your attitude, perhaps OS X isn’t the best fit for 
you.” Gansrigler concurs, and adds Apple’s 
advantage in everything coming from one 
place could eventually push Metal ahead of its 
rivals: “Apple has stated the shaders they 
provide have been fine-tuned for every single 
graphics chip supported by Metal. I don’t think 
Microsoft nor The Khronos Group will be able 
to say the same!”

Moving windows and transitioning between windowed 
and full-screen modes are snappier on OS X El Capitan 
than Yosemite on comparable hardware
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iOS 9 is finally here, and it’s bursting with dozens of 
enhancements for your iPhone and iPad

W
hen a new iPhone is 
on the horizon it’s 
accompanied by a 
brand new OS to run 
on it. But, thanks to 

Apple’s Beta Software Program, we’ve 
been able to road test iOS 9 for months. 
It’s been through a few iterations, with 
minor changes, but we’ve finally been 
able to explore the finished version and 
share with you our favourite new ways of 
getting more from your iPhone and iPad. 

iOS 9 has some significant changes to 
the way you use an iOS device – it runs 
on all the same devices as iOS 8 – and it’s 
not just cosmetic either. Entirely new 
apps like Wallet and News replace 

Passbook and Newsstand, while iCloud 
Drive finally gets its own app to make it 
easier to get to your cloud-saved content.

Then there’s everyone’s favourite voice 
assistant, Siri, which has been bolstered 
in iOS 9 with new voice training abilities. 
Find Siri in Settings and turn on “Hey Siri”; 
you’ll be asked to speak a few things so 
it gets to know your voice better in five 
quick and easy steps.

Talking of battery power, iOS 9 makes 
some major changes to help you get 
even more hours out of your iPhone. 
The all-new Low Power Mode turns off 
parts of the system that aren’t absolutely 
essential, meaning valuable power can 
be saved to get you through the day.

Over on the iPad some of the biggest 
changes are focussed on its interface. 
The fantastic Split View for iPad Air 2 and 
the recently unveiled iPad mini 4 gives 
you a side-by-side way to access two 
apps at once. It’s a feature that Windows 
users will know all about and it’s available 
in OS X El Capitan on the Mac too. 

Then there’s Slide Over, a great new 
way to pull in another app for quick 
access, such as Mail when you’re 
watching a film, or Calendar while 
browsing Safari, for example.

Beyond these great headline features, 
we’ve discovered dozens of other useful 
improvements which we’re sharing with 
you now. Enjoy!

iOS 9

Amazing 
things to 
do in53



If you prefer to use a Bluetooth keyboard for writing, the experience is much improved now that 
you can look up common shortcuts. There’s an OS X-inspired method for switching apps, too.
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Smarter and faster

Search in Settings

1
At the top level of 
Settings is a search bar. 
Type something into it 

to get a list of matching settings, 
including the path to reach them, 
although you can just tap an item 
to jump straight to it.

Deal with bad Wi-Fi

2
If Wi-Fi Assist is switched 
on at the bottom of 
Settings > Mobile Data, 

iOS will fall back on your mobile 
network when it recognises that the 
Wi-Fi network you’re using is doing 
a poor job of getting you online.

Check out these brilliant new features and improvements that 
make your iOS device even more pleasurable to use

On-screen keyboard

3
Okay, breathe a sigh of 
relief: letters on iOS 9’s 
on-screen keyboard 

reflect the case in which you’re 
typing. The top row of the iPad’s 
keyboard contains shortcuts to 
features such as copy and paste, 
undo/redo, formatting controls and 
buttons to attach photos and items 
in iCloud Drive in apps such as Mail.

If you type quickly and with high 
accuracy, the character previews 
that appear above your finger each 
time you tap a key can be a 
distraction. They can be turned off 
in Settings > General > Keyboard.

Bluetooth keyboards
When using a Bluetooth 
keyboard, the shortcuts 
bar still appears at the 

bottom of the iPad’s screen, along 
with an option to hide it. When you 

press ç+† on a hardware 
keyboard, iOS 9 presents an 
OS X-inspired app switcher that’s 
faster than the one controlled by 
touch. It enables you to reach any 
of the last eight apps you’ve used.

Aside from a new system font, 
iOS 9 looks like its predecessor. 
However, dig a little deeper and 

you’ll find a plethora of changes 
that make it much better to use.

4
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Text insertion 
Positioning the insertion 
point just got easier on 
the iPad. Hold two fingers 

on the on-screen keyboard and the 
keys become greyed out. A blue 
vertical bar appears at the insertion 
point’s current location, and you 
can move it like you would with a 
mouse or trackpad on a computer 
by sliding both fingers around the 
screen; the insertion point will 
follow. Lift your fingers to finish.

Choose Siri’s accent

7
Until now, the language 
you selected for Siri would 
determine its accent in 

addition to guiding its expectation 
of how you say words – but not 

5
Accessibility features (in Settings > General) have been 
expanded with useful switches that disable features that 
might get in your way. You can turn off the Shake to Undo 

gesture, which you might find is too easily triggered. Vibrations from 
your iPhone can be suppressed, too. Touch Accommodations are 
intended to assist people with motor difficulties, but you might find 
them useful for very young children. You can adjust how long the 
screen must be touched before an action is triggered, treat multiple 
touches within a duration as one, and set whether a finger’s location 
when it touches or leaves the screen determines your intention.

anymore! If you prefer to have it 
speak to you in a North American or 
Australian accent, you can choose 
that in Settings > General > Siri > 
Siri Voice, which replaces the 
simpler Gender setting from iOS 8.

Text to speech
If you use iOS’s ability 
to read out text that’s 
selected, new voices can 

be found in Settings > General > 
Accessibility > Speech > Voices.

New actions

9
New actions for dealing 
with email attachments 
enable you to save things 

to iCloud Drive, or to use Markup to 
annotate PDFs and images and 
return that in your reply.

Device 
and data 
security

Music

11
In Settings > Music you 
can choose to have music 
streamed from iCloud and 

Apple Music in high quality. You 
might disable this if you’re on a 
limited mobile data plan.

Camera

12
In Settings > Photos & 
Camera, you can lock in 
settings for the resolutions 

and frame rates used to record 
regular or slo-mo video. Tap Record 
Video or Record Slo-mo to choose 
from the available qualities, which 
vary between generations of 
iPhone. There’s also some on-screen 
guidance about how much space 
a minute of footage at each quality 
will take up. (Remember, the 
amount available is shown in 
Settings > General > About.)

10
The next time you 
set a passcode that 
unlocks your device, 

you’ll find that iOS 9 wants it 
to contain six digits – but tap 
Passcode Options if you still 
want to use four digits, or to 
pick Custom Numeric Code. 
This new option enables 
passcodes as worryingly 
short as one character, or 
much longer than six. As an 
added level of security, this 
option stops the Lock screen 
giving away the length of 
your passcode, making it 
harder for people to guess as 
what is entered is submitted 
only when OK is tapped.

In Settings > General > 
Auto-Lock is a new option 
that locks your device after 
just 30 seconds.

Your website accounts and 
saved bank cards (in Settings 
> Safari) are now protected 
by Touch ID rather than your 
passcode, provided you have 
set up Touch ID.

Broadly useful new 
accessibility settings

When setting a passcode, six digits is now 
the default length. However, additional 
options enable codes of arbitrary length. 
One option makes it even harder for 
someone to guess your code.

6

8
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Two important features are now more powerful than ever before

Proactive suggestions

13
Where you previously had 
to type before Spotlight 
Search showed anything, 

iOS 9 proactively assesses what you 
do and when, and uses that to 
display things you might need right 
now. The search page also displays 
online news for your location.

Newly searchable

14
Many more kinds of item 
show up in iOS 9’s search 
results. Go to Settings > 

General > Spotlight Search and 
you’ll see many more built-in apps 
are listed, including iBooks, Health 
and Wallet. Third-party apps from 
the App Store are listed, too. In fact, 
the rather longer list is indicative of 
a new capability Apple has placed 
in the hands of developers, who 

can make their apps’ contents 
searchable in Spotlight. If you see 
unwanted kinds in search results, 
you can hide them here. However, 
you can no longer rearrange the list 
to prioritise things. categories.

Disable proactivity

15
If you prefer not to see 
Spotlight’s proactive 
suggestions, they can be 

disabled in Settings > General > 
Spotlight Search. Switch off Siri 
Suggestions at the top of that page.

Dictate your terms

16
There’s now a microphone 
icon at the right of the 
search bar, which enables 

you to say what it is you’re looking 
for. This is available even if you’ve 
turned off iOS’s Dictation feature 

(which is triggered from the 
keyboard wherever you can type).

Perform calculations

17
You needn’t dig around 
for the iPhone’s Calculator 
app to perform basic 

arithmetic because you can run 
numbers in Spotlight Search, just 
like in OS X. An added bonus is that 
it works on iPad too, even though 
that device lacks the Calculator app. 
Type a calculation into the search 
bar, using * for multiply and / for 
divide. Try using common functions 
too – for example, sqrt(144).

Accessing Search

18
Prior to iOS 7, the system-
wide search feature was 
accessed by swiping to 

the left of the first Home screen. 

Later, Search appeared when you 
swiped downwards on any Home 
screen. In iOS 9, both methods 
work, but there’s a subtle difference 
to note. The latter method opens 
the search page with the input 
focus already in the bar and the 
keyboard visible, and a list of 
suggested apps even before you 
type – but nothing more until you 
do. Use the former route if you want 
to see iOS’s proactive suggestions.

Content blockers

19
These days, the size of 
many web pages has 
become bloated, and 

often you’ll find them slow to load 
on your iOS device – even over a 
good Wi-Fi connection. Partly this is 
due to complex scripts often used 
by online advertising, which take 

Search and Safari

Previously hidden features of Safari have been 
given greater prominence, and it has gained 
extra shortcuts and presentational features.
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time to run. In iOS 9, Safari includes 
support for content blockers that 
can be configured to stop content 
from certain web domains from 
loading). You can manage content 
blockers in Settings > Safari. You’ll 
only see a Content Blockers item 
listed under the General heading 
if you’ve installed an app that adds 
one (even though the item shows 
up when you search for it at the 
top of Settings).

Easier on the eyes

20
Safari’s Reader feature, 
which strips away 
superfluous content on 

long pages to give you a cleaner, 
reformatted view of only the actual 
content, has a bunch of new visual 
options. It presents text in the 
San Francisco font by default, 

which is the system font on all three 
of Apple’s latest operating systems. 
The same seven fonts available in 
iBooks are also available here, along 
with a choice of page background 
colours (white, cream, dark grey and 
black – the third of those is also 
now available in iBooks). Naturally, 
the text size remains adjustable.

Do things with a page

21
The bottom row of the 
share sheet contains a 
couple of new things 

besides Safari’s Request Desktop 
Site. Add to Favourites, which was 
previously tucked away with 
Request Desktop Site, is found here, 
along with a more explicit Find on 
Page action as a convenience for 
anyone who is unaware of the 
existing, more hidden route of 

tapping the search field and then 
the last item in its suggestions.

Paste and Go

23
It takes fewer steps to 
paste and go to a web 
address that you’ve 

copied to the Clipboard. Hold a 
finger on the field and tap ‘Paste 
and Go’ in the options bar when it 
appears. With something else on 
the Clipboard, you’ll get a Paste 
and Search option instead.

Upload files

24
Got a CV to upload as 
part of a job application? 
Wherever you see an 

option to upload a file to a site, 
you’ll find iCloud Drive among the 
sources from which you can attach 
and submit a file to an online form.

Spotlight Search is a lot smarter in iOS 9, and it 
even saves you having to search for the Calculator 
app because you can give it arithmetic expressions.

Request 
Desktop 
Site

22
In iOS 8, the option 
to load the desktop 
version of a website 

was tucked away where it 
was easy to miss. There are 
now two ways to reach it. 
The long-winded way is to 
tap the Share button and 
then Request Desktop Site 
in the bottom row of actions. 
However, it’s quicker to hold 
a finger on the reload arrow 
in the address bar for a 
moment, then tap Request 
Desktop Site when it appears.
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Important little details that you jot down are much smarter and richer

Notes and Reminders

Persistent reminders
Due reminders on the 
Lock screen remain there 
unless you actively action 

them – if you unlock and then lock 
your phone, your reminders will still 
be listed on the Lock screen.

More responses
When you do action a 
notification, you have 
more options than before: 

you can mark something as 
completed, or you can choose the 
Later option, which gives you the 
choice of ‘snoozing’ the reminder.

Create reminders
While in an app, you can 
tell Siri to “Remind me 
about this” and it will 

create a reminder named after 

whatever you’re currently looking at 
in the app. You can also send things 
to Reminders from apps such as 
Safari by tapping the Share button, 
then Reminders. Here, you can add 
text and, by tapping the Options 
button, set a time or location to be 
reminded. In Safari’s case, when you 
access that reminder, it will take you 
straight to the linked web page.

Enhanced notes
In the new, richer Notes 
app, you can embed 
pictures or web links into 

your notes. The easiest way to do 
this is often from Safari or the 
Photos app – tap the Share button, 
then choose Notes. You’ll have the 
option of adding text to go with 
your link or photo, and choosing 
whether to create a new note or 

add to an existing one. Pictures can 
also be added using the camera 
icon above the keyboard inside the 
Notes app (if this isn’t visible, tap 
the + on the right to reveal it). 

Make checklists
You can add checklists 
to notes, too – tap the 
icon of a circle with a tick 

inside, just above the keyboard. 
Type your first to-do, then press 
return to start a new one. Press the 
icon again to stop. To mark an item 
in the list as done, tap its circle. 

Sketch out ideas
Tap the squiggly line icon 
above the keyboard in 
Notes to add freehand 

drawings and use a ruler 
tool to draw straight lines. 

You can choose different drawing 
implements and line colours. There 
are undo and redo options, and you 
can rotate the whole drawing for 
easier working. Tap Done to insert it.

Text styling
The Aa icon above the 
keyboard in the Notes 
app lets you style up text 

in notes as headings, subheadings 
and lists. Highlight text and choose 
a new style for it, or start a new line 
and choose a style before writing. 
Highlight text and then tap BIU in 
the pop-up options bar to change 
its weight and decoration. You can 
indent the current line or selection 
from the same pop-up.

(Left) Notes can contain much more than text; you can attach links 
to web pages, add checklists and draw sketches on the touchscreen.

(Left) You can ask Siri to remind you later 
about whatever you’re looking at in Safari. 
(Above) Reminders have more ‘snooze’ options.
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New App Switcher
The App Switcher has a 
new look. Recent contacts 
are gone, but Handoff is 

more prominent in a bar at the 
bottom – tap it to receive a task.

Return to an app
When you switch apps 
through an action such as 
tapping a notification, 

you’ll see a ‘Back to…’ button at the 
top-left corner of the screen.

Dip into apps
Slide Over enables you to 
bring up a thin view of 
another app (which must 

support it) by sliding a finger 

Multitasking

Battery & storage

Conserve power

37
Smartphones are power 
hungry, there’s no way 
around that with bright 

touchscreens and plenty of apps 
running. But it’s good to see Apple 
turning its attention to battery 
management proper. Low Power 
Mode disables certain aspects of 
your iPhone, including background 
app refresh, so you don’t have to 
go around turning off features any 
more. It can extend usage by a few 
hours, and kicks in (as an option 
offered in an alert) when your 
iPhone reaches 20% of its battery 
capacity. The battery meter at the 
top-right of the screen turns 
yellow to indicate Low Power 
Mode is enabled. The feature can 
be turned on manually at any time 
in Settings > Battery.

Manage your usage

38
In Settings > Battery, you 
can view what hogs the 
battery. There are two 

options, Last 24 Hours or Last 
7 Days. They display the proportion 
of battery life used by each app in 
that time. Tap the clock icon on the 
right to see the duration that apps 
were using battery, both while 
on-screen and in the background.

Exiting Low Power 
Mode

39
You can turn off Low 
Power Mode manually, 
of course, in Settings. 

However, when battery power 
reaches 80% on charging your 
device, Low Power Mode will be 
turned off automatically, returning 
your iPhone to full throttle.

Monitor batteries

40
Among a slew of subtle 
changes to Notification 
Center, on an iPhone only 

you can check battery statuses in 
the Today view. The Batteries widget 
shows power levels of your phone 

and Bluetooth accessories, such as 
headphones or an Apple Watch. 
To enable it, scroll to the bottom of 
the Today view, tap Edit, then tap 
the + next to the widget’s name. 
The Batteries widget is not available 
if a Bluetooth accessory is not 
paired with the iPhone.

inwards from the right 
edge of an iPad’s screen, 
so you can attend to 
things without stopping 
what you’re doing. 
To switch apps, swipe 
down from the line at the 
top of the right pane.

Work in two 
apps at once

Split View lets 
you run two 
apps side by side – but 

only on an iPad Air 2 and iPad mini 
4. To use it, start with the same 
gesture as Slide Over, let go, then 
drag the vertical line on the divider 
to the middle of the screen. 

Picture in Picture
On any video that uses 
Apple’s default video 
player, tap the button that 

shows two rectangles and an arrow. 
This turns the video into a small 

floating box, which can be moved 
to any corner, resized using two 
fingers, and stays open even if you 
change apps. Flick it off the left or 
right of the screen to temporarily 
hide it (it will keep playing).

Working with multiple apps 
just got a whole lot easier

At last, you can work in two apps side by side, which is great for researching in Safari and taking notes 
alongside. However, this feature is only available on the iPad Air 2 and iPad mini 4.

iOS 9 has great new ways to manage 
your device’s storage and battery

Apple claims Low Power Mode can keep your 
iPhone running an hour longer before it needs 
recharging. Turning it on is optional.

Low Power Mode turns itself off when your 
iPhone reaches 80% of battery capacity, or you 
can disable it sooner in Settings > Battery.

32

34

35

33

36

53 Amazing things to do in iOS 9



apple watch
Pre-condition and 
open your car

BMw i3
The compact electric 
vehicle to die for 

Online • PrinT • TableT

DIScOVeR the 
futuRe Of autO 
tech IN tODaY’S 
cONNecteD wORlD

lIfe’S BetteR wIth t3
t3.com 



Beyond the big changes, there are plenty of subtle ones to discover

Other apps
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News and Newsstand

41
News is a brand-new app 
that provides timely 
information in a single 

place, much like you might once 
have caught up with website 
updates in an RSS reader. However, 
it comes with its own publishing 
format that enables the use of 
animation and other engaging 
interactions. At launch, it’s geared 
towards the US, but it’s expected to 
launch in the UK soon after.

If you read digital editions of 
MacFormat or other magazines, 
you might wonder what News 
means for them. Newsstand is gone 
in iOS 9 – sort of. If you already had 
magazine apps, Newsstand will 
have been converted to a regular 
folder, and apps can be moved out 
of it. Future magazine downloads 
go straight to the Home screen.

Wallet

42
Wallet is the new name 
for Passbook. It still 
contains your passes for 

airlines, hotels and other services, 
and bank cards registered to use 
with Apple Pay. To make accessing 
these things more convenient, go 
to Settings > Wallet & Apple Pay 
and ensure the Home button 
shortcut is switched on so you can 
double-click the button to open 
Wallet while your iPhone is locked.

Photos

43
When viewing a photo 
full-screen, a strip across 
the bottom of the screen 

shows other images in the same 
album, collection or moment. 
Swipe across it to quickly browse 
through them.

In the Photos tab, tap Select then 
drag your finger from one photo to 
another to select them and those in 
between, rather than having to tap 
each one you want in the selection.

Rather than reaching for the back 
arrow at the top-left of a full-screen 
photo to return to its album, swipe 
downwards to dismiss the picture. 

This is particularly handy 
on larger iPhones.

If you put screenshots 
on social media, as some 
of our friends do, you’ll 
be ecstatic that iOS at 
last adds them to a 
Screenshots album, 
making them much 
easier to clear out of 
your library later on. 
There’s a Selfies album 

too, but it isn’t powered by 
intelligent face detection; any 
photo taken with the front-facing 
camera appears in this album.

Rather than tapping and holding 
on a photo for an option to hide it, 
you must now tap Select, tap a 
photo, then the Share icon and find 
the Hide action in the bottom row 
of the share sheet. That takes a little 
longer for a single photo, but the 
advantage is that you can select 
additional photos in the share sheet 
and then hide them all at once.

Maps
44

The latest step in 
Apple’s attempts to 
bring Maps up to 

scratch is the inclusion of 
public transport data to help 
you get from A to B, rather 
than just driving and walking 
directions. Previously, Apple 
made it so third-party transit 
app developers could plug 
into Maps, but now it’s 
starting to add its own data 
to the app by default, 
including details of problems 
on your route, like it does for 
driving directions. However, 
transport data is available for 
a limited number of cities at 
present, which is pretty 
normal as localised services 
of this sort start to grow.

Tap the Transport tab while 
plotting directions and the 
app will try to use Apple’s 
own data before suggesting 
you look at transport apps in 
the App Store. Tap the ‘i’ at 
the bottom-right and switch 
to the Transport view. In all 
three views, a ‘3D’ badge next 
to a city indicates you can 
take a Flyover tour of it. 
Zoom out in the Transport 
view and other badges will 
indicate where public 
transport data is available.

Podcasts
45

Podcasts has been 
given a makeover to be 
more consistent with 

the Music app added in iOS 8.4. 
Music’s MiniPlayer – a bar above 
the tabs at the bottom when 
something is playing – is 
replicated, as is the use of an 
ellipsis (…) to indicate more 
options for an adjacent item.

The My Podcasts and My 
Stations tabs have been 
consolidated under the former, 
and the new Unplayed tab is 
more immediate in showing 
what you need to catch up on.

More detail is shown in the 
Top Charts tab (star ratings and 
the date of each podcast’s most 
recent episode) but some control 
has been sacrificed; categories in 
Featured and Top Charts no 
longer have subcategories.

As you zoom out in maps, look for blue 
icons next to cities, which indicate public 
transport directions are available there.

To hide multiple photos, select one, call up the 
share sheet, select more photos in the strip 
across the top, and then tap Hide.

Rather than tapping each photo you want to 
select, iOS 9 enables you to do it with one tap 
followed by a swipe across them.
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The iCloud Drive app
The Document Picker is now found in a dedicated 

app, enabling access to your files on all your devices

Find the app

46
iCloud Drive is Apple’s 
storage solution for 
managing file syncing 

between your Mac and iOS devices, 
but until now it has been very 
much ‘in the air’ because there’s 
been no easily visible hub for it on 
the iPad and iPhone. But for iOS 9 
Apple built an iCloud Drive app, 
holding all your iCloud Drive files in 
one easy to access area. However, 
the app doesn’t automatically 
appear when you upgrade your 
device to iOS 9. It has to be enabled 
in Settings > iCloud > iCloud Drive 
> Show on Home Screen).

View your Drive

47
When you tap the iCloud 
Drive app’s icon, you’ll see 
the Document Picker (a 

grid of the folders and files within 
your cloud storage). Previously, this 
only appeared in compatible apps, 
rather than its own app. At the 
bottom of the screen, you can see 
how many items are in the current 
folder, and how much space you 
have available in your iCloud Drive.

Dealing with files

48
iCloud Drive in iOS 9 tries 
to mimic the folder and 
file experience you get on 

your Mac. Tap on any file to view it. 
You can also create new folders and 
move files to different locations, as 
you would expect. The iCloud Drive 
app has brains too; if you select a 
series of files in a folder that doesn’t 
have any subfolders and then tap 

Move, the app will automatically 
determine whether you need to 
create a new folder and prompt you 
to enter a name for it. If you already 
have one or more subfolders, the 
app shows you a list of them to 
choose from.

Edit a document

49
In order to make changes 
you have to export the file 
to a different app. Tap the 

Share button (top-right) and then 
select the app you’d like to export 
the file to. You’ll be redirected to 
that app, where you can edit it fully. 
Depending on the file type, some 
of your formatting preferences, 
like fonts, might be different. Every 
change you make will sync back to 
iCloud. Rename a file by holding a 
finger on it and choosing Rename. 
This works for nested folders, too.

Preview a file

50
The app also allows you 
to preview files within 
your iCloud Drive. It only 

knows how to display a handful of 
file types, but it can display text 
documents. You can also access the 

Sharing sheet to send the file to 
other people in an iMessage, email, 
or as an attachment in other 
messaging apps.

Change view

51
You don’t have to stick 
with the large folder view 
shown above. Click the 

List Menu (the icon that shows 
three horizontal lines) to get a list 
view instead. If you don’t see the 
icon, it’s because you need to swipe 

down slightly on the main screen to 
reveal it – it’s under the search area.

Tidy up your Drive

53
One of the most useful 
things you can do with 
the iCloud Drive app is 

organise your files and delete the 
ones you don’t want. If you want 
to delete files, tap on Select in the 
top-right corner, and then tap on 
the files you want to get rid of. 
Next, tap Delete, then the red text 
that says ‘Delete from iCloud Drive’. 
The app will warn you that the 
action cannot be undone.

The iCloud Drive app enables you to preview files, send  them to people, export them to other apps, and delete old files to free up storage space.

You can preview files that iOS can read 
without leaving the app, but not all files 
copied to Drive from your Mac will open.

Options to send the selected file to an app 
appear in the middle row of the share sheet.

Search 
iCloud Drive
52

Don’t forget that 
iCloud Drive is fully 
searchable. The 

search bar is always visible 
near the top of the the iCloud 
Drive app. It searches as you 
type so you will get to your 
files in seconds.

53 Amazing things to do in iOS 9
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“Considering 
how affordable 

Affinity Designer is, 
there are a lot of tools 
on offer, including 
pixel editing”
Make the finishing 
touches to your art  p48

Monitor your Mac’s activity
We take a look at the best utilities to keep  
an eye on your Mac’s performance p40

Fix Apple Music 
Apple Music is good, but it’s not perfect 
yet. Here’s how to get the most from it p44

Customise a photo book
Combine Photos, Pages and Preview to 
create truly unique photo books p46

Add finishing touches
We explore Affinity Designer’s pixel editing tools 
with Pixel Persona p48

Banish email cruft
Overcome email overload with our tips to help 
you keep your communications organised p50

Calibrate your display’s colour
Make sure your screen is accurate by creating 
a ColorSync profile on a regular basis p52

Make Finder more productive
Learn about the shortcuts that can speed you 
around OS X’s file manager p54

Take control of notifications
Learn how to make those helpful Mac 
notifications work better for you p56

Get more from Pixelmator
Get creative with your pictures using 
this excellent and affordable app p58

This issue’s easy- 
To-follow guides
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Chances are if you took 
your Mac out of the box 
when you got it home, 
powered it up, and then 

never installed anything on it and never 
went online, things would rarely go 
wrong. Also, you’d probably be very 
bored. But once you add anything on 
top of vanilla OS X, the potential for 
problems rapidly increases. Software can 
clash with the operating system or other 
software, websites and apps can cause 
network issues, disk space can run out, 
and processes can run riot, causing your 
Mac’s fans to go into crazy mode. 
Furthermore, hardware can and does 
invariably – if rarely – fail. So what we’re 
saying is that your Mac is essentially a 
sleekly designed and very stylish time 
bomb, waiting for the day when it’ll 

quietly detonate, not so much with a 
bang, but with a “not working so well 
today – sorry”.

If you’re quietly panicking, don’t. Most 
problems can be fixed, and we provide 
ideas about how to do so later in this 
tutorial. Moreover, issues can be headed 
off at the pass. Rather than reacting to 
problems after they’ve occurred – 
frantically trashing files if you abruptly 
run out of disk space; realising you have 

precisely no charged batteries when 
your mouse, trackpad and keyboard 
conspire against you by simultaneously 
stating they’re out of juice – it’s smarter 
and more efficient to get some advance 
warning. What you need is monitoring 
tools which lurk in the background, 
patiently probing your Mac, and 
enabling you to poke around facts, 
figures and data as you see fit.

Built-in tools
Apple bundles some handy tools with 
your Mac. Visit the Network and 
Bluetooth panes in System Preferences. 
Each has an optional menu bar extra 
that can be activated, enabling you to 
check on the status of the relevant type 
of connectivity. With Bluetooth, you’ll 
see a battery indicator if one of your 

The best utilities to keep an eye on things and help when things go wrong

SKILL LEVEL
Taking things further

IT WILL TAKE
1 hour

YOU’LL NEED
OS X 10.10 or higher, 

iStat Menus,  
GrandPerspective

Monitor your Mac’s activity

Once you add 
anything on top 
of vanilla OS X, 
the potential for 
problems increases

Little Snitch monitors 
network connection 
attempts, so you can 
control app communication 
with remote servers.
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Main window
1  The app’s main window is 

used to to explore and adjust 
set up options. Select General or a 
module from the sidebar to start. 

Module settings
2  Each module has its own 

options. Typically, you can 
drag items between the active and 
inactive areas, and set which sensor 
output is shown in the menu bar.

Menu bar extras
3  All items ticked in the app’s 

sidebar will be displayed in 
the menu bar as graphs or stats 
that periodically update. 

Finer details
4  Click a menu item for details. 

In many places, you can put 
the pointer over info to see more.

QUICK LOOK | iSTAT MENuS

connected accessories is running low 
on power, giving you ample time to find 
new batteries. Clicking the menu extra 
lists the devices, and clearly shows 
which one needs attention; dipping into 
the sub-menus details charge levels. 
As for the Wi-Fi menu extra, it provides 
a straightforward visual indication of 
when your network connection is flaky. 
Once connected, it should remain a 
solid black. If it keeps flicking to grey 
and back, and you’re in a place where 
the network connection should be solid, 
you might need to think about running 
some diagnostic checks. (Note that 
should you quickly need additional 
details about your current network 
settings, å-click the Wi-Fi menu extra. 
The information in the menu will then 
be rather more involved.)

Plenty of third-party tools exist for 
similar and additional scenarios. Some 
are quite specialised. TG Pro ($15 – 
about £10, tunabellysoftware.com) 
monitors temperatures in your Mac (the 
‘TG’ stands for Temperature Gauge), 
finds faulty sensors and gives you the 
option to control fan speeds. (If you’re 
lacking funds to spend on an app, also 
consider the free Macs Fan Control 

(crystalidea.com.) Generally, we don’t 
recommend messing with Apple’s 
default fan settings, but it’s worth 
having the option in mind if your Mac’s 
getting very hot, and being able to do 
something about it if you’ve got days to 
wait for a Genius Bar appointment.

System monitoring
Elsewhere, the best utilities tend to be 
modular bundles that perform various 

tasks. Monity (£2.29, Mac App Store) is 
an affordable utility designed to monitor 
CPu usage, network activity, batteries, 
and disk usage that enables you to drop 
into Notification Center at any time to 
see how things are going.

Our favourite product of this kind, 
though, is iStat Menus ($18 – about £12, 
bjango.com). This comes in the form of 
an app that’s essentially a bunch of 
settings that control a bunch of icons 

KEEp IT 
SImpLE

Don’t stuff your 
Mac full of 

every single 
monitoring app 
you can think of, 

because that 
in itself 

might cause 
performance 

issues. Make use 
of trial versions, 
decide on your 
favourites, and 
then uninstall 

everything you 
no longer need. 

Activity Monitor is useful for quickly finding out when an app or process is causing CPU or memory issues.

1

2

3

4
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that reside in the right-hand side of the 
menu bar. These icons are highly 
configurable in terms of appearance, 
but mostly take the form of tiny graphs. 
You get more than ample warning 
about the capacity of your Mac’s 
storage, given that the relevant bar 
increases in size over a matter of 
months. Things like CPu, memory and 
network statuses are perhaps more 
useful in an immediate sense. If one of 
those things starts going haywire, you 
might be able to respond appropriately 
before it’s too late.

When problems do occur, you need 
to figure out what’s happening before 
working on a plan of attack. Common 
issues with Macs include sudden 
sluggishness and/or unresponsiveness, 
network connectivity slowdowns or 
dropouts, and a lack of on-board 
storage. Sometimes, you’ll find one 
problem leads to another. For example, 
if your Mac has essentially no free space 
remaining on the volume where OS X is 
installed, apps will find it much harder 
to function, which can result in 
slowdowns and responsiveness 
problems. But if your cursor’s jerking 
about or it feels like you’re wading 

through digital quicksand with every 
step, that doesn’t necessarily mean that 
low storage space is the problem.

Fixing your Mac
A good first step is to check in Apple’s 
own Activity Monitor tool, which you’ll 
find in /Applications/utilities. Here, you 
can click the tabs to peruse resource 
usage on your Mac in terms of CPu, 
memory, energy, disk and network. 
Sometimes, an app will get stuck, and 
you’ll see the CPu load graph maxed 
out. Similarly, your Mac may run out of 
memory, causing the memory pressure 

graph to look like a solid red block. 
under these circumstances, sort the 
processes by clicking the ‘% CPu’ or 
Memory column headings, respectively. 
If an app is taking up an unreasonable 
amount of CPu, leave it for a bit to see if 
it can complete its task. If that doesn’t 
work, select the app in the list, click the 
cross button (top-left), and then choose 
Force Quit. Note that red items are 
entirely unresponsive, and are often the 
cause of problems; you’ll often see this 
with tabs in Safari (helpfully listed by 
uRL), due to misbehaving websites. 
If one regularly eats up large amounts of 

ChECK 
ANOThEr 
ACCOUNT

If you have 
an ongoing 

problem with 
your Mac being 

slow or weird, try 
logging into a 
fresh account 

(made in System 
Preferences) and 
using it for a bit. 
If the problem 

disappears, 
an app, utility 

or add-on 
you use is the 
likely cause. 

TG Pro monitors 
temperature in 
Mac components, 
and it can adjust 
fan speeds.

1 Start scanning a drive or folder
In GrandPerspective, go to File > Scan Folder and select a folder for 

the app to scan. This can be at any level on your Mac, but it makes more 
sense to scan widely rather than select something specific, such as your 
Downloads folder. Therefore, either scan your user folder, or select the top 
level of your Mac’s internal drive. Click ‘Scan’ and GrandPerspective will get 
on with its search. The app has to trawl through every file and folder 
within the one you selected, so this process can take a while, especially 
on older Macs. You can still use your Mac in the meantime, and you can 
cancel the scan if it’s slowing things down too much.

2 Inspect the scan results
When the scan is complete, your drive’s contents are represented 

by a bunch of rectangles. This is all very abstract, but there is logic to it. 
The larger rectangles represent bigger files, and items within the same 
folders are shown within a larger containing rectangle. For example, your 
Downloads and Documents folders will be found within one specific area 
of the representation of your Mac’s drive, rather than the various files 
within them being spread randomly about the graphic. Select an item 
and you’ll see its size and filename in the status bar at the bottom of the 
window, and its parent folder will also be highlighted.

HOW TO | SCAN YOuR MAC FOR HuGE FILES
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CPu or RAM, stop visiting that site. 
Similarly, if you find an app often taking 
huge chunks of memory over and above 
anything remotely sensible, it might 
have a memory leak, so check for an 
update or, failing that, an alternative.

Network problems are typically harder 
to nail down. Little Snitch (€29.95 – 
about £22, obdev.at) can help weed out 
errant apps, through intercepting their 
communications with servers and 
analysing your bandwidth. It’s quite an 
involved app, but its detailed display is 
relatively easy to get to grips with, and 
powerful rules provide the means to 
enforce certain conditions under 
specific circumstances. 

Getting space back
Storage space is, fortunately, simpler to 
deal with. DaisyDisk (£7.99, daisydiskapp.
com) or GrandPerspective (free, grand 
perspectiv.sourceforge.net) help analyse 
your user folder or entire Mac, quickly 
spotting large files that you can choose 
to trash. Alternatively, Disk Doctor (£2.29, 
fiplab.com) will automatically trawl your 
Mac for large files for potential disposal, 
while Duplicate Zapper (79p, intego.
com) will restrict itself to duplicates. 

In all cases, take care while using such 
apps. When in doubt, back up first, and 
only trash items you definitely aren’t 
going to need in the future.

It’s also worth considering monitoring 
specific folders. You can use rules in 
Hazel ($29 – about £19, noodlesoft.com) 
to keep an eye on the likes of your 
Downloads folder, filing content by type 
or date, and periodically emptying the 
trash, to free up precious space. 
Craig Grannell

Rather than reacting 
to problems after 
they’ve occurred, it’s 
smarter to get some 
advance warning

Hazel offers a different 
kind of monitoring, 
checking folders and 
applying rules to the 
files within.

JARGON 
BUSTER
The term CPu 
means Central 

Processing unit, 
which is the 

brains of your 
Mac. If the CPu 
gets overtaxed, 

everything 
grinds to a halt. 

The trick is to not 
get to that point, 

or to quit 
problematic 
apps if your 

Mac’s heading 
for a meltdown. 

3 Get more information
Narrow the window and click Drawer to access further information. 

Info gives you an overview of your scan, and Focus tells you more about 
the selected item, including dates when it was created, modified, and last 
accessed. Use the toolbar buttons to change your view and focus. The + 
and – buttons zoom in and out of the folder or folders that contain your 
selection, and the two Focus buttons broaden or narrow your selection. 
For example, you can select an item in Downloads, and as a comparison 
use Focus to check the size of the entire folder. (If a containing folder is 
small, so too will be any file within, even if it takes up most of that folder.)

4 Find, delete and filter files
You can delete items directly from GrandPerspective by selecting 

them and clicking Delete, but only if ‘Enable deletion of’ in the app’s 
preferences is set to something other than ‘Nothing’. Be very careful 
regarding what you remove – only delete files or folders where you know 
their function and that you won’t need again (or have a copy stashed 
somewhere). Large apps (OS X and iOS) you no longer use, for example. 
You can alternatively ≈-click to reveal or open the item in Finder. Should 
you want to narrow subsequent searches to specific file types, explore 
GrandPerspective > Filters; set up rules and then use File > Filtered Scan.
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When it comes to teething 
problems, Apple Music has 
had more than its fair 
share. The inconsistent user 

interface is the least of its problems: 
unpredictable bugs in playlists, the 
Beats 1 radio station, and the occasional 
distressing report of lost metadata and 
tracks give pause for thought.

The good news is that Apple is on 
a deadline: Apple Music picked up 11 
million users in its first month thanks to 
its free three-month trial period – users 
it could lose in October if it doesn’t get 
its house in order. It’s already taking 
steps to fix the service, too: iOS 8.4.1 
came out halfway through August, and 
iOS 9 will be out by the time you read 
this. The former fixed irritations such as 
Apple Music ignoring attempts to mark 
a song playing on Beats 1 as ‘loved’.

There are still problems, though. The 
only way to get offline tracks from Apple 
Music is to turn on iCloud Music Library; 
that feature is theoretically brilliant: 
besides offline tracks, iTunes compares 

your local library to Apple’s own, and it 
makes matching ones available to play 
on all devices signed into your iCloud 
account. However, many people are 
finding that songs are mismatched, or 
that they get the wrong versions. If you 
own an unbleeped version, say, it might 
be overwritten with a censored one. 

Some are also finding album artwork 
is missing or wrong. Meanwhile, adding 
music to playlists is still fairly confusing, 
particularly compared to other services 
such as Spotify. We’re optimistic about 
Apple Music in the long run. For now, 
these workarounds should help you to 
smooth things out. Dave Stevenson

Fix Apple Music problems
Apple Music is improving, but you might need help with common issues

1 Playlists
Custom playlists are a staple of music 

streaming services, so why does Apple make 
it so hard to do? For starters, you can’t just 
add the song currently playing to a new 
playlist. Instead, go to My Music, choose 
Playlists, then use the very small New button 
to create a new one. Name your playlist; it 
will then appear in the list of options when 
you choose the ‘Add to a Playlist’ option.

2 Reset iCloud Music
If incorrect details show for your local 

music, open iTunes’ General preferences and 
turn off iCloud Music Library. Choose Store > 
View Account, sign in, scroll down and click 
Reset. Confirm, quit iTunes, and reopen it 
while holding å and ç to enter safe mode. 
Select Restore Library and, once the process 
is finished, check your track data is correct. 
If so, turn iCloud Music Library back on. 

3 Reset is unavailable
An infuriatingly common issue is that 

not everyone’s Account Info has the Reset 
option. If this happens, the best option is to 
turn off iCloud Music Library, close and open 
iTunes with å held, choose Create Library 
(to make a separate one locally), and turn 
iCloud Music Library on. Though imperfect, 
this protects your master library while still 
using iCloud for multi-device playback.

How to | GeT AppLe MuSIC WOrkInG FOr yOu

SKILL LEVEL
Anyone can do it

IT WILL TAKE
A few minutes to 

a few hours

YOU’LL NEED
iTunes, potentially 
a lot of patience

Apple Music in all its glorious, potentially bug-filled glory – though there are things you can do to fix it.
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Photos allows you to 
customise the layout of 
your photo book pages to 
an extent, but to really take 

control of its appearance you can make 
custom images in Pages instead.

Photos isn’t fussy about what kind of 
image files you can import into it. As 
long as they’re in the right file format, 
you can import holiday snaps, fine art 

portraits or pages of text rendered as 
images (JPEG compression can lower 
the quality of text, so if you’re doing this 
consider using PNG instead). 

Unfortunately, Pages isn’t capable of 
exporting your layouts directly as an 
image file, but it is capable of 
outputting a PDF, and that’s where 
Preview comes in, quickly and easily 
converting those PDFs into an image file 

format that Photos can handle.
Apple’s print products are an often 

overlooked service. We’re concentrating 
on photo books here, but you could use 
the same techniques to produce 
calendars, prints ready for framing or 
even a jigsaw. Remember to keep the 
quality settings high when preparing 
files for print, so you get the best 
possible end result. Ian Evenden

Customise a photo book
Combine Photos, Pages and Preview to create truly unique photo books

3 Lay it out
Inside the Shape, lay out your photos. Add drop 

shadows or frame lines to your images, overlap them etc. Use 
the stacking order from the Arrange part of the Inspector to 
make sure overlaps go exactly the way you want, and Edit 
Mask from the Inspector’s Image pane to crop them. 

1 Check dimensions
First, find the page size of the book – online at www.

apple.com/uk/mac/print-products or displayed when you 
create a new book in Photos. In Pages, create a blank 
landscape document then make it larger than the page size 
using the Document Inspector. We’re using an A3 document. 

4 Export it
When finished, give your page a title, although it’s 

only useful for separate chapters. Keep the type quite large 
to maintain readability. Delete the guide frame so it doesn’t 
get printed in your book. Go to File > Export to > PDF… 
Choose Best image quality and save the PDF to a new folder. 

2 Place a guide
Add a new rectangular Shape the same size as your 

page. This acts as a guide, so you can keep your images 
inside its boundaries. If you like to use Guides, clicking Show 
Rulers will allow you to drag them onto the edges of your 
Shape, your images will snap to them to prevent overflow. 

HOW TO | GEt A UNiqUE Photo book

SKILL LEVEL
Anyone can do it

IT WILL TAKE
15 minutes per page

YOU’LL NEED
oS X 10.10 or higher

tool 
school

Rectangular 
selection

Preview allows 
you to select 

only part of your 
image file, 

whether you 
want to crop or 

apply an effect. it 
used to be 

represented by a 
button on, but in 
recent versions 

it’s hidden in the 
tools menu. 
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7 Add to a book
Adding photos to book pages is as simple as dragging 

and dropping. For your custom Pages images, make sure ‘1 
Photo’ is selected in the Layout Options so it appears across 
the whole of the page. Use this setting for any full-page 
photos, adding text if needed using other options.

5 Convert
Open the PDF in Preview. As we laid out a page that’s 

larger than the book page, we need to crop away the excess 
white space. Use the Rectangular Selection tool to drag a 
box, then hit Crop (ç+K). Head to the File menu and select 
Export, then choose JPEG as the format and save to a folder. 

8 Ready to order
Make sure every piece of placeholder text has been 

replaced and every space for a photo has been filled – Photos 
will not let you proceed with missing images but it will if 
there’s placeholder (lorem ipsum) text in the book, although 
it does warn you. Hit Buy Book to place your order.

6 Import to Photos
Repeat these steps for every page you want to create. 

Import your final JPEGs into Photos, and add them to an 
album. Select a type of book to create a project. Choose the 
album, click + then Add to Book. Choose the book size, a 
Theme, and it should appear with photos along the bottom.

Apple’s photo books are charged to your Apple account 
and will ship in three to five business days. While they may 

be convenient, Apple’s books are some of the most expensive 
in what’s become quite a crowded marketplace. The process 
of laying out images in Pages beforehand can be used for 
any printing service that allows you to upload images to a 
website before organising them into a book, so shop around 
to find the best deal out there before you commit.

Competitor services include Photobox, Blurb, Snapfish, the 
supermarkets and chemists, and while all offer slightly 
different services photo books are very common now. Even if 
still decide on an Apple photo book, you might pick up some 
inspiration along the way.

the end result

UNUSED 
phOTOS

Photos provides 
an Unused 

Photos button at 
the bottom of 
the interface 

when creating a 
print product. 

this is incredibly 
useful if you’ve 
added lots of 

photos to your 
project but 
haven’t yet 

found them all a 
home on the 
pages of your 

book, as it flags 
up those you 

haven’t placed. 
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Despite being 
primarily a vector-
based software 
package, Affinity 

Designer has an extremely good 
range of pixel editing tools in its 
Pixel Persona. In this, the final part 
in our Designer series, we’ll be 
exploring some of these and 
discovering just what a complete 
package Affinity Designer really is! 
We’ll also be learning another 
method of exporting images – 
this time we’ll be using Affinity 
Designer’s third and final mode 

known as Export Persona.
Now that we’ve finished the 

main image, we can add the 
last finishing touches to it. This 
will be a good place for you to 

experiment with the different 
things you’ve learnt over the 

course of the series. We decided 
that it would be a nice idea to hang 
a copy of our fish tank image on the 
wall and then give it a bit of a shadow. 

Over the past few issues you will have 
hopefully got to grips with Affinity 
Designer and come to your own 
conclusions about the software. 

Although software such as Adobe 
Illustrator is a much more complete 
vector editing package, Affinity Designer 
will happily give it a run for its money. 
And when you consider the price 
difference of the two, Designer becomes 
a very viable option. James Robinson

Adding the finishing touches
In the final instalment we’ll be exploring Affinity Designer’s Pixel Persona

1 Export the image
The first thing that we’ll do is export the image. There 

are a number of ways to do this, some we’ve already covered 
before, but this time we’ll be using Designer’s Export Persona. 
First of all you’ll need to select this mode by clicking on the 
icon on the top left-hand side of the window. 

2 Exporting multiple resolutions
There are different settings to use when exporting, 

but if you want to export multiple resolutions for the web 
then you can do this by ticking the resolution boxes at the 
top of the layers palette. You can then select the Export icon 
on the layer to export all three resolutions. 

HOW TO | fINIsh yOur PrOjEcT ThE rIghT WAy!

SKILL LEVEL
Taking things further

IT WILL TAKE
1 hour

YOU’LL NEED
Affinity Designer 1.3.2

VIEW 
mODES

you can view in 
three different 
modes. Pixel 
view mode 

is a standard 
resolution. retina 
Pixel view mode 

displays your 
image as if it’s on 
a retina screen, 
while Outline 
shows just the 

shapes and line 
art of your image.

Now we’ve finished 
the main image, we 
can add the last 
finishing touches

Now that we’ve created our vector image we can move to Pixel Persona to add a few flourishes.
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5 Add depth to the table
After you’ve finished using the Smudge Brush Tool 

you can use the Dodge Brush Tool to lighten the shadow too. 
You can also give the impression of depth by using the Burn 
Brush Tool. Select this and ‘paint’ along the top of the table. 
This will make that part look darker and further away.

7 Scale the image
Once you’ve chosen your image you’ll need to click on 

the canvas to place it. Then scale it by clicking and dragging 
on any of the corners. By holding down various keys you can 
also choose to scale it from the centre (ç), keep its ratio 
(ß), ignore its snapping (å) and resize and rotate (≈). 

8 Add a shadow
To add a picture frame we gave the image a brown 

coloured stroke. A nice touch is to add a drop shadow to the 
frame. Do this by selecting the layer and clicking on the 
effects tab. You’ll then see an option for Outer Shadow. 
Clicking the triangle will give you options to add the shadow. 

3 Switch to Pixel Persona
Once you’ve exported your image you’ll need to 

switch from Affinity Designer’s Export Persona (or if you 
skipped the first two steps from its default vector-based 
Draw Persona) to its pixel editing mode, Pixel Persona. 
The icon for this is to the left of the Export Persona icon. 

6 Hang a picture on the wall
Once you’ve finished tweaking your scene with the 

pixel editing tools it’s time to hang the image you exported 
earlier on the wall. To do this we’ll start by placing the 
exported image within our scene. To do this, go to Place… 
which can be found in the File dropdown menu. 

4 Blur the shadow
We’re going to soften the shadow underneath the 

fish tank. It’ll help if you zoom into that area then select the 
Smudge Brush Tool icon in the tool palette. Make sure you’re 
on the shadow layer then click to blur the shadow edges. The 
Assistant tells you which layer will be rasterised. 

hELpINg 
hAND

Affinity Designer 
has a warning 
assistant that 

will prompt you 
before you make 
any changes to a 
layer that hasn’t 
been rasterised. 
This can be very 

useful if you don’t 
want to edit 
the currently 

selected layer. 
The assistant will 
warn you before 

you make any 
changes.

JARGON 
BUSTER
Pixel resolution 
is the detail that 
a digital image 
has. It is usually 

measured by dpi 
(dots per inch) 
and the higher 
the resolution 
the sharper an 

image is and the 
more detail it 

has. As a general 
rule, to print an 
image it needs 
to be 300dpi. 
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Email. Where would we be 
without it? Much happier if 
you believe the numerous 
surveys that say drowning 

in the stuff is making us miserable. We’re 
much more positive about the benefits 
of email, but we also get tons of it and 
still struggle to keep it organised.

Leaving all your email in your inbox is 
fine up to a point, as long as your email 
app of choice has a powerful search 
feature. Sadly, most don’t and so either 
struggle to find anything at all, or spend 
ages churning through thousands of 
messages only to turn up what looks 
like a completely random selection.

There’s another problem with never 
deleting or archiving email: storage. 
Whether you keep all your email locally 
on your Mac or entrust it to a cloud 
service like iCloud or Gmail, sooner or 
later you’re going to run out of space. 
If you send or receive large attachments, 
that’ll happen sooner rather than later. 

There are a number of different 
techniques for finding and organising 
messages in both Mail and Gmail. The 
latter excels at searching through 
messages, and so we can use its 
powerful search operators to identify 

messages we want to process. Both Mail 
and Gmail provide tools to deal with 
messages automatically as they are 
received. In Mail these are called Rules 
and in Gmail, filters. We’ll show you how 
to use both to get on top of email.

Thankfully, knocking your email into 
shape is straightforward and doesn’t 
take long at all. Kenny Hemphill

Banish email cruft
Overcome email overload with our tips that help you get on top of it

1 Create a Smart Mailbox
In Mail, go to Mailbox > Smart Mailbox and then enter 

a name. We’ve called ours ‘Old mail’. Set conditions messages 
must meet in order to appear in the mailbox. We’ve chosen 
‘Date last viewed is not in the last year.’ Press OK and you’ll 
have a collection of messages you’re unlikely to read again.

2 Archive old mail
Choose Mailbox > New Mailbox, name it, and choose 

‘On My Mac’ as its location. Click on your Smart Mailbox and 
press ç+A to select all its contents, then drag them into 
the new mailbox. ≈-click on the new mailbox, select Export 
Mailbox and save the archive. Finally, delete the mailbox. 

HOW TO | FILTER, ORGAnISE And ARChIvE YOUR EMAIL

SKILL LEVEL
Anyone can do it

IT WILL TAKE
30 minutes

YOU’LL NEED
OSX 10.10 or higher,  

a Gmail account

SEVERAL 
ACCOUNTS
You can add up 

to five POP3 
accounts to 

Gmail, and use 
the processes 

outlined in this 
tutorial to 

manage them, 
then delete the 
mail from your 
local email app. 

To add accounts, 
go to http://bit.

ly/1UyhqT1. 

Both Mail and Gmail 
provide tools to deal 
with messages 
automatically when 
they are received

Use Smart Mailboxes and rules to organise messages in Mail and easily get rid of anything you don’t need.
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5 Find messages in Gmail
Gmail’s powerful search uses ‘operators’ to allow you 

to easily find messages. For example, type ‘from:[email 
address]’ to find every message received from that address. 
You can then select them all and label or archive them. 
There’s a full list of search operators at http://bit.ly/1LfcPuV. 

7 Use labels
Click a message’s checkbox to select it, then click the 

Labels button, ‘Create new’, and type a name. Click the cog 
then Settings > Labels to choose whether the label is shown 
in the sidebar. Even archived mail retains its label; it will show 
up when you click the label in the sidebar or search for it.

8 Set up filters
To make labels work on incoming mail, not just 

retrospectively, go to Settings > Filters and click ‘Create a new 
filter’. Fill in the form to choose messages the filter will apply 
to. Click ‘Create filter…’ and set actions to perform – say, ‘Skip 
the Inbox’ and ‘Apply the label’ to archive and label messages. 

3 Use rules to process new mail
Create and name a new mailbox. We’ve made one for 

marketing emails. In Mail > Preferences, click Rules then Add 
Rule. Set your conditions. We’ve chosen ‘If any’ and then 
listed known email addresses for marketing. In the actions 
section, we’ve chosen to move messages to our new mailbox. 

6 Delete as well as archive
Google archives messages by default, rather than 

deleting them; they disappear from your inbox, but they’re 
still using space. Start by entering ‘larger:2M’ to find large 
attachments. Optionally, add ‘Older:mm/dd/yyyy’ (adding 
a date in US format) to find old items. Select all and delete. 

4 Apply rules to existing mail
Now you know how to create Rules, set a few up to 

organise your mail, say by separating work and personal mail 
into different mailboxes. To apply rules to mail you’ve already 
received, select the mailbox where it’s stored, press ç+A to 
select everything in it, then choose Message > Apply Rules.

FOLDERS 
IN GmAIL

Google no 
longer uses 

folders, although 
confusingly it 

retains a folder 
icon when you 
read a message 
and allows you 

to ‘move’ the 
message to that 
folder. What that 
actually does is 
apply the label 

you select to the 
message and 

archive it.

JARGON 
BUSTER

Though Rules 
and Smart 

Mailboxes are 
similar, there’s a 

crucial difference. 
Rules move your 

messages to 
wherever you 
specify. Smart 
Mailboxes can 

show messages 
from different 

folders, but items 
are left in their 

original location.
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Are you sure your Mac’s 
screen is working properly? 
If you do anything with 
colour, even making basic 

image adjustments in the Photos app, 
you need to know you’re seeing things 
as they really are. Even if your screen 
was set up perfectly in the past, its 
performance will drift over time and 
end up misleading you. ColorSync 

profiles help your Mac know about any 
deficiencies of your screen so it can 
adjust what’s sent to the display to 
compensate. This doesn’t alter your 
images, just the data that goes to your 
screen, giving you more predictable, 
trustable results when you print or share 
images, video and other files.

Calibrating your screen and creating a 
ColorSync profile is quick and easy, but 

it’s something we all forget to do. We’ll 
show you how to do this to a basic level 
using OS X’s built-in Display Calibrator 
Assistant, and how to use DataColor’s 
Spyder5 calibration tool to produce a 
more precise, reliable profile. The end 
result shouldn’t be dramatic (well, not 
unless your screen was disastrously bad 
to begin with), but the peace of mind 
this brings is tremendous. Keith Martin

Calibrate your display’s colour
Make sure your screen is accurate by creating a ColorSync profile each month

SKILL LEVEL
Could be tricky

IT WILL TAKE
5 minutes

YOU’LL NEED
Apple’s Display 

Calibrator Assistant 
(for basic profiling) 
or the DataColor 

Spyder5 (for more 
advanced profiling) how to | CAlIbrATE AnD PrOfIlE yOur SCrEEn

Use the Display Calibrator Assistant
Open System Preferences in OS X, click Displays, choose the 
Color tab and click Calibrate to open the Display Calibrator 
Assistant. With the Expert Mode option checked, follow the 
on-screen instructions. You’ll be asked to match the flat grey 
of an Apple logo to the tone of black and white stripes. 
Squinting to blur your vision slightly can help.

Use the Datacolor Spyder5
OS X’s calibration tool is useful but basic. DataColor’s Spyder5 
uses a specialist colorimeter rather than your eyes to create a 
precise, detailed ColorSync profile, giving you much more 
reliable and consistent results. Run the Spyder5 software, 
connect the colorimeter, then follow the on-screen steps.

Save the new profile
When you reach the steps where you select a target gamma 
setting and a target white point, put a tick in the checkboxes 
to use the ‘native’ options unless you have particular reasons 
to do otherwise. Finally, give your new profile a name. We 
strongly suggest including the date in the name so you can 
compare this against profiles you make in the future. 

Saving and comparing profiles
Once the range of colours has been sampled, you can name 
the profile (with the current date to help comparisons) and 
then preview it. Switch between uncalibrated and calibrated 
views to see the difference the profile makes. Use System 
Preferences > Displays > Color to check against other profiles.

EYE TEST
A dedicated 

hardware sensor 
will always 

outperform your 
eyes, which is 

why we 
recommend 

devices such as 
the Spyder5. 

The basic 
Spyder5EXPrESS 

is ample, and 
you can upgrade 

the software 
later if you want 
more features.
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Finder fades into the 
background to the 
point you often forget 
it’s an application. Yet 

chances are you use OS X’s file 
manager very regularly, in order to 
access files and folders, browsing 
your Mac’s drives as you go. On that 
basis, it makes sense to ensure that 
Finder is as efficient as possible.

In this tutorial, we’re providing a 
plethora of tips, showcasing many 
of Finder’s shortcuts and features 
that can speed up workflow. But 

there are a couple of things we 
didn’t have space for elsewhere, 
which we’ll cover right now.

In Finder’s preferences, two 
important defaults can be set. In 
General, ‘New Finder windows 
show’ has ‘All My Files’ as the initial 
selection, but you can change this 
to any folder on your Mac. If, for 
example, you live in Dropbox, it 
would make sense to select that 
folder, which would then be 
displayed as soon as you open a 
new Finder window. Advanced has 
a similar option: ‘When performing 
a search’. This is set to ‘Search This 
Mac’, but can be changed to search 
the current folder or use the 
previous search’s scope, depending 
on what you most often do.

Now read on for many more tips 
about how to get the best out of 
the humble Finder. Craig Grannell

Make Finder more productive
Learn about the shortcuts that can speed you around OS X’s file manager

SKILL LEVEL
Anyone can do it

IT WILL TAKE
15 minutes

YOU’LL NEED
OS X 10.10 or higher

It makes sense to 
ensure that Finder is 
as efficient as 
possible, boosting 
your productivity

1

2

3

4

QUICK LOOK 
cuSTOMISe AND 
NAvIGATe FINDer 

Sidebar 
favourites

1  In the Sidebar 
section of Finder’s 

General preferences, you 
can define which system 
folders, shared items, 
device types and tags 
you want visible in all 
Finder windows and 
Open/Save dialogs.

Custom 
favourites

2  Should you want 
to add custom 

folders or documents to 
the sidebar, drag them 
from Finder. Apps must 
be ç-dragged. 

Containing 
folders

3  ç-click the title 
bar of a Finder 

window and you’ll see 
its containing folders. 
Select one and the view 
will change. ç+ß-
select one and the folder 
opens in a new tab.

Toolbar 
customisation

4  ≈-click a Finder 
toolbar for options 

to show icons-only, text-
only or both text and 
icons. You can also access 
the ‘Customize Toolbar’ 
sheet for adjusting 
Finder buttons/spacing.

Spaces and 
groups

5  Finder toolbar 
items are 

positioned, added and 
removed using drag and 

drop. Use spaces to make 
uncluttered and logical 
groups of buttons.

Actions
6  The Actions button 

provides fast 
access to Finder 
commands, such as 
duplicating items and 
arrange options.

Get Info
7  The Get Info 

button mirrors File 
> Get Info (ç+i), 
providing a window 
with details for each 
item. Use ç+ß+i 
on multiple selected 
items and their Get Info 
window is grouped.

Preview 
column

8  You can add a 
preview column to 

all Finder views by using 
View > Show Preview 
(ç+ß+P). 

Path bar
9  The path bar is 

akin to the 
containing folders menu, 
except you can drop 
items into any of the 
small folders. Double-
click to open a folder. 
≈-click for the Open/
Show options.

Status bar
10  This details the 

number of items 
in the current folder and 
space available on the 
drive. In Icon view, you 
get an icon size slider.

56

7

8

9
10
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1 Use the Go menu
You can stash favourite places in Finder’s 

sidebar, it’s quicker to use keyboard shortcuts 
though. Click the Go menu to see all examples. 
Note ‘Library’ is hidden in Yosemite, but can be 
accessed via Go by holding å. Drag the folder 
to the sidebar for faster subsequent access. 

4 Access favourite places
What you place in Finder’s sidebar 

impacts what you see in Open and Save dialog 
boxes. In both cases, favourites (along with 
shared items and devices) are mirrored. You can 
reorder, add and remove individual items from 
the sidebar directly from within dialog boxes. 

6 Change your view
Each view type – Icon, List, Columns, 

Cover Flow – has its own keyboard shortcut, as 
do arrange types, such as listing by name, date 
modified or size. Since certain view types work 
best in specific circumstances, being able to 
quickly switch between them saves time. 

2 Get around faster
 Navigate Finder windows using the 

keyboard. Tap out letters to jump to items 
beginning with those characters. Use the cursor 
keys to change the currently selected item. Use 
ç+… to go up one level in the folder hierarchy, 
and ç+æ to open a selected folder.

5 Switch views
If you drag any item to the file list in a 

dialog box, the folder shown in the dialog box 
will switch to the location of the item; and many 
keyboard shortcuts – including for views and Go 
menu location shortcuts (such as ç+ß+D for 
Desktop) – work there. 

8 Sort out your Desktop
Use View Options to sort everything by 

name, and use a fairly big icon size, to make 
things clickable. In Finder’s General preferences, 
define whether or not you want hard disks, 
external disks, optical media and servers to 
appear on your Mac’s desktop. 

7 Explore view options
With any Finder window open, go to 

View > Show View Options (ç+J). Options for 
the current window are shown. These are 
specific to the current view. For example, in Icon 
view, there’s a slider for icon sizes. Arrange/sort 
options can be defined for individual folders. 

3 Copy, paste and move
When filing a document, it’s very easy to 

drag it to the wrong place. Select the item you 
want to move in Finder and then use Copy 
(ç+C). Find the target location in Finder and 
then either use Paste (ç+V) to send a copy, or 
Move Item Here (ç+å+V) to move the item. 

HOW TO | SpeeD up WOrkING IN FINDer

A CLASSIC LOOK
You can hide the sidebar, 

toolbar and path bar. use the 
view menu or related 

shortcuts to achieve this. Note 
that with the toolbar hidden, 

you can’t use tabs. 
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Notification Centre is one 
of the most important 
aspects of OS X, and yet 
it is rarely used to its full 

potential. Hidden at the right-hand side 
of your screen, Notification Centre has 
all but replaced the Dashboard feature 
that was introduced 10 years ago in 
OS X Tiger. It gathers both widgets and 
alerts in one sidebar, accessible by 
clicking the list-like icon in the top-right 
corner of the screen or swiping inwards 
with two fingers from the right edge of 
a trackpad, and is vital to staying on top 
of things – as they happen or later on.

The sidebar is divided into two tabs. 
The Today view manages your domestic 
information: the date, the weather, your 
daily calendar, and the stock market. Its 
contents can be customised by clicking 
the Edit button at the bottom, so you 
can add widgets provided by Apple – 
such as the Social widget that gives you 
a quick way to send texts, tweets and 
Facebook status updates (provided 
you’ve added your login details in 
System Preferences’ Internet Accounts 
pane) – and with third-party apps such 
as Wunderlist, Fantastical and Deliveries. 
Many widgets can be configured by 
putting the pointer over them and 
clicking the ‘i’ that appears at its top-
right corner. You can add locations to 
the Weather and World Clock widgets 
and companies to the Stocks section. 

The second tab is for notifications, 
and it manages every bit of information 
sent to you by apps, such as emails, 
reminders, iMessages and calendar 
events. When a notification is shown, 
sliding in at the top-right corner of the 
screen, it comes in one of two formats: 

banners disappear automatically after a 
few seconds; alerts, in contrast, stay on 
the screen until they are engaged with. 
In System Preferences > Notifications, 
you can specify whether notifications 
appear as alerts or banners on a per-app 
basis. In both cases, you can control an 
app directly from a notification; for an 
iMessage, say, you can choose to reply, 
which opens a text box in the alert, 
rather than going to the Messages app, 
or you can mark the message as read, 
which dismisses the notification.

Any item that is not engaged with 
gets added to the Notifications tab in 
Notification Center (unless you have 
turned off ‘Show in Notification Center’ 
for that app). Items in that tab are listed 
chronologically, but also grouped by 
app. For example, if you receive a text 
message at 12:00, followed by an email 
at 12:05, the email message will be 
shown above the text message. 
However, if you then receive another 
text message at 12:10, both the recent 
text message and the older one will be 
placed above the email. So, no matter 
how many notifications you get from 
different apps, they remain grouped. 

Of course, notifications can be 
suppressed. Do Not Disturb hides all 
banners and alerts until midnight, or 
until you turn it off. It can be scheduled 
to turn on for part of the day, so you can 
keep your Mac on overnight without 
noisy interruptions. Adam Smith

Take control of notifications
Learn how to make Mac notifications work better for you

Notification Centre 
has all but replaced 
the Dashboard that 
was introduced in 
OS X Tiger

Notification Centre enables you to manage alerts that come from your Mac’s apps and some websites.

You can schedule 
Do Not Disturb to mute 
notifications between 
two times, and so 
banners and alerts 
don’t distract you.

SKILL LEVEL
Anyone can do it

IT WILL TAKE
30 minutes

YOU’LL NEED
OS X 10.10 or higher



hELpfUL 
SITES

You can set up 
certain websites 

to send you 
notifications; the 
New York Times, 
for example, will 
offer to alert you 
to new content, 
while eBay will 

send you a 
notification 

when changes 
are made 
relating to 

your account.
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HOW TO | gET MOrE FrOM NOTIFICATIONS

JARGON 
BUSTER
The widgets in 

Notification 
Centre’s Today 

tab are a type of 
Extension, and in 

addition to 
managing them 

from the Edit 
button at the 
bottom of the 

tab, you may find 
it easier to 

reorder them in 
the Extensions 
pane in System 

Preferences, 
especially if you 
have many of 
them installed.

1 Quickly activate Do Not Disturb
Saving a few seconds can be important, so rather 

than wasting time opening Notification Centre and scrolling 
to the top of its Notifications tab in order to activate the 
Do Not Disturb mode, you can also activate it instantly by 
å-clicking the Notification Centre icon in the top-right 
corner of the screen. The icon is greyed out when Do Not 
Disturb is active, and black when it is not.

3 While your Mac is locked
Select an app in the Notifications preferences pane 

and you’ll see a checkbox that decides whether its items 
appear on the Lock screen (shown when your Mac wakes 
and ‘Require password…’ is enabled in Security & Privacy). 
Some apps, like Messages and Mail, can preview message 
contents on the Lock screen (‘always’), only at the Desktop 
(‘when unlocked’), or you can turn off previews altogether.

2 Respond from a notification
Some notifications provide actions that are specific 

to the originating app. For example, if you hold down the 
Snooze button in an alert from Reminders, a drop-down 
menu will appear. You can then set the amount of time you 
want to pass before the alert activates again, giving you 
more flexibility than the automatic 15 minutes that are 
assigned if you simply click the Snooze button instead.

4 Settings you might miss
Some apps provide extra control of their notifications, 

though not always in the Notifications preferences pane. 
In Mail’s preferences, for example, click General and you‘ll 
find options that specify which messages trigger 
notifications: all new messages; just those in your inbox, 
rather than moved elsewhere by rules; those sent by your 
designated VIPs; or those from any of your known contacts.

5 Open using a Hot Corner
Notification Centre can be opened just by moving the 

pointer to a corner of the screen. Go to System Preferences > 
Mission Control, click ‘Hot Corners…’ and then click one of 
the drop-down menus. Optionally, hold any combo of ç, 
å, ≈ and ß while doing this to require those keys to be 
held too, which avoids accidentally triggering the action.

6 Sort notifications manually
To have items in Notification Centre’s Notifications 

tab listed in a specific order, go to System Preferences > 
Notifications and change the sort order (at the bottom-left 
of the pane) to ‘Manually’. You can then set the order of your 
applications by dragging and dropping their icons in the 
left-hand pane to prioritise your most important apps.
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Get more from Pixelmator
Get creative with your pictures using this excellent and affordable app

visual guide | FindinG your way round Pixelmator 

SKILL LEVEL
anyone can do it

IT WILL TAKE
30 minutes

YOU’LL NEED
iPad, Pixelmator

Icons
1  The paintbrush icon brings up the 

main Tools palette with access to the 
app’s creative tools. The + icon enables you 
to add images, layers, text and shapes. The 
cogwheel brings up the app settings and 
also includes image setup. The share icon 
lets you save and share your images. 

The Tools menu
2  This is the main access point to 

Pixelmator’s toolset, which features 
brush-based tools, colour adjustments, a 
variety of effects, plus tools for creating 
selections and cropping. Format provides 
additional control over individual layers. 

The layers palette
3  Pixelmator comes with a fully-formed 

layer system, which enables you to 
duplicate images, overlay effects and add 
text and shapes. Tapping a layer also brings 
up a menu for additional control over 
opacity (how transparent or not a layer is). 
Plus blend modes and context-sensitive 
options such as stroke, drop shadow, 
reflection and so on.  

the Photos app on your 
iPad provides a handful of 
useful editing tools, 
enabling you to make 

basic tweaks to your images. you can 
crop and rotate an image, apply a 
selection of preset filters, dial in 
brightness and saturation… and that’s 
about it. if you want to get creative with 
your imagery, Pixelmator (£3.99) is an 

ideal next step. this fast, easy-to-use and 
affordable image editor provides a raft 
of tools, including brushes and layers, 
text and shapes, retouching, distortion 
and more. it’s great for taking your 
photos to another level – or even 
creating an image from scratch. 

the app is simple to use, with all 
the tools accessible from a few menus. 
it plays nicely with the Photos app, 

loading images directly from your photo 
library and Camera roll, and you can 
even link it to the Photos app, enabling 
you to make basic edits there, and then 
take your photo directly into Pixelmator. 
this workflow limits you to using 
Pixelmator’s effects menu, although 
you still have plenty of creative freedom. 
tapping done sends you back into your 
iPad’s Photos app. Steve Jarratt

Add Effect presets
4  Tapping the Add Effects menu brings 

up a palette of 14 different options, 
including Blur, Sharpen, Hue & Saturation, 
Light Leak, Bokeh, Focus and Kaleidoscope, 
all with their own controls. The Add Effects 
menu also offers a small, live preview of 
your image with each effect applied, so  you 
can see what your image will look like 
before you set about making changes.

Images
5  Tap here to close the current image 

and go to Pixelmator’s Image Gallery. 
This enables you choose a new image to 
work on: this can be from scratch, from 
iCloud Drive or from the Photos app. You can 
also use Images to open an existing project 
(images are saved with layer information 
intact) and use Images to rename or delete 
existing files.

Undo
6  Pixelmator has a whopping 50 levels 

of undo available, enabling you to 
experiment freely, knowing that you can 
always backtrack through your work if you 
need to. Of course, with the layer system it’s 
always wise to save a copy of your image as 
a standby just in case you do happen to run 
out of undos – although that’s only likely to 
happen with very complex images.

Pixelmator has 
a clean look 
that’s right at 
home on ioS, 
making it 
easy to use

1

2

3

5 6

4
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1 Load an image
Time to fire up Pixelmator and load an 

image. There are a variety of ways of getting 
digital photos onto your iPad: You can load 
them from your camera via USB and an adaptor. 
You can also sync or share them using iTunes, 
My Photo Stream, iCloud Photo Sharing, iCloud 
Drive and even Dropbox. We also suggest Files 
App (http://getfilesapp.com), which is useful for 
sharing files between iOS and OS X. In Files App 
simply use ‘Open in…’ and choose Pixelmator.

4 Retouching the image
Let’s bring out the blue flowers and 

darken the green stem. Tap the paintbrush icon 
to bring up the Tools menu, hit Retouch and 
select Darken. This brings up a brush with which 
to paint over specific areas. To adjust the size 
and strength, tap on the numeric values (top-
right); this brings up a menu showing the brush 
stroke. Always start with low strength values 
until you get a feel for what the tool does. Next 
we’ll do the same thing, but using the Saturate 
brush to make the blue petals more vivid. 

2 Image setup
We’ve chosen a macro shot of some 

flowers – it’s an OK image but lacks interest. You 
have the option of using Image Setup to define 
the size in pixels, or you can tap once on the 
image to bring up handles to manually resize it 
and pan around the canvas. To rotate, just place 
two fingers on either side and move them in 
opposite directions. Once you have the image 
set up as you’d like, zoom in and out and pan 
around with finger-pinches and by dragging.

5 Adding effects
Hit the + symbol (top-right), and in the 

second tab, select the dark rectangle to add a 
solid black layer. In the layers panel, tap it, select 
‘Style’ from the menu and change the Blending 
from Normal to Screen. Now we can see the 
flowers again. Open the Tools menu and tap 
Add Effects; this brings up a menu of 14 options 
for adding blur, bokeh and more. We’re going to 
use the Bokeh menu to add a sparkly, ethereal 
vibe. Use the two black handles to position, 
rotate and scale the Bokeh image to your liking. 

3 Duplicating a layer
Even though Pixelmator has an undo 

feature, it’s useful to make a duplicate layer to 
work with. Tap anywhere on the image and hit 
Duplicate. Now if you swipe in from the left, 
you’ll see the layers. The new layer has been 
created and sits on top of the original with a 
blue outline. To reorder layers, tap and hold, 
then drag them to their new position. To cut, 
copy, delete or hide a layer, tap to highlight it, 
then tap again to bring up the layer menu. 

6 Using Blending modes
Hit Done to apply the effect, then tap the 

black layer which has the Bokeh image. In the 
menu, tap Style and adjust the Opacity to 
around 50%. You can also play around with the 
Blending modes – Color Dodge also gives a nice 
effect in this instance. To finish the image, we 
added another Bokeh layer, called Magnolia, 
then reduced the opacity and added a Blur 
effect. This brings up a small wheel, which you 
dial up or down the amount of blur. We then 
added a Hue & Saturation effect. 

HOW TO | loadinG, uSinG layerS and addinG eFFeCtS
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1 Changing image size
We’ve copied a 4,096x2,731-pixel photo 

using Dropbox, and our first step is to make it 
more manageable. To alter the size, tap the 
cogwheel to bring up the Settings panel, then 
hit Image Setup. At first it doesn’t do anything: 
you need to tap the text saying 4,096x2,731 – 
this opens the Adjust Size panel. Here you can 
key in any size you need, and constrain its 
proportions if need be. We’re going to reduce it 
by half. Once you’re happy, tap anywhere off the 
panel to close it, then hit Apply.

4 Cloning in details
The Repair tool has done a pretty good 

job, but we can improve it by cloning in any 
missing detail. Open the tools palette again, 
open the Retouch options then select the Clone 
tool. Place the black marker at the end of the 
‘rope’ where you want to copy from, then simply 
paint where you want to copy to. Here we’ve 
duplicated a few bushes to tidy up the area by 
the pillar. We also cloned out the entrance sign 
and painted in some new gravel. We even 
manage to remove some of the people by the 
fountain with the Repair tool.

2 Cropping the image
For our vintage-look image, we need to 

make some changes. There are people dressed 
in contemporary clothing on the right and a guy 
by the pillar. Lets get rid. First of all, it’s easier to 
just crop the family from the edge of the image; 
to do this tap the Paintbrush icon and select 
Crop. You can drag the crop window around or 
adjust it using the handles in each corner, or by 
dragging on an edge. You can keep the original 
aspect ratio or choose a different one using the 
Aspect Ratio options at the bottom.

5 Colour correction
Now let’s make the photo look aged. You 

can give it the popular 1970s Polaroid look by 
going into the Tool palette, and tapping on 
Adjust Colors; the Sepia preset does a pretty 
good job on its own. But we want a look that’s 
even older. First we’ll add the Warm preset and 
then decrease the Saturation level slightly, and 
increase the Contrast. Hit Apply, then go into 
Add Effects and use the Hue & Saturation to 
give the photo a faded brown-purple tone. To 
control individual colour channels, tap the 
colour dots at the bottom and Hit Apply. 

3 Using the retouch tool
Now to deal with the guy in the red top 

using Pixelmator’s intelligent retouching tool. 
Tap the paintbrush icon to open the Tools panel 
and select Retouch. To start, we’ll try using the 
Repair tool. Like the other brush tools you can 
adjust the size by tapping the numerical values. 
We’ll zoom in on the image, and use a fine brush 
to paint over the figure. It’s a good idea to cover 
the figure in one go. However, we did one main 
paint stroke, then some smaller ones to remove 
any bits we’d missed. Tap Done to close the tool.

6 Add the final touches
Staying in the Effects menu, we then 

apply a Vignette effect with a value of 150%. 
Next we’ll add a new solid black layer set to 
Screen mode. This is so we can apply Light Leak 
effects and some speckles, and tone down their 
colour and saturation separately. Now we’ll add 
the ‘Blurry’ frame template. To use it, we had to 
save our vintage picture to back to Photos. In 
Pixelmator’s gallery, hit the + icon (top-left), and 
from the Create Image menu select the frame 
you want. Tap the + icon (bottom-right), and 
import your edited image into the frame. 

HOW TO | CreatinG a vintaGe PhotoGraPh
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1 Adjusting the colour
First, we’ll load our train photo. The scene 

was shot on a bright sunny day, but it’s a little 
flat for our purposes, so open the Tools panel 
and select Adjust Colors. We want the image to 
be vivid and ‘hyper-real’, so let’s increase the 
Contrast and Saturation by 20% each. Then 
move the Temperature slider by 10% to warm 
things up a bit and tweak the curves to brighten 
the midtones. Tap Apply. If you’re not confident 
with colour channels, the Vibrant preset in 
Adjust Colors will do much the same thing.

4 Add the tilt-shift effect
For the tilt-shift effect, go into the Tools 

palette and select Add Effects > Miniaturize. 
There are two black handles: the large one 
shows the ‘focal point’, while the smaller one 
determines the extent of the effect. We want a 
narrow depth of field, so lets put the focal point 
on the train, keep the handles close together 
and crank it up to 100%. To make even the 
effect more extreme, we apply the effect again. 
You could also duplicate the layer and apply the 
effect to the uppermost version – then dial back 
the opacity if it’s too much. 

2 Object removal
For our tilt-shift photo, let’s tidy things up 

a bit by removing the kids running down the 
bank – these will look too much like real people 
and will distract the eye from the train. In the 
Tools palette, select Retouch and then the 
Repair icon. Using a smallish brush, paint over 
each figure, making sure to completely cover 
them. Pixelmator does a good job in removing 
them from the scene – fortunately, these areas 
will be blurred in the final image, so there’s no 
real need to use the Clone tool to tidy up.

5 Vignetting and noise
Our image is nearly complete. In Tools > 

Add Effects, we’ll throw on a Vignette set at 70%, 
which helps sell the tilt-shift effect and draws 
the eye to the centre. Next we’ll add some Noise 
set at 10%, just to add a little grain and tie the 
whole image together. Finally, we’ll add another 
solid black layer, and apply a Light Leak (the one 
titled Pavo). With the layer set to Color Burn and 
20% opacity, it adds a bit of richness and texture 
to the image. If you choose to apply the effect 
as a separate layer you can easily tweak and 
change it to your heart’s content. 

3 Replacing the sky
Our sky is a bit boring, so we found a nice 

replacement and added it as a layer beneath the 
steam train. We then used the Tools > Select > 
Magic Wand to select our original sky. The 
region gradually turns grey as you move your 
finger, so you can gauge how much to select. 
It’s then easy to pick an Erase brush and paint 
out the sky.  To check your progress, Hide the 
layer beneath to see the alpha channel. Now to 
work on both layers as one, tap and hold the sky 
and drag it on to the train layer to group them. 

6 Adding shapes and text
Finally, lets add some text and a graphic. 

Pixelmator has a selection of shapes and text, 
added via the + icon (top-right). You drag the 
item into position and then scale it with the 
handles; text is edited by tapping on the text 
box. You can make further refinements by 
selecting the item in the layer palette, and 
tapping Styles. This shows a menu with options 
for colour, outlines, drop shadows, and so on. 
Your finished image can be shared via Messages, 
Mail and iCloud Photo Sharing; opened in 
another app, saved to iCloud Drive or Photos. 

HOW TO | CreatinG a tilt-ShiFt eFFeCt
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Have your say on 
everything Mac, 

OS X and iOS

Mailed it!
I read your Best Mail Alternatives (MF291) 
with interest, as I have never been a fan of 
Apple Mail and was delighted to see you 
recommend Postbox. I am a Postbox user, 
but you don’t mention in your article its 
ability to display and compose messages in 
one font size, yet send them in another.

My eyesight isn’t brilliant, but Mail is the 
only app where I struggle to read the text on 
the screen. I know with many email apps 
you can use the ç and the + key to zoom in, 
but this is rather solution. If I use a larger 
font size, it means the recipients also receive 
my emails in that font size, and as someone 
who is self-employed it worried me that this 
would not look very professional. 
I used to compose my messages in 
font size 16, and when I was ready to 
send it I would then change it down 
to 12. But I lost count of the number 
of times I forgot to do this, hitting 
send before reformatting. Then one day a 
client replied saying that although I hadn’t 

Welcome...

Get involved
Apple Mail 62
Photo Stream 64
Mac User Groups 65
Ask the Experts 69

There’s always plenty to say 
about Apple, whether it’s 
good or bad. And we’d 

particularly love to hear what 
you think? Write to us at 

letters@macformat.com and 
the remember, the Star 

Letter wins a prize!

  Emailing your questions to 
letters@macformat.com

  Visit macformat.com for 
more great Mac news

  Join the conversation with  
our Facebook page

  Keep up to date by following 
us on Twitter at @MacFormat

Are you on App.net? So are we!  
We’re @MacFormat there too

Subscribe to our videos at 
 youtube.com/MacFormatUK

Join us online

You’re a winner!
Drop us an email at letters@macformat.com.  

If yours gets picked as the MacFormat Star Letter, 
you win a Just Mobile AluCable Flat for connecting 

iOS devices with a Lightning port to a Mac.

used capitals, my 
size 16 font size in 
emails made him think 
I was shouting!

Postbox resolves this problem. It has two 
font size settings – one for display purposes 

(both reading and writing emails) 
and one for when you actually come 
to send the email. It’s such a simple 
idea, but one Mail and other apps 
(including those you also tested in 
your feature) haven’t cottoned onto 

yet. Although I’ve sent emails to Apple 
pointing this out, there seems little sign of 
them actually taking on board comments 
from users. Then again, perhaps I should 
send them an email using a larger font size, 
so they can actually read what I’ve written 
on the screen!
Simon Whaley

Alex Blake says… A great tip,Simon, and 
yes it seems to be a feature that’s not often 
explored in email apps.

As you say, Postbox has Display Font and 
Composition Font choices. The Display Font 
controls the size on non-HTML formatted messages 
that you receive as well as those you compose 
yourself. Composition Font determines how your 
recipient sees the message, and it’s not just font 
size either. Postbox allows message recipients to 
see messages with a different font, colour or 
background too.

Last issue, Postbox 4 
topped our group test of 
Apple Mail alternatives.
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Voicing opinion
For many years I would read the 
paper MacFormat magazine at the 
same time as doing various jobs 
around the house. When I initially 
swapped to the digital version on my 
iPad, I found it a bit frustrating since 
it was difficult to keep stopping to 
scroll down the page to the next piece 
of text. Then I realised that I could 
select all of the text on a page and use 
the Speak option to allow my iPad to 
read it to me while I got on with my 
job. Most of the time it uses the default 
English male voice, but once in a 
while the text is read in a completely 
different voice and language – the 
article on Music IO in Issue 288 uses a 
female voice in an unknown language.

Can you please tell me what 
determines the voice/language that 
is used since there is nothing on the 
page to indicate which will be used?
Geoff Hawke

Alan Stonebridge says… 
The voice that’s used is picked in 
Settings > General > Accessibility > 

Speech > Voices, but you can pick just one 
at a time. I’m unsure why your iPad is not 
sticking to that; check there’s a tick next to 
the one you want to hear. Sadly, you can’t 
use this with MacFormat any more; our new 
production software doesn’t render text as 
HTML. The upside is the digital edition’s 
design will improve in the coming months.

Out in the Snow
I am guilty of hanging on to my early 
2008 white MacBook (which I love). 
It’s had quite a few repairs and I’ve 
increased the memory so it’s been 
running very well on Snow Leopard 
for ages. I also have an iPhone 5s; my 
husband has an iPad and we have an 
Apple TV.

My printer broke yesterday and, 
after doing extensive research, 
I decided on the one I want to get as a 
replacement. Then I suddenly realised 
that it won’t run on 10.6.8. I’ve put up 
with being unable to use iCloud and 
having erratic syncing with the 
iPhone as I wanted to stay in my safe 
zone – but is it past time to buy a new 
MacBook or a MacBook Air? And, if 
so, how will I cope with the many 
changes in the OS? Or maybe I should 
just look around for any printer which 
will run Snow Leopard?

What shall I do?
Joan Fletcher

Christian Hall says… Printers are 
particularly guilty of not lasting too 
well on the software side, drivers 

are often left languishing as new models 
come to market so quickly.

This is likely to be less of an issue in more 
recent versions of OS X – many printers out 
now will go back to 10.8 or even 10.7, but it’s 
not uncommon for 10.6 to be beyond them 
now. As you’ve invested a lot in your 
MacBook we understand your wanting to 
keep hold of it, and you shouldn’t feel 
pressured to move on. But, hardware 
incompatibility with 10.6 is likely to hold you 
back. We did find that the late 2014 Canon 
Pixma MG5650 works with 10.6.8 though, 
and that can be found for around £50.

Alfred the Great?
As a new subscriber to MacFormat’s 
print edition, which I’m enjoying 
hugely, I think your Spotlight article  
(MF291) was very apposite. I have 
recently installed Alfred (alfredapp.
com), a productivity app for OS X, 
on my MacBook Pro. Yes, it does 
Spotlight, only much better, and a 
whole load of other stuff besides. 
It all becomes second nature as it 
quickly attunes itself to one’s Mac 
usage (file-searching, app-launching, 
etc) from a few keyboard strokes. 
The dock has gone into hiding and 
the trackpad… now, where is that?

You will be aware of Alfred’s 
existence, but for the benefit of any 
readers who are not, I would strongly 
recommend they check it out! The app 
will speed up their days and greatly 
increase the fun quotient of their 
Macs. The latest version (2.7.2) is free 

at the Alfred website (alfredapp.com). 
For advanced stuff, you need the 
Powerpack and Remote for iOS). The 
Mac App Store’s version is, sadly, 1.2 – 
from 2012. Any chance of MacFormat 
inviting Alfred to improve on that 
soon? Who knows, it might just reveal 
a few surprises under that bowler hat?
John Brown

Alan Stonebridge says… 
We certainly recommend readers 
check out Alfred if they find 

Spotlight’s capabilities insufficient because, 
as you point out, the app is free. Regarding 
the Mac App Store version, the developer 
provides an explanation at (http://bit.
ly/1F3E8eB); basically, it’s due to security 
restrictions on apps sold in Apple’s store.

iPad Post-its?
I love the magazine and especially the 
iPad version, subscribing for three 
years now. The only frustrating thing 
is remembering articles and being able 
to find them again quickly amongst 
the plethora of issues. So my 
suggestion would be to include some 
way of being able to bookmark or tag 
a certain article for future reference – 
almost like a pin or a Post-it note.
Greg Whiteley

Paul Blachford  says… We like this 
idea, Greg, but at present that’s not 
possible. Features are constantly 

being added to our software though so we 
may one day be able to incorporate that.

Don’t forget that you can use the Page 
Finder in each issue (tap the arrow at the 
bottom, then the top-right icon), or search 
back issues from the app’s Library tab.

Would you like to 
see something 
like virtual 
bookmarking in 
our iPad edition?

Spotlight’s improved in El Capitan, but Alfred has useful workflow tricks.
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Send the best of your iPhone shots to photos@macformat.com

Pier point The sun goes down on Hilton Head 
Island, South Carolina, beautifully captured on 
an iPhone 5s by Jon Mir.

Quay to success Torquay in the sunshine – why go abroad, eh? 
A lovely panorama from James Matthews… and no filter!
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Find fellow Mac enthusiasts near you! 

Search the list below to find your local Mac user group – and if  
you can’t find one, why not start one yourself? It’s easy and fun.

Berkshire MUG
vlsburia@me.com

Bracknell Forest MUG, 
Bracknell, Berks
bfmugoffice@gmail.com
bfmug.org

Bristol and Bath MUG
robert@bbmug.co.uk
bbmug.co.uk

ClubMac Ireland, Dublin
secretary@clubmac.ie
clubmac.ie

Cork University College, Cork
d.murphy@cs.ucc.ie
ucc.ie/mug

Cotswold MUG
paul@cotsmug.org
cotsmug.org

Cumbria Mac Enthusiasts, 
Barrow-in-Furness
contact@macenthusiasts.co.uk
macenthusiasts.co.uk

Edinburgh MUG, Edinburgh
Twitter: @edmug
edmug.org.uk

Exeter MUG, Exeter
examug@mac.com
examug.org.uk 
Twitter: @examug

London MUG, London
secretary@lmug.org
lmug.org.uk, @londonmacgroup
Facebook: facebook.com/
groups/35108081221

Midlands MUG, 
Birmingham
mmug.org.uk

OxMUG, Oxford
oxmug.org

South Essex MUG, Wickford, Essex
seal-apple.co.uk

South Wales MUG
terence.neels@btinternet.com

Suffolk Mac User Group, 
Ipswich
mikekwasniak@me.com
suffolkmacusergroup.co.uk

Sussex MUG
adamfield@gmail.com
sussexmug.org.uk

Three Counties MUG Luton, 
Bedfordshire
chris@3cmug.org.uk
3cmug.co.uk

Wessex MUGs Fareham, 
Dorchester, Bournemouth  
& Salisbury
www.wamug.org.uk

la tormenta Dan Oakes took this moody Spanish storm shot at a 
resort in Murcia. He used  the Drama and HDR Scape filters in Snapseed.
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Your questions answered by our Apple 
expert in residence, Luis Villazon

Get in  
touch

If you have a technical 
issue that you need 

help with, please 
email us at:   

sos@macformat.com

Time Capsule can 
create its own Wi-Fi 
network or extend 
an existing one.

   When I installed my Time 
Capsule and set up Time 
Machine, I was never asked 

which network to use – the system 
just set up a new network, ‘Oystein 
Wi-Fi Network’, which is used 
exclusively for Time Machine 
backups. The trouble is this network 
is not connected to the internet, or 
any of my other 5 PCs or Macs. This 
task is taken care of by ‘OP-net’, a 
home and WAN network. 

As it is today, I have to change to 
Oystein Wi-Fi Network when I want 
backups. However, most of the time 
I naturally want to stay on the 
OP-net network, which I use for 
everything else. 

I thought it would be easy or at least 
possible to set up the Time Machine to 
use the network of my choice, but I’ve 
not been able to figure out how or if 
this can be done.  
Øystein Pettersen

  It can be done, and it’s quite 
straightforward. Connect to the 
Oystein Wi-Fi and open AirPort 

Utility. You’ll see your Time Capsule there; 
click on it and click Edit on the pop-up. 
On the Network tab, make sure that ‘Router 
Mode’ is set to ‘Off (Bridge Mode)’. 

Now, on the Wireless tab, your Time 
Capsule is currently set to ‘Create a wireless 
network’, but the setting you actually want is 
‘Extend a wireless network’. When you switch 

it to this, you’ll see a 
drop-down list where 
you can select your 

main network – the one that is able to reach 
to the internet.

This will put the Time Capsule on the same 
Wi-Fi connection as everything else, but it 
still means that your backups might end up 
travelling through Wi-Fi twice – once from 
your Mac to the router and then again from 
the router to the Time Capsule. That’s a waste 
of bandwidth, so if space and electrical 
sockets permit, it’s a better idea to put the 
Time Capsule next to the router, connect 
them with an Ethernet cable, and set the 
Time Capsule’s network mode to ‘Off’. 

Unless you actually need to extend the 
range of the Wi-Fi network in your house, 
it is better not to have two access points 
broadcasting Wi-Fi signals. 

My Time 
Capsule  
uses its own 
network

Is this bargain too 
good to be true?

   My high street computer 
shop has a Late 2012 
MacBook Pro in the window 

with a Core i5 CPU and 16GB RAM 
for £399. This looks like a good deal 
to me, based on scanning eBay for 
similar systems, but I need to know 
one thing. Will I be able to connect 
this laptop to an external monitor? 
I’m planning to buy it as a sort of 
emergency backup, in case my 
current Mac mini dies suddenly, but 
I’d need to be able to plug it into my 
BenQ monitor for this to work. Do 
you have any thoughts on this? 
Mike Alford

  The first thing that jumps out is 
that this probably isn’t a Late 2012 
Retina MacBook Pro. On that 

(13-inch) model, the RAM is soldered onto 
the motherboard so it isn’t upgradable, and 
it was available only with 8GB. The Late 
2013 model was the first 13-inch Retina 
MacBook Pro available with 16GB.

You can confirm the Mac’s model and 
date in the shop by clicking the Apple icon 
in the menu bar and selecting About this 
Mac, but I think it’s more likely it is a Mid 
2012 non-Retina model. £400 is still a 
decent price for this, and the graphics card 
in it can drive an external display at up to 
2560x1600 pixels. You will need a Mini 
DisplayPort to DVI or HDMI adaptor to 
connect it to your BenQ monitor, but these 
are less than £10 on Amazon (or £25 if you 
want the official Apple adaptor). 

A second-hand MacBook 
Pro is a decent alternative 
to a new Mac mini.
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   This is not an SOS but 
possibly a hidden 
feature observation I’ve 

made. Please correct me if I’m 
wrong because a brief search 
on the web suggests I’m the 
only one to have noticed this. 
After putting my iMac into 
sleep mode and I return to my 
home office after a long period, 
I’m convinced that my iMac’s 
camera detects my movement 
and wakes it up, anticipating 

that I’m about to log in. It 
doesn’t turn on the screen but 
gets the login screen ready for 
when I hit a key or click the 
mouse. I’m only suspecting this 
because I have external drives 
that start spinning when I enter 
the room. I’m not quite sure if 
my iMac 
hard drive 
starts too 
due to the 
noise from 

them but I think it must do. I’ve 
always thought ‘how clever’ 
though sometimes I do think 
it’s a bit ‘Big Brother’ spooky! 
Moelwyn Hopkins

  This does happen, but it 
isn’t using the camera. The 
camera is connected to 

the green LED through a hardware 
interlock, so it can’t be active 
without also turning on the LED. 
Instead, OS X uses the ambient light 
sensor to detect movement in front 
of the screen. This should only stop 
the Mac from going to sleep; it won’t 
make it  ‘get ready’ if it’s already 
asleep. But external drives might be 
triggered to wake up that way. 

Is my laptop secretly watching me?

Finally - an end to  
panic attacks

The iSight camera can’t be turned on 
secretly because the green LED will always 
light up to warn you that it’s active.

Care and 
feeding of 
batteries

   I hear a lot of conflicting 
advice about laptop batteries. 
Some say I should keep it 

topped up at 100% and then let it 
drain all the way down once a month. 
Others say that charging it once a day 
is better. Who is right? I use my 
MacBook Pro as my main computer 
and it is normally plugged into the 
mains on my desk. But I want to have 
the option of running from battery 
occasionally, such as on holiday. 
George Peake

  Lithium-ion batteries don’t like 
extremes. They don’t like getting 
very cold or very hot, or spending 

too much time in a completely flat or 
completely charged state. Indeed, Apple’s 
advice at apple.com/batteries used to say 
of its lithium-ion polymer batteries: “If you 
don’t use your device often, be sure to 
complete a charge cycle at least once a 
month”. That exact text no longer features 
on the site, but Apple still recommends 
charging your MacBook to 50% if it’s going 
to be stored long-term.

It’s worth reading 
Apple’s online advice 

about charging and 
storing the batteries 

used in its devices.

   I was having up to six kernel 
panics per day, and a day without 
one was a rarity. I was becoming 

very angry with Apple because OS X is 
supposed to allow a product to crash 
without bringing down the whole system, 
but kernel panics do just that – white 
screen, and goodbye! I had always taken 
a screen snapshot of the diagnostics and 
sent them to Apple, just in case, but the 
mass of hexadecimal 
strings and register 
names was meaningless 
to me. Finally, after 
enduring three months of 
this aggravation, I looked 
through the reams of 
diagnostic records to see 
if there was something an 
amateur such as myself 
could understand, and I 
found this: “BSD process 
name corresponding to 
current thread:  <name>”.

I soon discovered that 
‘<name>’ was always the 
same and that it belongs 
to a product that I had 
paid for: a virus-checking 
and general ‘security’ system to keep my 
Mac in top condition! I used AppZapper 
to remove the entire product from my 
system. That was in April, this year, and 
I have not had a kernel panic since. Worse 
than a virus possibly?
Sid Green

  Definitely. Especially when you 
consider that there still aren’t any 
actual viruses for OS X out ‘in the wild’. 

Certainly you will occasionally read about a 
theoretical vulnerability or a proof-of-concept 
virus created by researchers. But an actual virus 
that you or I are ever likely to catch? There are 
none. I have several Macs and do quite a lot of 
medium-risk things with them as part of my 
work. Things like installing third-party utilities 

from places other than the 
Mac App Store, for example. 
But I don’t buy drugs or 
weapons on the dark web 
and I don’t download pirate 
movies on BitTorrent.   
 I’ve never installed a virus 
scanner on any of my Macs 
and I’ve never had a virus, 
trojan or worm. Neither has 

almost anyone else, 
of course, but 
many will 
nevertheless 

install anti-virus software 
on their Macs just to be on 
the safe side. Except that 
you’re not playing it safe 
if the anti-virus software 

itself is a leading cause of system instability.  
 At best it will protect you from a non-existent 
threat. At worst, it causes kernel panics. It’s a very 
unpopular opinion and I catch a lot of heat for it, 
but I believe that anti-virus software does more 
harm than good even on Windows PCs. On the 
Mac, using it basically amounts to superstition. 

The first virus ever seen in the wild 
infected the Apple II. But it can’t affect 
modern Macs running OS X.
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Last month I included a tip for 
looking up the definition of the word 

under your mouse pointer by pressing 
ç+≈+d. There are some caveats for 
this: it only works in certain apps 
(specifically those written using the 
Cocoa framework, which includes most 
of the standard OS X apps and some 
third-party ones) and the shortcut must 
be enabled in Keyboard preferences 
under Shortcut > Services. That’s 
enough to make it work on my 
MacBook Air, but not on my Mac mini.

Both Macs are running Yosemite, 
and I tried all the obvious things, like 

deleting com.apple.symbolichotkeys.
plist but that didn’t make any 
difference. So I poked through the 
property list file using PlistEdit Pro 
(fatcatsoftware.com). After I had 
disentangled all the binary values 
stored there, I discovered something 
very odd. While the shortcut was listed 
as ç+≈+D in Keyboard preferences, 
the plist values were set to E, not D. 
Even weirder, ç+≈+E didn’t work 
either. After a bit more poking, I found 
some more shortcuts that don’t work 
either, like ß+ç+p to turn on Private 
Browsing in Safari. 

Using PlistEdit Pro, I was able to 
hack the dictionary shortcut back to 
ç+≈+D and after a quick reboot it 
worked again. But how was it disabled 
in the first place? I don’t know yet, but 
my curiosity is definitely piqued…

Luis Villazon has just checked, and ‘gullible’ 
definitely is still in the dictionary.

Tech
Talk
by Luis Villazon

   Is there a quicker way to 
shut down my Mac? When 
I select Shut Down from the 

Apple menu it takes almost a minute, 
and frequently fails altogether 
because iTunes decides to restart 
itself. I’ve read that the Terminal 
command shutdown -h now will 
shut down instantly. But is that safe? 
Alex M

  Not really. Shutting down from 
Terminal requires all apps to 
immediately save their cached 

data and they only have a second or two to 
do this before the rug is pulled from under 
their feet anyway. If you have unsaved 
documents open, you might not even see 
the prompt to save. Shutting down from 
the menu is slower, precisely because it 
waits to make sure that each app has had 
time to make an orderly shutdown. Also, 
the Terminal command can actually be less 
convenient, because it must be run as root. 
Which means you’d need to prefix it with 

sudo and enter your password. If you don’t 
care about open apps and files, it’s quicker 
to use the shortcut ≈+å+ç+≠. 
Alternatively, you could use the shortcut for 
the ordinary shutdown dialog, which is 
≈+≠. Ultimately though, if your Mac 
takes too long to shut down, why not just 
sleep it? Modern Macs use next to no 
electricity in sleep mode and restart almost 
instantly. Hold å+ç and press the power 
button. Press any key to resume from sleep. 

Shut down more quickly

Changing track  
numbering in iTunes

If you find keyboard shortcuts difficult to remember, you can 
use Energy Saver’s options to ensure your Mac goes to sleep. After I had 

disentangled all the 
binary values stored 
there, I discovered 

something very odd

   After starting the 
Apple Music 
trial, a lot of 

my iTunes library has 
been messed up. 
I have managed to 
get most of the 
album art back 
but I have a lot of 
compilation albums 
that I have renumbered 
to change the track order. 
I can change this back by 
manually editing each track number 
but it will take a long time to do. 
Is there a way to automate this, so 
I can just select an arbitrary number 
of tracks on the album and have them 
numbered from one to whatever? 
Keith Darrow

  If you want to create a new track 
order from an existing album, 
I think a playlist is a better 

solution, since it doesn’t interfere with the 

existing metadata of your 
tracks and therefore 

doesn’t risk getting 
overwritten the next 
time iTunes decides 
the version in the 
cloud is canonical. 

However, if you 
insist on arranging 

tracks by modifying 
metadata, you can use 

AppleScript to achieve this. 
In Automator, create a Service and 

add the Run AppleScript action to it and 
enter a script like this example:

tell application "iTunes"
 set mytracks to selection
 set n to 1
 repeat with thistrack in mytracks
     set track number of thistrack
       to n
     set n to n + 1
 end repeat
end tell 
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   I have a Mac Pro connected to a 
drive enclosure containing two 
3TB disks. The disks were 

originally set to a RAID 1 configuration 
using Disk Utility, so that each one backs 
up the other automatically. I am now fast 
approaching the point where my storage 
needs exceed the 3TB. The enclosure has 
room for another two disks and I’m 
thinking about moving up to a RAID 5 
configuration. But Disk Utility doesn’t 
seem to support this. Is there a third-
party utility that will do this for me?
Gareth Woodward

  Yes. SoftRAID (£126, softraid.com) will 
do this but I’m not sure it’s really what 
you want. RAID 5 distributes your data 

evenly across all the disks in the array, with 
some extra parity data included so that 
the array can continue to function if any 
single drive fails. If you added another 
two 3TB drives, the parity information 
would take up the equivalent of one 
disk’s worth, leaving you with 9TB of 
storage – which seems like a good deal, 
but RAID 5 isn’t a backup. No flavour of 
RAID protects your data. What they do is 
protect access to your data. If a drive fails, 
you can still get at all your data with no 

interruption. But until you have replaced that 
drive and waited the day or two for the parity 
information to be rebuilt, your drives are 
effectively in a RAID 0 array. Suffer a second 
drive failure in this period and you’d lose all 
your data, because every file is distributed 
across the three remaining disks. With one of 
those missing, you have just two-thirds of 
every file. Which is the same as no file at all.

A safer option is to set up two of the disks as 
a single 6TB volume (a ‘concatenated disk set’ in 
Disk Utility) to store files. Set up the remaining 
disks in the same way, and use a utility such as 
Carbon Copy Cloner (£27.50, bombich.com) to 
periodically back up the first volume to the 
second one. This gives you an actual backup 
that will protect your 6TB of data against the 
loss of up to two disks in the same set, though 
still not against one disk in each array.

Disk Utility can combine 
multiple disks together so 
they look like a single volume.

   I have a MacBook Pro, which has 
served me well for several years. 
It originally ran Lion and has been 

updated to Mountain Lion, but I have 
resisted going further in case I overstretch 
the MacBook’s capabilities.

One thing I have noticed though is that 
the built-in keyboard and trackpad often 
don’t work when I start up in the morning 
or resume from sleep. 

I have searched online and done all the 
recommended actions, including resetting 
the PRAM and SMC, and restoring Lion. 
Would upgrading the system to Mavericks 
or Yosemite help?  
Olivier Parmentier

  This sounds more like a hardware than 
a software problem to me. The 2008 
MacBook Pro, for example, has a ribbon 

cable for the keyboard and trackpad that runs 
underneath the battery. This can come slightly 
loose over time and cause an intermittent 
connection. Initially this can look like a software 
error because slight thermal expansion can cause 
the connection to only break when the Mac is 
warm – or, alternatively, only when it has been 
shut down for a while and is cold.

Try removing the battery and gently prodding 
the ribbon cable with your finger. If the keyboard 
starts (or stops) working as you do this, then you’re 
on to something. I have found that sometimes 
just taping a small square of tissue paper, to apply 

a little extra pressure on the cable while the 
battery is installed, can be enough to buy you 
a bit more life from your MacBook. 

Pushing past 3TB  
of disk space

My keyboard is not a morning person

Mysterious  
ghost typing

   Whenever I type the word 
‘test’, it gets instantly and 
automatically replaced with 

‘echo "test"’. I think this was 
something I did myself a while ago 
(I’ve been learning to program in 
Python) but I can’t remember what it 
was and I can’t find how to remove it. 
Dan Strickland

  It sounds like you have added an 
autocorrect substitution. You can 
delete this in the Text tab of the 

Keyboard preferences pane. You can also 
see the same autocorrect entries via 
Terminal using defaults read -g 
NSUserDictionaryReplacement 
Items. (Before Mavericks, the preference 
file was NSUserReplacementItems.) So it’s 
possible your programming experiments 
added a new entry using the ‘defaults write’ 
command. Text substitutions only take 
effect in places where ordinary text is 

expected though, 
like in Notes or 
TextEdit. They won’t 
work their magic in 
Safari’s address field, 
for example. 

If your keyboard isn’t a 
morning person, the cable 
that connects it to the 
motherboard may be loose.
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   I have a Late 2012 Mac mini 
running Yosemite 10.10.4. My 
digital camera takes 4GB 

micro-SD cards and I import my 
pictures into the Photos app using an 
adaptor card to convert from micro-
SD to the normal size. I would like to 
share some pictures by copying them 
back onto the card, but whenever I 
try this using Export in the Photos 
app, it warns ‘Export Complete with 
Errors’ and ‘Could not write file to 
destination (1,016)’.  I’ve been advised 
to reset the PRAM but this doesn’t 
seem to have helped.
Judith Harvey

  That error is because the SD card 
is read-only and I think this is 
much more likely to be a 

hardware problem. Does your SD card 
adaptor have a little slide on one edge 
(usually labelled ‘lock’)? If so, and even if it is 
currently not in the lock position, this may 
be the cause. SD adaptors are very flimsy 
things – little more than some thin gold-

plated contacts sandwiched in a plastic 
envelope. The write-protect lock doesn’t 
change the electrical connections on the 
card itself in any way. It’s just a little bit of 
plastic that slides back and forth. The card 
reader in your Mac detects this with a 
spring-loaded contact that fits into the tiny 
slot. Sometimes this gets stuck and the Mac 
thinks the card is locked. Blowing a can of 
compressed air into the slot might free it, 
otherwise you’ll need to open up the mini 
and gently prise the contact free. 

   I’ve bought a second-hand 
iMac through a friend of a 
friend. Naturally, the Mac 

came completely reset (it is running 
Mavericks) but the only user account 
on there seems to be an ordinary 
account, not one with administrator 
access. How can I add an admin 
account without having admin 
privileges? Will I have to reinstall 
everything from scratch? I don’t have 
the OS X discs!
Jeremy Linton

  There aren’t any OS X discs 
anymore. If you need to reinstall, 
you’ll do it using the recovery 

partition and the App Store. But you don’t 
need either to fix this. Restart your iMac 
with ç+s held down. This puts the Mac 
into ‘single-user mode’ which gives you full 
access to the filing system. Now mount the 
drive by typing /sbin/mount -uw /  

at the command prompt. Next you need to 
trick OS X into showing you the Setup 
Assistant again, which you do by making it 
think that the OS hasn’t completed its 
original install. The command sudo rm  
/var/db/.AppleSetupDone deletes 
the file that OS X uses as a marker for this. 
When you restart your Mac, you’ll arrive at 
the welcome screen that you normally only 
see on a new Mac or a fresh install. This 
enables you to create a new admin user 
account (you must make sure it is a new 
user account name, not one that already 
exists). You can use this admin account to 
change or create any others as you wish. 

OS X 10.11 El Capitan will soon be upon us, 
but there is still some juice to be squeezed 
out of Yosemite.

If you dislike translucent menus in 
Yosemite, they can be disabled by 

clicking ‘Reduce transparency’ in the 
Accessibility preferences pane. Even 
though it says reduce, this option 
actually turns it off altogether – 
and in windows, too. 

iTunes 12 mostly got 
rid of the old sidebar 

but you can still access a 
limited version of it by 
selecting the Playlists view at 
the top of the window. This is 
available whether you are browsing music, 
movies, TV shows, podcasts or audiobooks.

Safari hides the full address of a web 
page, showing only the domain by 

default. If you want to be able to see it, you 
can just click the address field. To make it 
visible all the time, tick ‘Show full website 
address’ in Safari > Preferences > Advanced. 

Restrict the kinds of information that 
Spotlight finds by going to System 

Preferences > Spotlight > Search Results. 
Just untick any category you don’t need, 
or drag more important ones up the list. 

 Dashboard is much more convenient 
if you configure it to display on top 

of your Desktop, rather than as a separate 
space. Go to System Preferences > Mission 
Control and set the Dashboard pop-up 
menu to ‘As Overlay’.

Get the solid grey Dock background back by 
turning off OS X’s transparency effects.

improve Yosemite

If you end up without an admin 
account, the Setup Assistant can 
be re-run to make a new one.

There’s no administrator 
account on my Mac!

Is my SD card broken?

SD cards use an old-fashioned physical switch 
to prevent their contents being overwritten.
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Get in  
touch

If you have a technical 
query with your iOS 

device that you need 
answering, please  

email us at    
sos@macformat.com Christian Hall fixes your iPad 

and iPhone problems

   I work in a basement where 
I can’t get my iPhone 4 
online. The PCs get online 

using cables but don’t have Wi-Fi. 
Can I use USB to hook my phone up 
to a PC and share its connection?
Jean Bardoit

  Not in iOS; your phone won’t 
accept a network connection 
over USB  – this can only be used 

to charge and sync with local devices. 

Getting around this restriction would 
involve fairly extensive re-engineering of 
the networking code and jailbreaking your 
phone, but that’s a very complicated setup 
just to get online. I think a more convenient 
approach would be to plug a small wireless 
router into a spare Ethernet socket at work. 
If you don’t have spare socket nearby, you 
could do this with a Wi-Fi card or dongle for 
your PC. But you’ll probably need you to 
sweet talk your company’s IT department 
for permission to do either. 

Nothing to worry about

Mooching office internet

Larger print in 
the magazine

   I’ve just subscribed to the 
iOS version of MacFormat. 
Is it possible to read it in 

landscape mode on my iPad? Is it 
possible to enlarge text and graphics 
using the two-finger ‘stretch'? 
Paul Miller

  Currently, neither of those is 
possible. In order to preserve the 
layout, the app must restrict 

things you can do. The software used to 
make the iPad edition doesn’t allow text 
resizing right now either. However, the 
team is experimenting 
with various design 
options to improve 
readability in the future. 
The best you manage at 
the moment is to turn 
on Zoom in Settings > 
General > Accessibility. 

Reinstalling everything

   I have collected dozens of apps – now 
well over a hundred – on my iPhone 
over the years. The problem is it takes 

longer and longer to redownload them all from 
the App Store every time I need to do a factory 
reset. I’m at the point where I basically have to 
leave my phone at home on Wi-Fi for a day to 
get them all back. Is there a way to make a local 
copy of them all to save doing this every time? 
Ade

  I don’t know why you are performing factory 
resets. This is normally only necessary to 
recover from a serious lock-up or installation 

error. Also, it sounds as if you aren’t backing up your 
iPhone to iTunes, which will keep a local copy of every 
app on your computer so you can restore from there.

It’s hard to ‘pocket decline’ a call by 
accident, but sending a text message 
can still happen pretty easily.

   My father has an iPhone 4 which 
used to be mine and I gave to him 
after I upgraded to the iPhone 6. 

Yesterday I got a text from him saying 
“Can’t talk now – On my way.” This was 
out of the blue and he 
wasn’t on his way to 
anything. He is already 
very nervous of online 
security and has decided 
that someone else has 
access to his phone 
account and may be able 
to send texts using his 
credit so he is refusing to 
top it up. Is that possible? 
How can I reassure him? 
Jayne Bisley

  Were you by any 
chance trying to call 
him at the time? 

This message is one of the 

predefined responses that iOS supplies when 
you decline an incoming call with a text. If his 
phone was locked at the time, it would have 
been even easier to do by accident, because 
there is no big green Accept button – just the 

‘slide to answer’ and the Message 
button above it. Particularly for 
someone unused to touchscreens, 
or smartphones in general, I can 
imagine it might be easy for them 
to accidentally send a text message 
instead of answering the call. As for 
reassuring him, it’s probably just a 
question of showing him how this 
feature works. No one else can use 
his phone to make calls or send texts 
remotely, but even if they could, 
they wouldn’t use it to send a 
pointless template message to you.
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How do i get mine?

Download back issues onto your iOS  
device – get our award-winning app at 

bit.ly/macformatipad.

To order back issues of the print 
magazine, go to http://goo.gl/B7aFdk  

or phone +44 (0)844 848 2852 
and we’ll post them out to you.

To become a subscriber so you never miss 
another issue in the future, go to page 24.

Looking for a back issue? Look no 
further. Search for ‘MacFormat’ on 

the App Store to get our award-
winning app for iPad, iPhone and 
iPod touch! There are lots of issues 

of MacFormat inside it, ready to 
be downloaded immediately. 

And remember, from issue 250, 
MacFormat became a fully 

interactive iPad app! 
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As Cupertino joins the world of mobile 
payments, we show you how to use 
Apple’s secure payment system – and 
why it’s safer and simpler than its rivals

et’s face it, ‘revolution’ is 
something of an overused 
word in the world of 
technology. Yet Apple 
may be the only tech firm 

that can legitimately claim to repeatedly 
justify its use when talking about its own 
products. Leaf through computing’s recent 
history and you see the telltale signs of the 
Apple revolution everywhere you look – 
iPhones, iMacs and iPads have changed 
the way we interact with tech forever.

It should come as no surprise, then, that 
Apple is at it again, this time in the form of 
Apple Pay, the contactless payment system 
that wants to keep wallets in pockets and 
credit cards firmly out of sight.

The beauty of Apple Pay is that it is 
classically ‘Apple’. Simple and elegant, 
it combines the tech you’ve already got 
(an iPhone with Touch ID) with a one-step 
payment process, all wrapped up in 
watertight security safer than traditional 
chip and PIN. All you need to do is place 
your iPhone near any NFC card terminal 
and rest your finger on its Touch ID sensor. 
The foundations are laid – in a few years 
we could be looking back at the dawning 
of yet another Apple revolution.

Apple Pay
Get started with

L

Words: Alex Blake Photography: Future Photo Studio (Joseph Branston)
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Apple Pay works with any terminal that 
accepts contactless payments, so you can keep 

your card in your wallet and pay on the go.
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Apple Pay in the UK
Sadly for UK consumers, many developments in mobile 
payments have debuted in the USA and are not yet 
available here. One notable example is PayAnywhere, which 
plugs into an iOS device and functions as a mobile NFC 
terminal. This lets any retailer accept Apple Pay transactions, 
regardless of whether they actually have an NFC terminal.

Likewise the biggest potential competitor to Apple Pay – 
Google – has yet to launch its own mobile payment system 
in the UK. Google’s first foray into the world of mobile 
payments was Google Wallet, rolled out in the USA in 
September 2011. However, the system has been plagued 
by security issues and lacks the simplicity of Apple Pay.

That puts Apple in a good position. The opinion of Pinar 
Ozcan, Assistant Professor of Strategic Management at 
Warwick Business School, is typical of many industry 
analysts. “So far, Apple Pay is ahead in terms of roll out, 
partners and safety”, she insists, although she does warn 
that Apple must maintain its momentum.

That healthy start may come under threat, though, when 
Samsung Pay hits UK shores (its release date here was not 
confirmed at the time of going to press). Samsung’s own 
offering, while similar to Apple Pay, has the advantage of 
working with any credit card reader, not just those enabled 
with NFC. That’s because it works through Magnetic Secure 
Transmission (the magnetic strip reader on terminals) as 
well as NFC, so users just need to tap their Samsung phone 
on the side of the card reader for it to work. The number of 
places you can use Samsung Pay is therefore at present far 
larger than the number accepting Apple Pay.

But while rivals like Android Pay and CurrentC have yet to 
make the leap across the pond to the UK, one noteworthy 
rival on these shores is Zapp. This payment app integrates 
with five major banks in the UK (First Direct, Metro Bank, 
HSBC, Nationwide and Santander); when a user pays with 
Zapp, their banking app is opened on their phone. A secure 
token is created during each payment and the user taps a 
button in their bank’s app to pay. The secure token makes 
the transaction very secure (just like Apple Pay), and the 
retailer never sees the user’s payment card details. Yet the 
Zapp way of paying is not as quick and convenient as 
Apple Pay, which manages to be both speedy and secure.

So while Apple Pay seems to be ahead, victory is by no 
means assured. A major stumbling block is the way Apple 
Pay is tied to hardware – you need an iPhone 6 or 6s to 
use it. In the opinion of Adam Davis, a consultant at 
financial industry analysts Capco, that could be a problem.

“At the moment the iPhone leads the mobile market 
with over 40% share”, he says. “And while that is an 

“So far, Apple Pay is 
ahead [of its rivals] in 
terms of roll out, 
partners and safety.”

From start to finish, the Apple Pay 
process is safe and secure. 
Protected by a one-time token 
system, it ensures that even if 
hackers find your unique 
payment code, they still can’t 
use it to steal your money.

Ask the experts: 
What could Apple 
Pay do better?

Marianne Berry
Managing Director of 
Payment Insights at  
the Auriemma 
Consulting Group

“ There are always 
features that can be 
improved, and we 
await the release of 
Apple Pay 2.0 this 
autumn with great 
interest. In general, 
though, Apple is 
doing a great job. 
Satisfaction with Apple 
Pay is high for both 
in-store and in-app 
use, and users are 
highly likely to 
recommend it – 62% 
of users have already 
recommended Apple 
Pay to someone.”

➔
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advantage, it means that a huge number of potential 
customers aren’t using Apple devices – and so can’t use 
Apple Pay… accessibility is still the key barrier and one 
that Apple will have a challenge to overcome.”

Also, whereas Apple’s previous successes depended 
in large part on how willing consumers were to buy its 
products, it now has to also rely on how willing retailers 
are to accept Apple Pay – “an extra barrier to success”, 
according to Davis.

Still, there are many reasons 
to be positive about Apple Pay
One aspect that has received scant attention is the effect 
Apple Pay could have on in-app purchases. According to 
Marianne Berry, Managing Director of Payment Insights 
at Auriemma Consulting Group, “the impact of Apple Pay 
on mobile commerce is more significant than in-store 
if for no other reason than the size of the denominators. 
Apple Pay accounts for only a tiny fraction of the overall 
volume of payments at the point of sale, but for many 
mobile apps it’s a substantial share”.

Using Apple Pay to make in-app purchases is so useful 
because it bypasses the need to create an account or 
enter card details with retailers you may not entirely trust. 
Instead, payment is quick and secure, just as it would be 
with in-store Apple Pay transactions.

The impact of Apple Pay can be observed in the 
behaviour of many consumers. As Berry puts it, “Apple 
Pay users told us that they go to the App Store and enter 

‘Apple Pay’ in order to find and download apps that 
accept it. Not having to enter a credit card number, 
expiration date, and CVV code makes it much easier to do 
a transaction on a new app.”

Until September, Apple Pay transactions were limited 
to £20, although that has now risen to £30. However, this 
wasn’t a limit imposed by Apple but by NFC terminals 
themselves; Apple Pay can accept any payment amount, 
as long as the card terminal in question can too.

The security features at the core of Apple Pay  are 
thought to have convinced some retailers that a payment 
limit is unnecessary by proving that the payer is present 
and making the payment. Boots, for example, is thought 
to be planning to remove the limit in November this year, 
while Pret A Manger allows limitless payments already.

However, don’t get too excited – retailers can only 
remove payment limits if they upgrade their NFC 
terminals, so being able to spend more than £30 in one 
go with Apple Pay depends on how fast retailers are 
willing to update their hardware.

Security
All our experts agreed that security is one of Apple Pay’s 
strong points. Davis points out that “the technical 
architecture has been designed to limit fraud at the point 
of sale… In fact, this is the first time that this many large 
banking players have signed up to an external payments 
platform at this rate, which is a win for the end user.” 

Ozcan agrees, arguing that “Apple has a reputation for 

Ask the experts: 
What could Apple 
Pay do better?

Pinar Ozcan
Assistant Professor of 
Strategic  Management 
at Warwick Business 
School

“ With CurrentC and 
Android Pay still absent 
everywhere but the US, 
Apple has a free playing 
field. But this will soon 
change and Apple 
needs to spread their 
service as widely as 
possible before the 
competition arrives.”

Using Apple Pay As with all Apple products, Apple Pay is designed to 
be both simple and secure, and it is compatible with 
any NFC-enabled terminal. Here’s how it works…

Open Wallet (formerly 
Passbook), tap Add 
Credit or Debit Card 

and enter your card details. 
Tap Next, after which your card 
will be verified by your bank – 
once that’s done, tap Next. 
You can now use Apple Pay.

You can also register through 
your bank’s own app. The 
process is largely similar to 
Passbook’s – see your bank’s 
website for more details.

Hold your iPhone near 
the contactless card 
reader and an image 

of your card will appear on the 
screen. Then, just rest your 
finger on the Touch ID sensor 
(but don’t press the Home 
button), wait for a second for it 
to confirm your fingerprint, and 
voila! It’s as easy as that.
To use a different card, tap the 
one on screen and choose 
another. (In iOS 9, prep a card 
at the Lock screen by double-
clicking the Home button.)

1 2
Wallet setup Using Apple Pay

➔
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building very secure systems” and pointing out that the 
success of iTunes was built upon this at a time when 
digital music marketplaces were still rare.

For Berry, the situation is a little more nuanced, and 
she notes that “security is both a driver and a barrier to 
usage. It is the second most frequently cited benefit of 
Apple Pay for users, who consider the tokenisation 
process to be more secure than standard payment 
cards, and the second most frequently mentioned barrier 
to trial among non-users, many of whom feel it’s an 
untested technology”. Convincing non-users that Apple 
Pay is as safe as has been claimed is a key test for Apple, 
but it is certainly encouraging that so many actual users 
of the system are so confident of its security credentials.

They have reason to be confident. Card numbers are 
never stored on a user’s device, nor are they stored on 
Apple’s servers or backed up to iCloud. Rather, each 
device is given a unique Device Account Number, which 
is encrypted and stored in the iPhone’s Secure Element.

Each transaction is similarly protected by being 
assigned a ‘dynamic security code’, which is different with 
every payment. Retailers only see this dynamic code, not 
your credit card number. It also means that any hacker 
who gets this ID can’t do anything with it, as it can only 
be used the first time it is generated and doesn’t identify 
you in future transactions.

It’s not only the actual security measures Apple puts in 
place that help its reputation, but also the actions of its 
rivals. In October 2014, CurrentC had to admit that 

hackers made off with the email addresses of some of its 
users, while Google’s harvesting of user data for its own 
business use is well known. “When it comes to Apple Pay, 
the fact that Apple does not share user data while 
Google does is an important point of concern for many 
potential users”, says Ozcan.

Yet despite the apparent market-leading security 
features enacted in Apple Pay, media outlets have not 
been shy in reporting ‘Apple Pay fraud’ stories typeset in 
gigantic bold italics. Apple’s payment system directs 
applicants to call their bank and go through a number of 
security steps if their identity cannot be verified. This is 
susceptible to fraud from clever scammers who may be 
able to guess the correct security answers.

However, as you may have guessed, this is a weakness 
of the banks’ security, not of Apple Pay, and there have 
yet to be any breaches of Apple Pay itself or leaks of user 
data. The measures put in place by Apple are the best in 
the business because not only are they encrypted and 
require a biometric input (from Touch ID), but the unique 
transaction codes are useless if obtained by fraudsters as 
they are single-use only.

Apple Pay was by no means the first mobile payment 
system, but Apple has created a fast and trustyworthy 
one that many consider to be the industry leader. As is so 
often the case, Apple stands as the current pacemaker, 
leading the way but never looking over its shoulder. The 
race isn’t over yet, but Tim Cook and company have gone 
a long way to making it secure.

Ask the experts: 
What could Apple 
Pay do better?

Adam Davis
Consultant at Capco

“ Rewarding customers. 
The issuing of loyalty 
cards through Apple Pay 
has been announced, 
but the roll out and 
adoption will be slow 
due to NFC compatibility 
issues. The quicker 
Apple can meaningfully 
reward loyalty, the 
higher the adoption and 
better the service.”

3 4
Using Apple Pay in an 
app is just as simple as 
using it elsewhere. 

Simply tap the ‘Buy with Apple 
Pay’ button, review your 
payment details, then place 
your finger on the Touch ID 
sensor to finish the transaction.

This is a much more 
streamlined process than 
entering your Apple ID details, 
and the biometric authorisation 
makes it more secure.

Open the Apple Watch 
app on your iPhone 
and tap My Watch. 

Next, tap Passbook & Apple Pay, 
then Add Credit or Debit Card, 
and then Next. Enter your card’s 
details, then tap Next.

To use Apple Pay with your 
Watch, double-click the side 
button, then hold your Watch’s 
face to the card reader until you 
hear a tone and feel a slight 
pulse, which confirms the 
transaction was completed.

In-app purchases Pay with Apple Watch
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“Find the perfect 
accessory for the perfect 

accessory – these Apple 
Watch stands let you charge 
your device in style” 
Apple Watch chargers p96

 REVIEW MANIFESTO

Given solely at the discretion 
of the Editor only to truly 
exceptional products.

Our group test winner gets 
this award; it’s the best of its 
kind at the time of writing.

Our reviews are totally independent; 
we’re not affiliated with Apple or 
anyone else, nor are we influenced by 
advertisers. You can trust us.

Prices we quote for products are 
correct at the time of writing and are 
the best we can find from a reputable 
online dealer, excluding delivery.

Our ratings explained

HHHHH Rarely given; a brilliant thing 
that’s as good as you can get in its class 
right now

HHHHH A strong recommendation to 
buy; any concerns are comfortably 
outweighed by its strengths

HHHHH A good product you should 
consider buying, but there may be 
better options for you

HHHHH Fundamentally flawed either 
in concept or execution; there are 
almost certainly better options for you

HHHHH A waste of your money and 
everyone’s time; do not buy!
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Fill your home with the sound  
of music, thanks to these affordable 
multi-room speaker systems

Multi-Room 
Speaker Systems
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MulTi-RooM spEAkER sysTEMs | At A glAnce

LG Music  
Flow H5

Philips  
Spotify SW750M

 Pure  
Jongo T4X

Samsung Wireless 
Audio M5

Sonos  
Play:1

Price (per 
speaker)

£179 £130 £150 £200 £169

Speaker Output 40W 20W 50W Unspecified Unspecified

Dimensions 
(HxWxD)

207x340x88mm 210x360x135mm 165x305x146mm 113x342x168mm 162c120x120mm

Wireless 
Connectivity

Bluetooth,  
dual-band Wi-Fi  

(802.11n)

Wi-Fi  (802.11n) Bluetooth, Wi-Fi  
(802.11g)

Bluetooth,  
dual-band Wi-Fi  

(802.11n), 
tVconnect**

Wi-Fi (802.11g)

Other connectors ethernet,  
3.5mm line-in

n/A 3.5mm line-in, 
optional ethernet 
adaptor (£19.99)

ethernet ethernet

Streaming 
Services

Spotify, napster, 
tuneIn, Deezer, 

googlePlay

Spotify Premium  
(iOS/Android only)

Any* Spotify, napster, 
tuneIn, Deezer, Rdio, 

7digital

Spotify, napster, 
tuneIn, Deezer, 

googlePlay, 
Amazon Music

iOS App Yes (required) Yes (required) Yes Yes (required) Yes

Mac/PC App Pc-only no no app - but can 
stream to Mac/Pc via 

Bluetooth/Wi-Fi 

Yes Yes

Multi-room speaker systems 
have been around for years now, 

but until relatively recently they were 
complex, expensive systems aimed at 
people who could happily afford to 
kit out an entire mansion.

But, like most technologies, multi-
room speaker systems have fallen in 
price in recent years, to the point where 
they’re not much more expensive than 
conventional speakers any more. One 
factor that has helped to drive multi-
room speakers into the mainstream is 
our increasing use of mobile devices, 
such as smartphones and tablets. 
Mobile devices mean mobile music, so 
it makes sense to have a multi-room 
speaker system that can follow you 
from room to room at home.

the first generation of wireless 
speakers used Bluetooth for streaming 
music, but Bluetooth has a fairly limited 

range and isn’t very good at 
penetrating through walls or other 
obstacles. Because of this, multi-room 
speaker systems tend to use Wi-Fi to 
connect to your home network 
instead. A Wi-Fi network provides 
better range, and better sound quality 
too, as it has greater bandwidth than 
Bluetooth. However, the set-up process 
can prove to be a little more 
complicated, and each of the multi-
room speaker systems that we 
review here handles this differently.

Most of them start with an iOS app 
that you can run on your iPhone, iPod 
touch or iPad (or Android equivalent). 
these apps will help you to connect 
your speakers to your home network, 
but once that’s done each speaker 
system goes off in a different direction.

Some of the speakers here rely 
entirely on the manufacturer’s own 
iOS app for playing music, which 
can make it difficult – or sometimes 
impossible – to play music from other 
apps or other devices, such as itunes 
running on a Mac. Few of them will 
work with the new Apple Music 
streaming service either.

So as well as getting a multi-room 
speaker system that sounds good, it’s 
also important to think about the 
different devices and services that 
you may want to use when listening 
to your music. Cliff Joseph

The set-up process 
can be complicated, 
and each of these 
systems handles 
this differently

*Requires both Bluetooth and Wi-Fi  **For Samsung tVs
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When testing these speakers, we initially started 
off with one speaker at a time, using each 
manufacturer’s iOS app running on an iPhone 
to connect a single speaker to our office Wi-Fi 
network. We then used the manufacturer’s iOS 
app to play a variety of songs that were stored 
locally on the iPhone. Where possible, we also 
streamed a number of songs from a Spotify 
playlist. The audio quality for the Spotify test 
will, of course, depend on a number of different 
factors – not just the quality of the speaker itself 
– but the main purpose of this test was simply 
to see how well the speaker’s own app 

supported these third-party streaming services.
The next step was to add a second speaker in 

a separate room, again using the manufacturer’s 
own iOS app to link the two speakers so that 
they played the same music in both rooms. As 
well as assessing the sound quality we also 
wanted to make sure that each pair of speakers 
was playing together in sync, and that there was 
no significant lag as we moved from room to 
room. Finally, if possible, we also attempted to 
play music from our iTunes library running on 
an iMac, as well as attempting to stream the 
Apple Music service from within iTunes.

these multi-room speakers all 
use Wi-Fi to connect to your 
home network, but there are 

other features to think about too. 
the lg Music Flow H5 and 

Samsung M5 are the most expensive 
speakers here, but they’re packed 
with useful features, including dual-
band Wi-Fi for maximum range and 
reliability, and ethernet for homes 
where Wi-Fi doesn’t work so well. 
the Sonos Play:1 has ethernet too, 
which may come in handy, as its 
single-band Wi-Fi may struggle.

Pure’s Jongo t4X just has basic 
Wi-Fi and Bluetooth, but it can use 
both wireless technologies in 
tandem in order to stream music 
from a really wide range of devices 

and apps, and it’s currently the only 
multi-room speaker system that will 
work with the Apple Music service.

In contrast, the Philips Spotify 
speaker only works with Wi-Fi 
connections and will only let you 
play music from the Spotify app 
on iOS devices. It can’t play itunes 
music from a Mac and, to add insult 
to injury, you’ll need a paid-for 
Spotify Premium account too.

the Philips Spotify speaker is 
the cheapest on test at just 
£129.99, but its sound quality 

isn’t at all bad. Higher frequencies 
are clear and detailed, and the bass 
is adequate for a speaker of this size. 
Step up to £150 and you can get the 
Pure Jongo t4X. this chunky speaker 
provides powerful 50W output 
with firm bass, although higher 
frequencies can be a bit shrill.

the lg H5 struggles a bit with 
volume as well. It’s fine for listening 
to some music over dinner, but the 
lightweight plastic casing struggles 
to contain its 40W output and the 
sound starts to distort when you 
really pump up the volume.

Samsung doesn’t specify the 

output of its M5 speaker, but this 
large triangular unit pumps out 
plenty of volume. the bass can be a 
bit heavy, but Samsung’s MultiRoom 
app includes a graphic equaliser to 
fine-tune the sound.

the Sonos Play:1 stands out here. 
Its upright, cylindrical design fills the 
air all around it with a rich, full sound 
and surprisingly firm bass for such a 
compact little speaker.

Features sound Quality
connectivity is key Sounding good in every room

test one test two

Multi-room playback involves additional problems, 
such as syncing the sound from two or more speakers.

How wE TEsTED | SPeAKeR SYSteMS

1    lG Music Flow H5
£179 lg.com

2    Philips spotify  
 sW750M 
£130 philips.co.uk

test ResULts
LG Music Flow H5 HHHHH

Philips Spotify SW750M HHHHH

Pure Jongo T4X HHHHH

Samsung Wireless Audio M5 HHHHH

Sonos Play:1 HHHHH

test ResULts
LG Music Flow H5 HHHHH

Philips Spotify SW750M HHHHH

Pure Jongo T4X HHHHH

Samsung Wireless Audio M5 HHHHH

Sonos Play:1 HHHHH

1

2
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The reliance on the manufacturer’s own iOS 
app means that some of these multi-room 
speakers aren’t as flexible as we might have 
liked. There are, however, two outstanding 
exceptions here. The Pure Jongo T4X can play 
music from any source – including the Apple 
Music service – although using this ability is a 
little complicated and might confuse people 
who aren’t familiar with Bluetooth and Wi-Fi 
technology. The T4X sounds good too, but it’s 
the Sonos Play:1 that is the winner on sound 
quality, thanks to its rich, full sound and very 
satisfying bass output. It doesn’t support the 

Apple Music service yet – but that’s on the way, 
and the excellent sound quality of the Play:1 
represents really good value for a speaker 
costing less than £200.

Most of these multi-room 
speaker systems are fairly easy 
to set up – as long as you have 

a mobile phone or tablet to get you 
started. they all rely on an iOS – or 
Android – app that guides you 
through the process of connecting 
one or more speakers to your home 
network, and then syncing them 
together to simultaneously play 
your music in different rooms.

However, these apps are less 
helpful when it comes to playing 
music from different devices and 
sources. the most extreme example 
here is the Philips Spotify speaker, 
which only works with the Spotify 
app on an iOS device. It won’t play 
your existing music library from 

itunes on a Mac, or the Music app 
on iOS devices.

the lg Music Flow app is a little 
more flexible in this instance. It 
works with services such as Spotify 
and napster, and can also play 
music that you have stored on 
your iOS devices. Unfortunately 
though, there’s no Mac version of 
Music Flow, so you can’t play music 

from itunes on a Mac, or from the 
Apple Music service.

Samsung does provide a Mac 
version of its MultiRoom app, which 
can play music stored in your itunes 
library, but you still have to use the 
iOS app as the remote control to 
play your music, which seems 
unnecessarily clumsy.

Sonos also has apps for both 
Macs and iOS devices, so you can 
play music stored on any device. 
the Sonos apps don’t currently 
work with the Apple Music service, 
but Apple and Sonos have said 
they expect to get this sorted 
before the end of the year.

Only one manufacturer manages 
to break free from this reliance on its 

own apps. Pure does provide an app 
for iOS devices, but it’s also possible 
to play music from other apps and 
other devices as well. Admittedly, 
the process is a bit complicated, 
as it involves using both Bluetoooth 
and Wi-Fi combined, but once that’s 
done you can play itunes on a Mac, 
including the Apple Music service, 
and even stream services such as the 
BBc iPlayer from your web browser.

GettinG ConneCted
Multiple rooms and multiple devices

test thRee

THE winnER | SOnOS PlAY:1

test ResULts
LG Music Flow H5 HHHHH

Philips Spotify SW750M HHHHH

Pure Jongo T4X HHHHH

Samsung Wireless Audio M5 HHHHH

Sonos Play:1 HHHHH

FInAL ResULts
LG Music Flow H5 HHHHH

Philips Spotify SW750M HHHHH

Pure Jongo T4X HHHHH

Samsung Wireless Audio M5 HHHHH

Sonos Play:1 HHHHH

Only one 
manufacturer 
manages to break 
free from a reliance 
on its own apps…

3    Pure Jongo t4X
£150 pure.com

4    sonos Play:1
£169 sonos.com

5    samsung Wireless 
 audio M5 
£200 samsung.com

3

4
5
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B&W P5 Wireless

HHHHH
£330 Manufacturer Bowers & Wilkins, bowers-wilkins.co.uk

Drive units 2x 40mm Frequency range 10Hz – 20kHz  
Bluetooth codecs aptX, AAC and SBC

Hi-fi quality headphones without 
the wires could finally be here

AVM FRITZ!Box 
4020

A very affordable 
router with great 
features for home 

users, plus some set-up 
flexibility if you want it.

 Very affordable

  Good depth of features

 DNLA and NAS features

 Only one USB port

Small and lightweight 
but not lacking in 
software‑based options.

The 4020 sits more at the entry-
level end of AVM’s router line-

up, and though fairly lightweight in 
construction, it still has some good 
features for the money. It can be 
used just as a wireless router, or also 
connected to any cable, DSL or fibre-
optic modem, or a wireless dongle 
for mobile internet access. As well as 
Ethernet ports, it has a USB 2.0 port 
for connecting a dongle, or a printer 
or hard drive to share wirelessly. 

The box works only on the 2.4GHz 
band with a maximum throughput 

of 450Mbps, which will be fine for 
most users though slow for large file 
transfers. Signal strength was good, 
however, and there’s a solid feature 
set that can be managed through a 
web browser. You get WPA2 security, 
guest access, automatic channel 
selection, a media server that uses 
SMB, FTP and UPnP to make music, 
pictures and videos available over 
the network, and parental controls, 
among other things. 

Another nice feature is FRITZ!NAS, 
whereby signing up on the website 

enables you to access the contents 
of a connected hard drive even from 
outside your network, potentially 
using any internet connection.

This is a very affordable router 
with great features for home users 
and a relatively painless set-up 
procedure. It doesn’t have cutting 
edge hardware connectivity but it 
has enough for regular users, plus a 
better depth of options and tools 
accessible in its software than you 
might expect. Hollin Jones

A surprisingly flexible router if you’re 
looking to network on a budget

The P5 Wireless 
sounds and feels 
gorgeous, with 

flawless streaming and an 
excellent sound stage.

 Extremely comfortable

 Excellent wireless fidelity

  Great battery life

 Even better wired options

These wireless headphones are 
small and lightweight but 

beautifully constructed and sturdy. 
Charged using a bundled USB cable, 
they boast a 17-hour battery life and 
have a fallback mini-jack cable that 
can be attached for wired operation 
if the battery runs out, or with 
non-Bluetooth kit. This is done by 
removing one ear pad, both of 
which are magnetically held in place.

They are on-ear models and the 
pads are very comfortable even for 
extended listening sessions. On the 
edge of the right cup are three 
buttons that let you alter volume, 

skip or pause tracks, and take phone 
calls. There are two microphones 
built in to enable calling, and a dual-
purpose button for turning on and 
pairing with another device.

The headphones sound great, 
with plenty of volume, bigger and 
more focussed bass than expected 
from relatively small cups, crisp 
mid range, and powerful but 
controlled highs. Interestingly, the 
sound quality and volume didn’t 
alter when switching from wireless 
to wired operation. The headphones 
use the aptX codec for higher quality 
streaming (on the Mac) to get 

around the issue of Bluetooth 
bandwidth affecting audio quality, 
and also support the AAC streaming 
codec which is great for Apple Music 
on iOS. These are certainly among 
the finest wireless headphones 
around and they have an excellent 
sound stage. However, in this price 
range if you can live without wireless 
you can get some breathtaking 
reproduction from competing 
wired models. Hollin Jones

You can connect 
the P5 Wireless 
by cable to keep 
listening if the 
battery runs out.

HHHHH
£42 Manufacturer AVM, http://en.avm.de

Connectivity 802.11n Wi-Fi, 4x Fast Ethernet ports, 1x USB 2.0, UPnP AV server
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Arlo is Netgear’s new home 
security system with one key 

advantage over rivals – the system is 
completely wireless. Well, we mean 
the cameras themselves. The base 
station connects directly to your 
router using Ethernet.

Arlo definitely falls into the ‘not 
cheap’ category. The two-camera 
pack costs £280, while three is £360. 
Camera mounts are also available as 
accessories, while you can add extra 
cameras for around £110 each. 

The packaging design cleverly 
puts the cameras on display at the 
top, but while it looks good in store 
it is a pain to open. Precious little 
instructions are included, but a 
leaflet directs you online for a quick 
start guide. We’d recommend doing 

this before using the iPad or iPhone 
app to set things up. You can also 
set up through a website on a Mac. 
The set-up process auto detects your 
base station, but assumes you will 
have plugged in the cables already. 

The cameras have night vision (up 
to eight metres), a 130-degree field 
of vision and can be used inside or 
outside – the cameras themselves 
are weatherproof, while the wireless 
range is cited as 90 metres. We had 
no issues putting them around our 
average-sized garden. 

Clever magnetic mounts are also 
included – they are waterproof and 
not only provide the potential for 
wall-mounting, but they also mean 
you can point the camera at various 
angles. Two spare mounts mean you 

can move the cameras depending 
on whether you’re away, say, and 
you can screw a mount to a wall 
with provided mounting screws. 
The cameras can be used on flat 
surfaces without a mount. Each 
takes four CR123 batteries (included).

Video quality is excellent, and the 
cameras automatically adapt for 
exposure and colour balance. Video 
is also stored on free Netgear cloud 
storage, so you don’t even need to 
worry about that. And, if there’s low 
light, the camera switches to night 
mode. You can opt to receive push 
notifications and emails depending 
on movement in front of the camera, 
and adjust detection sensitivity.

However, it’s important to caveat 
Arlo’s general excellence with its 
price. It isn’t outrageous for what it 
gives you, but cheaper options are 
available if all you want to do is 
watch a single location and you 
don’t mind wires. Dan Grabham

Netgear Arlo
A wonderfully flexible (if pricey) camera system for indoor or outdoor use

HHHHH
£280 (two cameras), £360 (three) Manufacturer Netgear, netgear.co.uk

Features 720p HD video, weatherproof, motion activation, night vision

The Arlo cameras are 
weatherproof and 

have clever magnetic 
mounts for tilting or 

wall‑mounting them.

I live in rented 
accommodation, 
so relocatable 

cameras that don’t even 
need to be screwed to a 
wall are appealing. That 
video is uploaded to the 
cloud and I can monitor 
my home from afar 
adds enough appeal to 
justify the high price.

Team Talk

Much of Arlo’s 
expense lies in its 
wirelessness and 

weatherproofing. If those 
matter, it’s a great choice.

 Moveable, wireless cameras

  Can be used from anywhere

  Cloud storage of video

  It’s expensive
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Manfrotto describes this 
accessory for connecting your 

iPad Air (there are different models 
for the original Air and the Air 2) to 
your Nikon or Canon SLR as a 
“workflow management processor”, 
which deserves some sort of award 
for being the most astonishingly 
boring description for an exciting 
new bit of tech we’ve ever heard. 

The Digital Director is a cradle 
for your iPad, and connects to its 
Lightning port. It then connects to 
a compatible camera using a USB 
cable, and, via the accompanying 
app, gives you a live feed of the 
camera’s view and control of its 
functions. But not in some middling 
way, like most camera companion 
apps. Manfrotto has been working 
with Canon and Nikon to get direct 
access to their pro cameras’ innards, 
to effectively recreate almost the full 
controls of the cameras in the app. 
You can’t change the camera’s 

shooting mode from the 
app, but aperture, shutter 
speed, focus and much more 
can be adjusted live on the 
touchscreen, with the live view 
showing exactly what you’ll get on 
the iPad’s lovely big, detailed display. 
The app even adds some excellent 
features such as focus peaking, 
ensuring you always get the right 
part of the shot in focus. 

Shots you take can be viewed 
right away on the iPad, and you can 
rate images as you take them 
(though these won’t carry over to 
management software such as 
Lightroom, sadly), and have them 
uploaded to an FTP server.

While this is all phenomenally 
exciting for things like video work or 
macro photography (the included 
one-metre USB cable means you can 
stay well back out of the light for this 
kind of shooting), the Digital Director 
isn’t perfect. We’ve already 

mentioned its trouble tying in with 
Lightroom, but also it lacks true 
depth of field preview – when you 
change the aperture setting, the 
brightness of the image is adjusted 
to simulate the image’s exposure, 
but the aperture isn’t actually closed 
down, so you can’t see how depth 
of field changes.

Is it worth £400? If what you’ve 
read has you excited at the 
possibilities, you may have already 
made up your mind, and we think 
you’ll enjoy using it. But it’s a lot of 
money, is limited to certain cameras, 
and isn’t quite a home run yet. 
Ali Jennings & Matt Bolton

Manfrotto 
Digital Director
Turn your iPad into the ultimate 
digital SLR camera accessory

HHHHH
£400 Manufacturer Manfrotto, manfrotto.com

Weight 0.29kg Battery life 15 hours   
Mount type 3/8-inch universal mount

Digital Director enables 
your iPad to talk directly 
to and control certain 
DSLR camera models 
from Canon and Nikon.

Truly innovative 
and packed with 
potential for macro 

and video work. Despite its 
issues, it’s an exciting tool.

  Touch control of some DSLRs

  View live feed on iPad screen

  Poor integration with workflow

 No true depth of field preview

It’s delightful to 
see a company 
merging two 

devices that normally 
sit apart into something 
even greater. After 
years of iPad use, the 
built-in viewfinder feels 
too small and awkward 
to navigate. If only it 
worked with my model.

Team Talk

The Manfrotto Digital 
Director contains its own 
processor for instant 
image processing.
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Cricut Explore Air

HHHHH
£255 Manufacturer Cricut, uk.cricut.com

Requires OS X 10.9 or higher Maximum size 12x12 inches  
Materials paper, card, vinyl, fabric, poster board

Papercraft and textile arts at 
home are a massive market. 

But if you thought the joy came 
from painstakingly drawing and 
cutting things manually, this gadget 
will change your mind. We gave top 
marks to the original model (see 
MF275), a drawing and cutting 
machine masquerading as a printer. 

Between the different paper 
stocks, vinyl, poster board, iron-on 
materials and even fabrics, Cricut 
reckons the Explore Air can deal with 
around 60 materials. That’s simply 
staggering for a home tabletop 

device that looks like it could just 
about manage a few slices here and 
there to make a basic birthday card. 
The intricacy that the Cricut can 
handle is clear when you download 
a complex design from the hundreds 
available in Cricut Design Space. That 
app, and the addition of Bluetooth 
connectivity in this model, make the 
Explore a winner once again.

Explore Air performs its magic 
with a two-part compartment that 
holds a pen on one side and houses 
the cutting blade on the other. 
There’s an optional ‘deep cut’ blade 

for dealing with tougher materials 
too. For paper and card you use the 
supplied cutting mat, which has a 
sticky surface to hold your material 
in place. When using the iOS app to 
design, patterns that use multiple 
colours are simply divided into steps, 
and you’re prompted when you 
need to swap in different material. 
The Explore Air is simple to use and 
makes lovely looking things. 
Christian Hall

Hobby crafters will 
love it, but it could 
easily get anyone 

addicted to, well, pretty 
much any home craft!

  Brilliant results, and fast!

  Finally it’s wireless

  Easy to set up

 Superb iOS app

Personal Cloud is 
a versatile and 
reliable network 

storage solution that covers 
most people’s needs.

  Decent set of features

  Offers solid performance

 Easy to set up and use

  Mobile app needs work

Simply a cut above the rest in the 
world of home craft gadgets

Personal Cloud 
2-Bay 8TB

These days, network drives offer 
far more than just storage. Look 

beyond this one’s slab-like case and 
you’ll find that while it lacks some 
top-end features, it has enough 
functionality to satisfy most folk.

The 8TB of storage comes from 
two 4TB drives, set as a RAID 1 array 
by default. This halves the usable 
storage, but increases read speeds 
and gives redundancy against one 
drive failing. While you can switch to 
the full 8TB, consider that the USB 

ports offer expansion options, 
alongside sharing a printer. Write 
speeds are par for the course at 
around 12MB/sec, and the mirrored 
array read at up to 85MB/sec.

User-friendly configuration tools 
are presented in your web browser, 
and they’re easy to use – just flick a 
switch to enable access to your files 
over the internet, for example. The 
drive flawlessly supports core Mac 
services, including an iTunes audio 
server and Time Machine, and a 

limited range of third-party services, 
including BitTorrent Sync and Plex, 
extends its capabilities. Mac and iOS 
apps provide access to files. Both do 
the job, but don’t pull up any trees.

Sub-par apps aside, Seagate’s 
solution hits the spot with a combo 
of good core functionality, 
reasonable performance and fuss-
free setup. Nick Peers

The Explore Air looks like a regular printer, 
but it enables very different and wild creativity.

HHHHH
£360 Manufacturer Seagate, seagate.com

Capacity 8TB (2x 4TB disks) Connectivity Gigabit Ethernet, 1x USB 2.0, 1x USB 3.0 

Cover your household’s backup and 
storage needs with a single drive

Personal Cloud is reassuringly solid – 
in looks, functionality and performance.
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Seagate Backup 
Plus Slim 2TB

HHHHH
£65 Manufacturer Seagate, seagate.com

Requires OS X 10.7 or higher (OS X 10.9 or higher for Seagate Lyve app) 
Ports 1x USB 3.0 Features Two years of 200GB cloud storage, NTFS driver for OS X

For the most part, portable 
external hard drives tend to be 

pretty much alike: compact boxes 
that wrap a disk in plastic or metal. 
This one is the latter type, so it feels 
tough. The model tested is the same 
size and weight as the 1TB version, 
which is just £15 less.

In terms of performance, its mean 
average transfer rates when reading 
(114.1MB/sec) and writing (124.7MB/
sec) sequentially to the disk are 

respectable. In our tougher test of 
accessing random locations, the 
mean average of 22.5MB/sec when 
reading isn’t great, yet 67.8MB/sec 
when writing is pretty good.

The drive includes two years of 
online storage on OneDrive, which 
integrates with OS X just as easily as 
the likes of Dropbox and iCloud 
Drive. This space is useful for backing 
up your most important files, but 
also to transfer files to and from a 

Windows PC without unplugging 
things. Or, if you need faster transfer 
of very large files in Boot Camp, the 
included NTFS driver means you can 
keep the drive in that format and 
also write to it from OS X. 

Seagate’s Lyve app consolidates 
photos and videos on the drive and 
makes them available to other 
devices online, but you might see 
that as redundant if you use iCloud 
Photo Library. Alan Stonebridge

For the most part, 
a good performer 
for a drive of its 

kind, backed up with a 
practical software bundle.

  Mostly good performance

 Appealing software bundle

  Well priced for what you get 

  Lacklustre random read speed

A big stand with 
useful features, but 
a few flaws – most 

notably that it doesn’t have 
an external power supply.

  Easy USB port access for iMacs

  Good price

  Would be better if self-powered

  Plastic build not that classy

Actually, you get more than 2TB of 
storage with this portable drive…

The Backup Plus Slim’s 
design is attractively simple, 
and its software bundle is, 
on the whole, good in 
selection and value.

Satechi F3 Smart 
Monitor Stand

HHHHH
£35 Manufacturer Satechi, satechi.net

Connectivity 4x USB 3.0 inputs, 1x USB 3.0 output (to Mac), 3.5mm passthrough 
ports for microphone and headphones

Not content to just hold your 
iMac, this comfortably wide 

(21.7x9.1 in – about as wide as a 
21.5-inch iMac) monitor stand aims 
to make it more convenient to use. 
There are four USB 3.0 ports on the 
front, so it’s easy to attach a USB stick 
or plug in your phone for charging. 
Just connect the provided USB cable 
from the stand’s rear to your iMac 
(or other computer of choice) to get 
going. It also has passthroughs for 

3.5mm mic and headphone jacks 
(again, cables are provided), though 
in the case of the iMac this can be of 
limited use, since current models 
only offer a single port for both.   

The stand doesn’t have its own 
power supply, so if you connect 
several things, you might find they 
charge a bit slowly – not a huge 
problem, but something to be aware 
of. The stand itself is plastic along the 
top, with aluminum legs. It looks 

better in photos than in the flesh, 
sadly, but it’s far from ugly – just 
quite plasticky. Ours had a bit of 
concerning wobble when we placed 
our iMac on it, but seemed perfectly 
sturdy after that – we never worried 
about the iMac falling off. It stands 
reasonably high off the desk, with 
plenty of space to fit a Mac mini 
under it, as well as most external 
hard drives (when kept on their 
sides, at least). Matt Bolton

Raise your Mac’s display to a more 
comfortable viewing level

This monitor stand looks 
better in photos, but at 
least it’s affordable.
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Creative  
Muvo Mini
A highly capable weatherproof and 
dustproof Bluetooth speaker, and at  
a bargain price to boot!

We’ve seen mighty sound 
packed into small form factors, 
options with incredible battery 

life and even some that can take a 
tough tumble. But we haven’t seen 
a single speaker that can accomplish 
all of these feats – until now.

The Muvo Mini’s design will split 
opinion. Some will appreciate the 
minimalism, but others will think it 
uninspired. Given the cost, most will 
be impressed with the build quality.

The body is covered in a smooth, 
matte plastic. Ours was grey, but 
there are red, blue and white options 
too. The front is capped with a grille, 
which itself has neat design touches. 
Beneath it, a mesh layer covers the 
dual drivers and the bass radiator.

On the top are buttons for power, 
Bluetooth and volume, and LEDs for 
connection and battery status. 
When held, the Bluetooth button 
pairs a device, and it answers and 
ends phone calls when pressed.

On the back, a rubber flap covers 
the micro-USB and 3.5mm ports. 
Make sure it’s closed if the speaker 
will be exposed to dust or water. 

HHHHH
£50 Manufacturer Creative, http://uk.creative.com

Dimensions 19x3.7x5.9cm Connectivity Bluetooth 4.0, 3.5mm Aux-in, micro-USB

The Creative Muvo 
Mini contains every 
desirable feature you 

seek out in a Bluetooth speaker. 
For £50, it’s an unbeatable deal.

The Muvo Mini is weatherproofed, 
with an IP66 rating that means it’s 
entirely dustproof and waterproof 
just shy of being submerged.

Sound quality excels at avoiding 
distortion even at volume. The bass 
radiator does an admirable job with 
low-end notes, even though this is 
the speaker’s weakest area. Even so, 
the gamut of music genres sounded 
full of warm mid range and highs. 
We experienced no audio artifacts 
or drop in connection over 30 feet, 
even through a few walls. As a 
speakerphone, call quality was fine. 
Also, the battery met the hearty 
quoted duration of 10 hours easily.

This tiny box’s functionality and 
performance warrant a considerably 
higher price. It’s the best value for a 
durable and capable Bluetooth 
speaker. Cameron Faulkner

BassJump
Alex pumps up his MacBook bass 

with this elegant booster

Tiny and a little plain-looking, 
the Muvo Mini is surprisingly 

good quality and value.

For all their majesty, there’s still 
something MacBooks lack that 
would make them near-perfect: 
top-notch sound quality. Let’s be fair, 
your standard MacBook speakers 
will never be able to compete with 
high-end studio setups; they’re not 

bad, but they still leave much to be desired. Sure, 
you could shell out several hundred pounds on a 
good audio system and hook it up to your laptop – 
or you could pay less than £50 for Twelve South’s 
BassJump. For the results it delivers and the price 
you pay, it’s an outstanding bargain.

It’s not a speaker, though; rather, the BassJump 
provides the bass output that your MacBook lacks, 
and for many people that’s all that is required. 
It makes a world of difference: your MacBook Pro 
will sound even better than it already does, while 
your MacBook Air will be almost unrecognisable. 
It really is that good. While it may not please the 
most serious audiophiles out there, it’s an excellent 
piece of hardware for the rest of us.

As with all Twelve South kit, BassJump looks 
gorgeous sitting next to the Apple gear arrayed on 
your desk. Now is the perfect time to take the plunge, 
as Twelve South has just updated the BassJump 
software and given it a welcome lift ready for the 
release of El Capitan. All this for a fraction of the 
cost of a new speaker set? For me, it’s a no brainer.
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SuperStar 
Backfloat

logitech MX 
anywhere 2

evutec 
karBon Si

tt eSportS 
contour

HHHHH
£120 Manufacturer Monster, 
shopmonsterproducts.co.uk

HHHHH
£61 Manufacturer Logitech,  
logitech.com

HHHHH
$49.95 (about £32) Manufacturer 
Evutec, evutec.com

HHHHH
£50 Manufacturer Thermaltake, 
ttesports.com

There are quite a few 
rugged, outdoor speakers 
available right now, but we 

got to throw the BackFloat across 
the room during a recent demo, so 
we can attest that it really can take 
a beating. It’s waterproof and, as the 
name implies, is designed to float 
so that you can let it drift around a 
swimming pool while you lie back 
and relax on holiday. It has  
Bluetooth for wireless streaming 
and a seven-hour battery life. 
It sounds good too, with a strong, 
clear sound and a respectable 
amount of bass for such a compact 
little speaker. Cliff Joseph

This great little mouse is 
small enough to carry with 
a MacBook, yet two key 

features are great for any Mac.
One is its ‘Darkfield’ laser sensor, 

which tracks movement well on just 
about any surface – on windows, 
jeans, shiny magazines… anything 
difficult, we got perfect results.

Second is the button on top. You 
assign gestures to it in Logitech’s 
app, then hold it and move the 
mouse in one of four directions to 
trigger them. We found it a bit far 
back for comfort, but it offers great 
possibilities for creative work or 
getting around OS X. Matt Bolton

Unlike many protective cases, 
the Evutec Karbon SI is sleek 
and unobtrusive. It comes 

with MIL-STD-810G certification – 
fancy talk for saying it’s military-
grade strong. It’s scratchproof (to a 
degree), contains Kevlar and claims 
to be five times stronger than steel 
at the same weight, which should 
protect the back of your iPhone 
from all kinds of rough and tumble. 
There’s no protection on the front, 
though, which may limit its appeal.

The lock button cover also isn’t 
very tactile, but this is a minor 
qualm. For such a slimline case, it’s 
seriously impressive. Alex Blake

This iOS game controller is 
full-size, like those for Xbox 
One or PS4. A flip-up clip 

holds an iPhone or iPod touch, but it 
didn’t fold back enough for us; when 
our hold or line of sight was good, 
the other became awkward.

Otherwise, it’s pretty good to use. 
It feels solid and is a nice weight (yet 
a phone makes the back a bit hefty). 
Its face buttons feel crisp in action. 
The analog sticks are fairly stiff, but 
give good feedback. It’s hard to feel 
direction from the d-pad, making 
precision hard. The analog shoulder 
buttons are a little on the soft side, 
with fairly short travel. Matt Bolton

A sturdy, lightweight 
case that offers heavy-
duty protection for your 

iPhone while remaining slim. 
Lock button is a minor flaw.

Though the SuperStar 
Backfloat is a little 
pricey, its tough and 

waterproof design will earn its 
keep on holiday.

A good controller, but 
it’s a better clip and 
some d-pad feedback 

away from being a great one. 
Still worth buying, though.

A really well-made 
mouse that works 
everywhere and lets 

you use useful Mac gestures 
without fingering a trackpad.

1 2 3 4
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Give your Apple Watch some love 
with one of these great charging 
stands for your bedside table
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 5 of the best…

Apple Watch stands

HHHHH
£35 Manufacturer Just Mobile, just-mobile.eu

HHHHH
£25 Manufacturer Orzly, orzly.com

1 Just Mobile’s TimeStand is the smallest 
of the Apple Watch stands in this test. 
The HiRise is slightly shorter but the 

footprint of the TimeStand is tiny at just 48mm 
across. With even a 38mm Watch on it, the stand 
looks a little too compact, and it’s not that sturdy 
given how heavy it seems. We adore the design 
though, wrapping the strap through a hollowed 
out section in an otherwise cylindrical structure. 
The Nomad stand copies this approach but in a 
flatter and more curved one-piece design. 

It’s often awkward for the charging cables on 
Watch stands to be tidy, but Just Mobile’s effort 
works well, running the bulk of the cable down 
the left-hand edge of the stand, then out the 
back. It looks great in silver or black.

orzly  
DuostanD

Just Mobile 
tiMestanD

2 This stand is a bit quirky, designed to 
hold an iPhone (in portrait or landscape) 
on one pedestal, and the Apple Watch 

on another, higher one. It looks a little awkward, 
and we struggled with the bizarre angle that the 
Watch sits at. The backwards tilt is ok, but it’s then 
angled slightly inwards towards the iPhone stand 
which doesn’t feel quite right. The metal quality 
and finish aren’t the best, but it’s very lightweight.

The worst element is the clumsy cable solution. 
The stand’s thinness is nice, but there’s nowhere 
tidy to trail a charging cable. The iPhone stand 
doesn’t have this issue as a Lightning connector 
threads neatly at the front. The DuoStand is well 
priced, and many will like its dual use, but it’s just 
not as elegantly executed as most of the others.
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3

4

5

5 Nomad’s stand is a clear winner on looks. 
This looks like it was designed by Apple 
and really presents the Watch at its best. 

That wouldn’t mean a lot if the stand didn’t prove 
useful, however. Thankfully, it’s almost perfect. 
It could do with a slightly heavier bottom element 
if we’re being brutally honest. That would help 
prevent you knocking it backwards on occasion, 
when you try to snap the Watch onto the charger.  

The charging cable is really well disguised on 
the Nomad stand, running all the way along the 
curved design and then slightly under the dock 
before trailing away at the back. It’s easy to thread 
it on, and once in place looks like there’s no cable 
there at all – even better than the TimeStand’s 
tidy solution. We love it! Christian Hall

4 When we first saw this effort from Griffin 
we were put off by its joystick-like 
design. It’s also far taller than the others 

and looks ungainly. But with the Watch in place 
we warmed to it over time. It’s a solid stand and is 
the only extendable one here. The all-plastic body 
didn’t bother us and it didn’t feel cheap. 

We also liked the fact you can use the front as 
an iPhone stand too, a bit like the Orzly, but it’s far 
more subtle and just as useful.

The WatchStand’s best feature is how it holds 
the Watch. Because it’s so tall you just unfasten a 
strap, like the Sport band, and drape the bottom 
part of the strap downwards. If you want the 
watch to be horizontal you can rotate it easily and 
it holds firm with the charging cable’s magnet.

3 Twelve South’s stand is our favourite 
stand for angle. If you have a bedside 
table that’s at the same level as your 

bed, or slightly below, you can easily see the 
whole watch face. The tilted-back angle of the 
others suits much lower sidetables, so always 
keep that in mind when deciding which stand 
suits you best.

We also love the cable solution, which keeps it 
out of sight by running the bulk of it under a 
plastic flap at the back. It’s a shame that part is 
not quite the same colour as the metal part of the 
stand, but it’s passable. The Watch strap, whatever 
variety, fits neatly by sliding through a gap at the 
bottom and also over the top of the holding area, 
held on by the magnetic charging cable.

HHHHH
£35 Manufacturer Twelve South, twelvesouth.com

HHHHH
£20 Manufacturer Griffin, griffintechnology.com

HHHHH
£45 Manufacturer Nomad, hellonomad.com

griffin  
watchstanD

noMaD stanD  
for apple watch

twelve south  
hirise



Armature

HHHHH
£18.99 Developer Grey Goo Software, greygoo.io

Requires OS X 10.10 or higher

A crucial aspect of 
designing a software 
or web interface is 
prototyping: going 

through ideas to refine them down 
to one that works. Mocking up an 
interface can take almost as long as 
actually building one. That’s where 
Armature comes in. It’s essentially a 
collection of pre-made graphical 
elements designed to assist you with 
planning or wireframing projects. 
Rather than build your own generic 
graphics to illustrate how something 
might be laid out, you simply pull 
them from this library. 

Previously an extension for Adobe 
Illustrator yet now a standalone Mac 
app, Armature is simple to use: select 
a category of interface elements, 
find the one you want and copy and 
paste it into your app of choice. 
Obvious candidates for building 
mockups include Photoshop and 
Illustrator, but Armature also works 
well with Microsoft Word, TextEdit 
and OmniGraffle.

Objects are easily resized and 
manipulated once inside your design 
app, and Armature’s selection of 
graphics is good, covering most of 
the kinds of interface elements you 

need to create plans and wireframes. 
Although it’s very efficient to use 

and certainly speeds up prototyping, 
the price seems a little high for what 
is essentially a collection of 150 
graphical elements to paste into 
other apps’ documents. If you do a 
lot of wireframing, that’s maybe not 
such an issue. Hollin Jones

Search, drag and drop pre-created 
wireframe graphics for layout planning.

Save time when mocking up ideas 
with a drag-and-drop graphics library

Armature’s a handy 
timesaver for app 
developers and 

web designers, though it’s 
a little pricey for what it is.

  Speeds up prototyping

  Good selection of elements

 Quite an expensive, small library

 Better apps for layout planning
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Keyboard Maestro

HHHHH
$36 (about £22) Developer Stairways Software, keyboardmaestro.com

Requires OS X 10.10.3 or higher

Keyboard Maestro is all 
about controlling your 
Mac with user-defined 
macros, comprised of a 

trigger and one or more actions 
which range from simple hot-key 
commands through to more 
advanced interactions that can be 
based on specific conditions. 

The app shows you how to set a 
function key to open your Home 
folder – simple. A more complex 
action is also provided which copies 
a selection, switches to the last used 
app, pastes, and then switches back 
again. Naturally, the sky’s the limit 

once you get a handle on how to 
create your own macros.

Version 7 offers a range of new 
triggers and actions. Triggers now 
include keys tapped multiple times, 
window focus changes, and updates 
to folders. The last of those means 
you can be notified when new files 
are added to a shared folder. Actions 
have gained options that bring new 
smarts and complexity to macros, 
and it’s good to also see the app 
making things easier for anyone 
creating them. There’s a new gear 
menu in every action for access to 
contextual operations, an Add 

Action Bar for rapid access, and 
autocompletion of text and search 
tokens, functions and variables.

Keyboard Maestro still doesn’t 
look especially pretty (the theme 
editor’s palette styles come across as 
gaudy), but otherwise this is a solid 
update to a very capable app. 
Craig Grannell

The new Add Action bar seriously speeds 
up the process of creating macros.

Press a couple of keys to do (almost) 
anything with your Mac

Still a bit ugly and a 
touch daunting for 
newcomers, but 

this remains a macro app 
with serious ambition.

  Useful new actions and triggers

  Now faster to create actions

  New macro inspector

  Daunting for beginners



Mac Apps   |   RATED

MacFormat.com  |  Autumn 2015  |  99 

Kiwi for Gmail
Take Gmail out of your web browser 
with this fast and friendly email app

If Gmail is your email 
service, you have  
probably encountered 
a familiar problem: the 

service was designed to be used in 
a browser, and using a desktop email 
client to access it means losing some 
of its power. Kiwi is designed to 
change that by delivering the full 
Gmail experience in a dedicated 
desktop app that’s less demanding 
than a browser, but as powerful as 
you want Gmail to be.

There are two versions of Kiwi: 
a stripped-down Lite version for 
single accounts, and a paid-for 
version, which supports up to six 
accounts, keyboard shortcuts, 
account themes and the ability to 
restrict notifications to messages 
flagged as important. The latter will 
also support third-party plug-ins, 
although it doesn’t currently do so.

The first thing you’ll notice is that 
Kiwi really looks like Gmail, and that’s 
the point: you don’t need to change 
how you do things. There are some 
differences, though. An icon in 
OS X’s menu bar enables you to see 
your unread message count and 
compose a new email. In the paid 
version, that covers all your accounts.

HHHHH
Free or £7.99 Developer Zive, kiwiforgmail.com

Requires A Gmail account, OS X 10.8 or higher

In addition to Gmail itself, Kiwi 
also supports Google Apps (so it 
works with corporate and 
educational Gmail accounts) and 
integrates Google Drive and Chat. 
The paid version also has a useful 
‘zen button’ that turns off email 
notifications until the following day 
without affecting notifications from 
other apps in OS X.

If you’re happy using third-party 
email clients, Apple Mail or a pinned 
Safari tab to access Gmail then this 
might not be for you, but if you want 
the full browser-based Gmail 
experience without the browser bit, 
we think you’ll like Kiwi a lot. 
Gary Marshall

Kiwi looks just like Gmail, and that’s the point: it’s Gmail without the browser.

Kiwi is fast, friendly, 
frees Gmail from the 
browser, and makes 

multiple accounts much easier 
to manage.

  It’s Gmail without the browser

  Great for multiple accounts

  Third-party plug-ins “coming soon”

  Doesn’t have an offline mode

TeleporT
This brilliant virtual KVM switch 
makes Alan feel in full control

Often I’ll have a desktop Mac and my 
MacBook Pro next to each other, 
with things like Twitter, news sites 
and email on the MacBook while I do 
work on the larger screen. However, 
I don’t want to have to reach for the 
MacBook to control it. That’s where 

Teleport (free, abyssoft.com) is helpful.
After installing it on two Macs, you specify their 

physical arrangement, much like you would for 
multiple displays in System Preferences. You can 
then move the pointer from the Mac whose input 
devices you’re using to the other one – or at least it 
seems that way; Teleport is actually transmitting 
your input to the other Mac over your network.

You can specify a modifier key to hold down to 
prevent the pointer accidentally being moved 
between Macs, or simply adjust the delay before the 
pointer is allowed to make the leap. Teleport also 
enables you to drag files from one Mac to another 
(which I use in place of OS X’s File Sharing feature), 
and it can sync the Clipboard’s contents, too.

Teleport is even able to transmit keyboard input to 
another Mac – whichever the pointer is on – and its 
preferences include an option to encrypt what is sent 
in case you’re using a shared network. Considering 
it’s free, Teleport is a delightfully effective way to 
comfortably use two Macs side by side if you can’t 
justify the cost of, or desk space for, a KVM switch.
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Most image-editing 
apps can quickly make 
a monochromatic 
image, but not all give 

you full control over the end result. 
Macphun’s approach to the complex 
task of producing a good black and 
white image is Tonality, which 
applies a series of editable mono 
filters to your image.

The latest update brings with it an 
improved image processing engine 
and new layer effects, plus support 
for Force Touch trackpads along with 
a wider range of raw files. You can 
also send your edited files directly to 
other Macphun products, Photos, 
iPhoto, Aperture, Photoshop or 
Lightroom (sadly, there’s no support 
for Serif’s new Affinity Photo, 
reviewed in MF291). Shell out for the 
Pro edition and Tonality becomes a 
plug-in that runs inside many of 
those apps.

Open an image file in the app and 
it immediately becomes black and 
white. Along the bottom of the 
interface runs a bar of effects chosen 
from a Presets menu, each one 
immediately previewing the image 
you’ve loaded. Click on one of those 
effects and it’s initially applied at 
100% strength – you can then drag 

a slider on the preview thumbnail to 
decrease the intensity of the effect. 
Furthermore, a panel on the right 
can be used to alter the effect 
further, with a tone curve graph, 
colour temperature and exposure 
sliders, and tools for split toning and 

adding colours back into the image.
Despite Tonality being marketed 

as dedicated to monochrome 
images, all the colour information 
from your pictures is preserved – the 
saturation sliders are just set to zero. 

Far from being an app that just 
makes black and white images, 
Tonality is capable of all sorts of 
colour effects and vintage looks. 
That’s especially true when you 
factor in the app’s grain and film 
effect filter, which can load a custom 

texture file, in addition to those 
included with the software.

A layering system allows you to 
build effects on top of one another, 
blending and masking (including 
new luminosity masks that select 
pixels based on brightness) to build 
things up to complex effects and 
sophisticated images. Once you’re 
finished, your creations can be 
shared directly to social networks or 
photography sites, or export them to 
your hard drive.

Tonality tends to produce haloes 
around areas of high contrast in an 
image, much like overuse of the 
Clarity slider in Lightroom can. 
Otherwise it’s a competent image 
editor with an approach to altering 
your image that’s as simple or as 
complex as you want it to be. 
Ian Evenden

Tonality is capable of all sorts of colour 
effects and vintage looks, especially 
when you apply its grain and film effects

Tonality 1.2
A monochrome imaging 
app with plenty of tricks 
up its sleeve
HHHHH
£13.49 Developer Macphun, macphun.com

Requires OS X 10.8 or higher

Despite its emphasis on black and white, Tonality is also highly capable of a variety of 
colour effects. You can add grain and film effects to your images, too.

Presets allow quick and easy 
monochrome results but you 
can fine-tune endlessly.

A great choice 
if you’re into 
monochrome 

photography, and its colour 
editing options are a bonus.

  Runs really fast

  Supports many file formats

  Plays well with other apps

  Rather narrow appeal

I love black and 
white images 
and for such a 

small price I think 
Tonaility is well worth 
adding to your photo-
editing arsenal. But, 
perhaps only if you’ve 
not mastered 
monochrome in other 
photo apps you own.

Team Talk
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ZeitNote
Find out where all your time’s going

Making an app 
uncomplicated and 
simple is usually a 
smart move, but 

sometimes a developer can take 
things a bit too far. This is the feeling 
we get with ZeitNote, which pares 
personal time tracking to the bone.

 The basic concept is fine, though 
not unique on OS X; you fire up the 
app (or just add it to your login items 
for best results), and ZeitNote tracks 
the ones you use and how much 
time you spend in them. ZeitNote’s 
developer points out there aren’t 
really any ways to ‘cheat’ the app, 
but then if you feel the need to 
cheat, you probably shouldn’t be 
using ZeitNote or any of its 
contemporaries anyway.

As long as you’ve spent over a 
minute in an app, you’ll get feedback 
from ZeitNote, presented inside a 
window available from the menu 
bar. Click on the ZeitNote icon and 
you see a bar chart that shows the 
apps you’ve used, and how long you 
used each of them. Underneath 
you’ll find a single line representing 
the entire day (running from 
midnight to midnight). White areas 
denote active times on the Mac, and 
a faded line indicates the Mac was 
idle or asleep at that time. Select any 

HHHHH
£2.29 Developer Denis Krasulin, zeitnote.com

Requires OS X 10.10 or higher

of the apps in the chart and its 
usage is then displayed over the 
aforementioned line. ZeitNote is 
easy to use, and although it’s not 
especially beautiful, there’s enough 
clarity where it matters.

And that’s about it. You can click 
left and right arrows to view data 
from other dates, although you can’t 
jump straight to a specific day. More 
frustratingly, there’s no means of 
exporting your data. For personal 
timekeeping on a purely at-a-glance 
basis, this is fine, not least given the 
app’s low price tag. However, it 
would be good to have access to 
trends about your app usage within 
ZeitNote, or at least the means to 
get at the data it records, so that it 
can be examined and explored 
elsewhere. Craig Grannell

ZeitNote gives you an overview of time spent in apps, but it’s a bit too simple.

ZeitNote is not a bad 
option for personal 
time tracking, but it 

could do with more scope 
regarding collected data.

  Seems to be pretty accurate

  Simple enough to use

  No data export features

  Fiddly to view previous data

OptOpt aims to 
replace the OS X 
app switcher by 
adding the ability 

to launch or switch programs 
using keyboard shortcuts. It’s a 
worthy idea, but let down by 
poor execution.

OptOpt is fiddly to set up – 
you have to manually enable it 
in Accessibility preferences, and 
then you must set up custom 
keyboard shortcuts for your 
favourite apps using its menu 
bar icon. This is critical as it 
allows you to launch apps that 
aren’t running (and therefore 
on display in the OptOpt app 
switcher), but you do have to 
remember your custom key 

configurations. Matters are 
further complicated when you 
consider that apps are only 
available to configure when 
they’ve run alongside OptOpt, 
so it can recognise them.

Once you get past all these 
hurdles, press å twice to reveal 
OptOpt, then your shortcut to 
access an app. It works, but the 
effort involved makes OptOpt 
impossible to recommend in its 
current state. Nick Peers

Clipboard 
managers are 
almost ten a 
penny, so Nice 

Clipboard needs something 
special to stand out. Sadly, it 
fails to deliver anything truly 
innovative. Its main selling 
point is syncing clips via iCloud 
between Mac and iOS (another 
£2.29 purchase), but you can 
get similar functionality for free 
with CloudClip.

Nice Clipboard also stacks up 
poorly to rival apps like Copy 
‘em Paste, with just one 
tweakable setting available 
which limits the number of 
clippings. At least it sports a 
neat design that complements 

Yosemite perfectly and allows 
you to view your clippings in a 
resizable and movable floating 
window. There are also some 
useful buttons when doing so: 
View to preview media, and 
Show for revealing a copied 
file’s location in Finder. 

If you’re looking for a basic, 
no-frills tool, it may appeal, but 
if you want a wider range of 
management tools then look 
elsewhere. Nick Peers

OptOpt 1.1

Nice clipbOard 1.0.1

HHHHH
79p Developer Jian Hu, twitter.com/jianhucs

Requires OS X 10.10 or higher

HHHHH
£2.29 Developer Nice Apps, getniceapps.com

Requires OS X 10.10 or higher 

Manage and sync your clippings

Launch apps via your keyboard

Nice Clipboard is 
sleek and simple, 
but lacks the 

flexible options found in 
other Clipboard managers.

This keyboard-
driven app 
switcher is a nice 

idea, but its flaws outweigh 
its marginal benefits.



RATED   |   Mac Games  

102  |  MacFormat.com  |   Autumn 2015

Volume
HHHHH
£14.99 Developer Mike Bithell Games, mikebithellgames.com

Requires OS X 10.10.3 or higher, 1.4GHz processor, see site for graphics cards

‘Volume’ is a pun on 
the game’s themes of 
speaking truth to 
power, and to its 

signature mechanic – a whistle used 
to distract roving guards. Also, the 
game is presented almost entirely in 
volumetric virtual reality: all glowing 
walls and sharp, polygonal enemies.

Rob Locksley broadcasts a series 
of stealthy heists from the simulated 
homes of the rich and powerful in 
hopes that his viewers will commit 
genuine robberies, thus subverting 
the kleptocratic government of 
near‑future England. One hundred 
discrete mazes are guarded by 
pattern‑bound soldiers and studded 

with force fields and lasers. The goal 
is to steal every gem and escape.

Subtlety and nuance are fortunate 
by‑products of the stringent puzzle 
design. A patrolling Pawn may have 
to be lured to a specific point to give 
you time to get away, for example. 
This sounds fussy, but new concepts 
are introduced gently and stacked in 
increasingly satisfying ways.

Each level has a par time. This 
focus on efficiency may be most 
congruent with the game’s framing, 
but it’s not the only approach. 
Patience may mean you’re never 
spotted, but revealing yourself can 
be a tactical decision. The myriad 
user‑created levels show the 

mechanics are unambiguous and 
consistent, but allow for remarkable 
flexibility. The script is wry and 
touching in small moments, yet 
despite touching on weighty topics 
like xenophobia, voyeurism and 
class, neither the plot nor the game’s 
politics crystallize beyond your foe’s 
obvious villainy. Joseph Leray

Pink isn’t a good colour on Locksley 
because it means he’s about to be shot.

A sci‑fi Robin Hood, livestreamed

When undistracted 
by its talkative plot, 
Volume offers 

distilled and unencumbered 
stealth action.

  Clear stealth mechanics

  Mostly allows approaches

  User‑created levels

 Plot never executes on its drama

Shelter 2
HHHHH
£10.99 Developer Might & Delight, mightanddelight.com

Requires OS X 10.7 or higher, 2.6GHz processor, see website for graphics cards

Behind all things bright 
and beautiful, nature is 
a brutal place. No rules, 
save the inherent ones 

of tooth and claw. No mercy. No 
sympathy, not even for a pregnant 
mother lynx in desperate search of a 
new home. Shelter offers both sides, 
but it’s important that it starts out by 
making you the prey – alone and 
weak in the snow, with wolves 
quickly closing in. Later, having 
escaped and birthed cubs, you get 
to show your teeth – hunting other 
animals through the defrosting wilds 
and fighting to ensure your family 
lives long enough to create a new 
generation of furry little adventurers.

Shelter 2 is an extremely pretty 
game, eschewing realism for a 
painted look but still conveying 
enough detail to feel for the cubs 
and their exhausted mother. Where 
it falls down though is that at heart, 
there’s really not that much to a 
lynx’s life, and once you’ve got into 
the basic rhythm of things there’s 
not a lot more left to discover. 

Hunting is a simple matter. There 
aren’t many threats to worry about. 
Food is at least plentiful enough. It 
doesn’t take long before all that’s left 
is the mood, with Shelter quickly 
becoming far more of an art game 
than a survival simulator. It’s effective 
as that, and there’s little else out 

there like it, but even so it’s hard not 
to find yourself wishing that there 
was more to it than watching the 
scenery change and feeling 
empathetic towards polygonal furry 
critters. The whole thing is over in 
just a couple of hours, yet somehow, 
it still reluctantly outstays its 
welcome.  Richard Cobbett

Unfortunately, Shelter’s beautifully artistic 
style can’t make up for its short length.

A very different kind of lynx effect

A fascinating 
experience while it 
lasts, which isn’t 

long enough even for 
Shelter’s short length.

  Good sense of character

 Emotional connection

  Very little to it

  Not enough tension
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Games have always 
struggled with making 
you a detective. Their 
rigid systems just can’t 

satisfy our complex curiosity. You’ll 
have questions and places to explore 
that the game doesn’t allow.

Her Story brilliantly sidesteps 
games’ accidental restrictions by 
giving you intentional ones instead. 
You have to sift through a 20-year-
old computer archive, reviewing 
police interview tapes of a woman, 

taken over several days after her 
husband’s disappearance. You can’t 
view them chronologically. Instead, 
you search transcriptions of the 
evidence to find relevant clips. 
Only five can be returned at once, 
so looking for obvious results only 
gets you so far. You use hints from 
them to find more: a new name or 
place might reveal new videos.

Knowing the limits of the system 
you must work in, frustration makes 
way for figuring out creative ways to 

use it. This makes your game unique. 
The story contains many secrets, and 
how and when they’re reached 
depends on which threads you pull. 
Some revelations are big twists if you 
haven’t seen videos that provide 
context – everyone gets a different 
“Aha!” moment. This lets you feel 
smart in a way few games have 
managed – it feels not like solving 
a puzzle, but uncovering the truth.

The lone cast member gives an 
intriguing performance – sometimes 
suspicious, other times sympathetic. 
As you pick apart the contradictions 
and hints, spinning theories, you’ll 
feel like you’re unleashing your inner 
Richard Castle. Matt Bolton

Finally, a detective game worth investigating

HHHHH
£3.99 Developer Sam Barlow, herstorygame.com

Works with iPhone, iPod touch, iPad Version 1.1

An engrossing, 
exciting and unique 
mystery experience. 

A truly essential game that 
you shouldn’t miss.

  Your game is unique to you

  Clever layered story

 Good central performance

  Also available on Mac

If you’re sick of 
shooters and 
weary of RPGs 

then this game truly 
demands attention. It’s 
no less exciting than a 
gung-ho gunslinger but 
takes you on a totally 
different journey. One 
of the most intriguing 
concepts we’ve seen.

Team Talk

After a few hours of play, you’ll think you 

know this woman so well – until a new 

video changes your perspective again.
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HHHHH
£3.99 Developer Sega America, heroki.com

Works with iPhone, iPod touch, iPad Version 1.0.1

No matter what happens to Heroki, he’s always happy. Be like Heroki!

Heroki

We’re not entirely sure 
if Heroki is man or 
beast, but then again 
what was the deal with 

Sonic? Being an anthropomorphised 
hedgehog with one giant, terrifying 
eye didn’t stop him becoming Sega’s 
most iconic character. We’re not 
saying new Sega stablemate Heroki’s 
helicopter-based head propels him 
to such lofty heights, but it’s a pretty 
nice way of getting about.

You spend almost no time on the 
ground, instead working though 2D 
levels of platforms, tunnels and 
caverns by air – and the occasional 
dive-bomb. There are three control 
schemes (pulling, pushing and – our 
preference – an on-screen joystick), 
and while you’ll often overshoot 
tight turns, it does feel in keeping 
with a character who transports 
himself via head-mounted rotor.

Combat is never tricky; tap a box 
or rock to pick it up, then drag to fire 
it at something. If you’re poorly 
prepared, it will catch you out. Float 
glibly and speedily right into a nest 
of vicious parrots and you’re likely to 
take a few hits. If you’re venturing 
into the unknown, you’d best hope 
there are projectiles nearby.

In some ways, that’s Heroki in a 
nutshell: underestimate it at your 
own peril. As well as making your 
way from starting point A to finish 
ring B, solving environmental puzzles 
along the way (often a matter of 
finding switches to open barriers, 
bopping lizards and putting them 
on buttons, or lugging keys about), 
you also need to collect as many as 
possible of the five Emirals scattered 
across the level. That means some 
seriously thorough exploration, and 
they’re not optional trinkets: at the 
end of each world, you need a 
certain number of Emirals to 
progress through the next world. 
Don’t have enough? Back you go.

The game demands more of you 
than its cheery surface suggests. 
It’s refreshing not to be dragged 
through by the hand, but we’d have 
liked a little more of Sonic’s speed 
and a little less of the busywork. 
Emma Davies

The propeller beanie finally takes off

A sleek and shiny 
platformer with neat 
set pieces, yet the focus 

on exploration means it doesn’t 
spin as fast as Sonic‘s feet.

Prune is about 
growing trees 
out of the 
shadows to 

bloom in the light. A tree can 
only grow a certain total 
length of branches, so to 
make sure the trunk can grow 
long enough to reach the 
light, then spread out to 
bloom into enough flowers, 
you need to quickly trim away 
any extraneous branches.

In this way, you can also 
influence its direction as it 
forks, steering the growth 
around obstacles and out of 
dead ends. Swiping across 
branches to chop them must 
be done both precisely and 

frantically, in contrast to the 
game’s zen aesthetic.

Eventually you’ll have to 
grow via a certain point of the 
level, deal with wind affecting 
the direction of branches, or 
avoid things that can stunt 
growth altogether. The game 
is rapidly moreish. We found 
chopping branches imprecise 
at times, but you can regrow 
a tree instantly, so it’s not 
frustrating. Matt Bolton

Prune

HHHHH
£2.99 Developer Joel McDonald, prunegame.com

Works with iPhone, iPod touch, iPad Version 1.0.21

A game that grows on you

A quiet, flowing, 
engrossing game 
of creation that 

might be 2015’s 
Monument Valley. 

The thing about 
endless runners 
is they’re badly 
named. You 

usually reach a very sudden 
end. Good examples like this 
one do a great job at giving 
you incentive to keep trying.  

You’re in a solar-powered 
vessel and the sun is going 
down, so you’re racing toward 
the horizon to stay in its light. 
The closer to the left or right 
edge of the screen you touch, 
the sharper you steer in that 
direction. Obstacles start off 
fairly sparse and stationary, 
but grow more complex and 
mobile. Avoid them or it’s all 
over. Their shadows grow 

longer and more dense as the 
sun sets, slowing your pace.

The worlds are vast, and 
you play each one for a day, 
learning where choke points 
are and trying different routes. 
The next day you enter a new 
world, which balances gaining 
familiarity to go for high 
scores with variety. You can 
level up your craft too, which 
adds to the game’s longevity. 
Matt Bolton

race the Sun

HHHHH
£3.99 Developer FlippFly LLC, flippfly.com

Works with iPhone, iPod touch, iPad Version 1.01

Spoiler: the sun wins

A smartly made 
and fun endless 
game, though it’s 

best once several of its 
secrets are unlocked. 
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HHHHH
£1.49 Developer Pixite, pixiteapps.com

Works with iPhone, iPod touch, iPad Version 1.7

Fragment has a range of interesting effects with which to chop and change your photos.

Fragment

Fragment is an unusual 
entry into the 
cornucopia of photo 
filter apps. Rather than 

making your images look like they’ve 
been left in a mouldy biscuit tin for 
40 years, it uses a geometric shape 
to split and duplicate the shot, 
creating a kind of double exposure.

Flicking up the menu allows you 
to switch the shape you’re playing 
with, as well as brightness, contrast, 
glow colour and even a stereoscopic 
3D effect. It’s the sort of thing you 
could spend hours playing with, and 
while it will repay the time you invest 
in it, sometimes the best results 
come from a simple application of 
the prism-like shards the app is 
capable of generating.

The effects are certainly striking, 
but a lot rests on choosing the right 
combination of filter and base 
image. Once you’ve found 
something that might work, you can 
zoom and rotate the inset image 
with your fingers before tapping an 
arrow to either share your creation or 

run it back through the app to apply 
a different filter.

The decision to use a swipe up 
from the bottom of the screen to 
open the filter menu is an odd one, 
as it’s quite possible to open iOS’s 
Control Center instead. Otherwise, 
Fragment has an intuitive interface 
that’s speedy to operate.

New in this version is the ability to 
edit videos – as long as you’re using 
iOS 8. This works perfectly smoothly 
but is perhaps best saved for short 
sequences rather than a whole 
wedding video.

Fragment isn’t something you’re 
going to want to apply to every 
photo you take. However, with the 
right image you can certainly create 
something special with it. 
Ian Evenden

Not your everyday image filtering app

Fragment is a unique 
image-editing app that 
may have limited 

applications but will always 
turn up something new.

Good sound is 
just as important 
as what’s on the 
screen. We may 

have little control over our 
surroundings when shooting 
with an iPhone, so VideoSoap 
helps scrub out unwelcome 
background noise.

VideoSoap removes hiss or 
noise, brightens up the overall 
sound, and fixes poor volume 
levels. It accomplishes the first 
task by intelligently analysing 
the sound you don’t want, 
such as an air conditioner or 
traffic noise. As a clip plays, 
tap and hold Learn for a few 
seconds during the offending 
section and the app applies a 

filter to reduce or completely 
remove it from the entire clip.

Enhance and Boost sliders 
restore sparkle to dull audio, 
adjust low volume levels, or 
fix clipping on overly loud 
tracks. The results are quite 
spectacular and very easy to 
accomplish, but headphones 
are recommended. Video, 
along with cleaned audio, is 
copied to a new file with no 
quality loss.  J.R. Bookwalter

VideoSoap

HHHHH
£18.99 Developer Soundness Corporation, soundness-llc.com

Works with iPhone, iPod touch, iPad Version 4.0.3

Scrub up bad audio recordings

VideoSoap works 
magic on poor 
recordings, but it 

needs updating for Retina 
displays and the iPhone 6.

With Facebook 
you can create 
lists of people 
with whom you 

share different kinds of news, 
but Togethera – which lets 
you create dedicated private 
groups to share news among 
family and close friends – 
goes one further. Generally, it 
works very well both as a 
mobile app and a website, 
though for specifically sharing 
baby, child or family news, 
23snaps (see MF290) is 
superior and more mature.

Updates can be shared to 
one or more groups, or via the 
standard Share sheet. There’s 
a Watch app too, though it 

perhaps tries to do too much, 
and there are Premium 
subscriptions for auto-backup 
to services including Dropbox.

Despite being at version 
two, everything still feels a bit 
new; there’s no support FAQ, 
though there is an email 
address. We’re less confident 
about logistical things such as 
data portability and closing 
accounts than with 23snaps. 
Christopher Phin

TogeThera

HHHHH
Free Developer GVL, togethera.com

Works with iPhone, iPod touch, iPad Version 2.12

Private sharing sans Facebook

A good option for 
sharing news to 
small, private 

groups if Facebook makes 
you uncomfortable.



Remote 
viewing
The real headline 
grabber of the Apple TV 
is its Siri Remote, which 
is akin to the Wii remotes 
used by Nintendo, but 
far more sleek and 
compact-looking.

The new Apple 
TV has moved 
beyond its film 
and TV origins

Eight years after the Apple TV came 
into our homes, it has finally been 

given an App Store. We can hardly recall a 
time when our iOS devices didn’t have one, 
so it’s good to see the humble black box 
getting a way to add content beyond TV, 
film and music. You can at last install apps 
that turn your TV into a place to catch up 
on news, sports results and even do some 
shopping. If it’s games you’re into, Apple TV 
is also a console with a clever remote that 
gives you motion control via a gyroscope 
and an accelerometer, just like your iPhone. 

The top area of the remote is dedicated 
to touch, meaning you can control your 

Apple TV like never before. So it’s all gesture-based; tap and swipe your 
way through menus and use it as a scrubber for speeding through 
video. There’s Siri in the new Apple TV too, which looks very clever at 
responding to natural language queries.

Your guide to buying a Mac, iPad, iPhone, Watch and Apple TV

Apple TV

As expected, 
Apple unveiled 
an all-new Apple 
TV, with a clever 

remote, at the September 
event that also brought us 
the iPhone 6s and 6s Plus 
and iPad Pro. Apple TV 
hadn’t been updated since 
2012, so it was more than 
overdue. Luckily, it’s been 
well worth the wait. It’s no 
longer just a great place to 
watch TV and show off 
your photos on the big 
screen, as it now supports 
apps and games to make it a 
proper entertainment hub.

The Apple kit we’re most excited about

Model Key specifications Price

Apple TV (3rd- 
generation)

Processor: single-core A5
Connectivity: HDMI, IR receiver, 
10/100BASE-T Ethernet, micro-USB 
(for service only)

£59

Apple TV (4th- 
generation)

Processor: dual-core A8
Connectivity: HDMI 1.4, IR receiver, 
Bluetooth 4.0, 10/100BASE-T 
Ethernet, USB-C (for service only)

32GB: TBC
64GB: TBC

choose an aPPLe TV

Days since  
RefResh

UPDaTe LiKeLy?

Recently updated

BUy oR waiT?

Buy now

6
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The Days Since Refresh box shows you when an Apple product was last updated at the time 
we went to press, and whether it’s safe to buy now or wait. Please remember this advice is 
just our best guess – Apple can update any product line at any time.



MacBook

UPDaTe LiKeLy?

BUy oR waiT?

Days since  
RefResh

New model

Buy now

The newest member of the Mac 
family sports a 12-inch Retina 

display with a pixel density of 226ppi – 
almost identical to the MacBook Pro. 
It’s available in the same silver colour as 
other MacBooks, as well as Gold and 
Space Grey variants. 

Only this and the MacBook Pro feature 
a Force Touch trackpad, which detects 
and responds differently to levels of 
pressure. The backlit keys are larger than 
on other Macs, and run almost from 
edge to edge of the MacBook’s body.

The MacBook is powered by Intel’s 
new Core M processors (up to 1.3GHz), 

which are designed to stay cool without needing a fan, making this 
the quietest portable Mac. All models come with 8GB of RAM – 
double the amount that’s standard on the MacBook Air – but can’t 
be upgraded any further than that. They also include fast flash 
storage that starts at a comfortable capacity of 256GB, rising to 
512GB in the more expensive version. The 1.3GHz processor 
upgrade is available on both models for between £120 and £200.

190

Model Key specifications Price

12” 1.1GHz 
dual-core  
Intel Core M

RAM: 8GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 5300
Solid State Drive: 256GB

£1,049

12” 1.2GHz 
dual-core  
Intel Core M

RAM: 8GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 5300
Solid State Drive: 512GB

£1,299

12” 1.3GHz 
dual-core  
Intel Core M

RAM: 8GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 5300
Solid State Drive: 256GB or 512GB

£1,249 or 
£1,419

choose a macbook

R

R

R

UPgrade!
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MacBook Air

UPDaTe LiKeLy?

BUy oR waiT?

Days since  
RefResh

Recently updated

Buy now

The 2015 MacBook Air refresh is 
a mere speed bump, yet even 

with the announcement of a new, 
lighter MacBook, the Air remains 
Apple’s most affordable portable Mac.

The MacBook Air uses Broadwell 
processors, which are designed to 
use very little power. The 2015 range’s 
updated graphics chipset is a small 
amount faster than its predecessor, and 
its flash storage can reach speeds in 
excess of 1,000 megabytes per second, 
which is in the same league as the 
Mac Pro. The MacBook Air is equipped 
with 802.11ac Wi-Fi, which is up to 

three times quicker than 802.11n, although you will need 
a compatible router to get that speed. Battery life is awesome, 
with the 13-inch models lasting up to 12 hours, and the 11-inch 
Airs running for up to nine hours on a single charge. 

190

Model Key specifications Price

11” 1.6GHz 
dual-core  
Intel Core i5

RAM: 4GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 6000
Solid State Drive: 128GB

£749

11” 1.6GHz 
dual-core  
Intel Core i5

RAM: 4GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 6000
Solid State Drive: 256GB

£899

13” 1.6GHz 
dual-core  
Intel Core i5

RAM: 4GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 6000
Solid State Drive: 128GB

£849

13” 1.6GHz 
dual-core  
Intel Core i5

RAM: 4GB of 1600MHz LPDDR3
Graphics: Intel HD Graphics 6000
Solid State Drive: 256GB

£999

choose a macbook aIR

R  = Retina display



choose an iMac

Model Key specifications Price

21.5” 1.4GHz 
dual-core  
Intel Core i5

Hard drive: 500GB (5400rpm)
Graphics: Intel HD Graphics 5000
Graphics memory: Shared

£899

21.5” 2.7GHz 
quad-core  
Intel Core i5

Hard drive: 1TB (5400rpm)
Graphics: Intel Iris Pro
Graphics memory: Shared

£1,049

21.5” 2.9GHz 
quad-core  
Intel Core i5

Hard drive: 1TB (5400rpm) 
Graphics: NVIDIA GeForce GT 750M
Graphics memory: 1GB of GDDR5

£1,199

27”  3.2GHz 
quad-core  
Intel Core i5

Hard drive: 1TB (7200rpm)
Graphics: NVIDIA GeForce GT 755M
Graphics memory: 1GB of GDDR5

£1,449

Retina 5K 27” 
3.3GHz quad-
core i5

Hard drive: 1TB (7200rpm) 
Graphics: AMD Radeon R9 M290
Graphics memory: 2GB of GDDR5

£1,599

Retina 5K 27” 
3.5GHz quad-
core i5

Hard drive: 1TB Fusion Drive
Graphics: AMD Radeon R9 M290X
Graphics memory: 2GB of GDDR5

£1,849R

UPDaTe LiKeLy?

BUy oR waiT?

Days since  
RefResh

Early 2016?

Wait if you can

Apple leapt straight to 5K to make 
the 27-inch Retina 5K iMac the 

desktop computer to own. In May 2015, 
Apple reduced the top model’s price by 
£150; it has a 3.5GHz quad-core Intel 
Core i5 (there’s a 4.0GHz Core i7 option), 
a 1TB Fusion Drive, 8GB of RAM and an 
AMD Radeon R9 M290X with 2GB video 
memory. At the same time Apple 
updated the mid-range 27-inch with 
a Retina 5K display and new graphics 
processor. Other models are unchanged, 
with one non-Retina 27-inch and three 
21.5-inch models. All except the entry-
level iMac have a quad-core processor.
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UPGRADE!
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choose a macbook pro

Model Key Specifications Price

13” 2.5GHz 
dual-core i5

Graphics: Intel HD Graphics 4000 
Hard drive: 500GB RAM: 4GB

£899

13” 2.7GHz 
dual-core i5

Graphics: Intel Iris 6100 Graphics 
Solid State Drive: 128GB RAM: 8GB

£999

13” 2.7GHz 
dual-core i5

Graphics: Intel Iris 6100 Graphics 
Solid State Drive: 256GB RAM: 8GB

£1,199

13” 2.9GHz 
dual-core i5

Graphics: Intel Iris 6100 Graphics 
Solid State Drive: 512GB RAM: 8GB

£1,399

15” 2.2GHz 
quad-core i7

Graphics: Intel Iris Pro Graphics 
Solid State Drive: 256GB RAM: 16GB

£1,599

15” 2.5GHz 
quad-core i7

Graphics: AMD Radeon R9 M370X
Solid State Drive: 512GB RAM: 16GB

£1,999

R

R

R

R

R

Apple recently updated the Retina 
MacBook Pro with a brand-new 

Force Touch trackpad, small boosts to 
their Intel processors, and upgraded 
graphics capabilities. The most 
expensive model is the only one with 
a discrete graphics processor, which is 
now an AMD Radeon R9 M370X.

 Since October 2013, all but one 
model of MacBook Pro has offered 
a Retina display, Thunderbolt 2, flash 
storage and a lightweight chassis, 
though the £899 non-Retina model 
persists. Power savings afforded by the 
latest Intel processors give the Retina 

MacBook Pros a long battery life. The 13-inch model now lasts for 
10 hours, and the 15-inch versions for nine hours.

Days since  
RefResh

UPDaTe LiKeLy?

Recently updated

BUy oR waiT?

Buy now

119

R  = Retina display

MacBook Pro



UPDaTe LiKeLy?

BUy oR waiT?

Days since  
RefResh

Recently updated

Buy now

6

R

R

R

R

R

UPgrade!
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Mac mini
The smallest Mac in Apple’s range 
finally got a long-awaited update 

in October. It’s a welcome update, but 
there have been a few odd choices in 
the components as well. Starting at 
a new lower price of £399 (£100 
cheaper than the previous model), it’s 
still the same shape as before, but with 
some more modern internals. 

It starts with a 1.4GHz Intel Core i5 
dual-core processor with Intel HD 5000 
graphics, 4GB of RAM and a 500GB 
hard drive – pretty much the entry-
level iMac without a screen. It’s the 
same kind of power as you get in a 

MacBook Air, but without the zippiness of flash memory.
 Higher end models bring Intel Iris graphics and the option for 
a Fusion Drive hybrid storage system, though every option limits 
you to dual-core processors – a quad-core option is sadly absent. 
When stepping up to the high-end model (£230 more than the 
previous model), you get a 2.8GHz Core i5, 8GB of RAM, Intel Iris 
graphics and a 1TB Fusion Drive, offering more headroom for 
tasks such as video editing, but it still needs to be accepted that 
these aren’t powerhouses like some other Macs.

Days since  
RefResh

UPDaTe LiKeLy?

Mid 2016?

BUy oR waiT?

Buy now

364

Model Key specifications Price

1.4GHz 
dual-core 
Intel Core i5

Hard drive: 500GB
RAM: 4GB 1600MHz LPDDR3 
Graphics: Intel HD Graphics 5000

£399

2.6GHz  
dual-core 
Intel Core i5

Hard drive: 1TB
RAM: 8GB 1600MHz LPDDR3 
Graphics: Intel Iris Graphics

£569

2.8GHz  
dual-core 
Intel Core i5

Hard drive: 1TB
RAM: 8GB 1600MHz LPDDR3
Graphics: Intel Iris Graphics

£799

choose a mac mini

iPhone
The iPhone 6s and 6s Plus 
introduce the first new method 

of interaction since the touchscreen: 
3D Touch. It’s essentially the same 
Force Touch sensation found in the 
Apple Watch and recent MacBooks. 
In iOS 9 on these iPhones, you access 
shortcuts through a deep press on the 
screen. For example, you can ‘peek’ at a 
message in Mail to preview its content, 
and ‘pop’ it open to deal with it.

The 12 megapixel camera gives you 
the best ever iPhone shots. The 6s Plus 
still has the upper hand here with its 
optical image stabilisation. 

Meanwhile, the 6 and 6 Plus enjoy a price drop and the 5s is 
now under £400 off contract, and free on many contract deals.

Model Key specifications Price

iPhone 5s Processor: A7+M7
Camera: 8-megapixel  
Video: 1080p, 30fps/720p, 120fps

16GB: £379
32GB: £419

iPhone 6 Processor: A8+M8
Camera: 8-megapixel
Video: 1080p, 60fps/720p, 240fps

16GB: £459
64GB: £539

iPhone 6 Plus Processor: A8+M8
Camera: 8-megapixel
Video: 1080p, 60fps/720p, 240fps

16GB: £539
64GB: £619

iPhone 6s Processor: A9+M9
Camera: 12-megapixel
Video: 4K at 30fps/1080p, 30/60fps

16GB: £539
64GB: £619

128GB: £699

iPhone 6s Plus Processor: A9+M9
Camera: 12-megapixel
Video: 4K at 30fps/1080p, 30/60fps

16GB: £619
64GB: £699
128GB: £789

choose an iPhone

R  = Retina display



R  = Retina display

The iPad Pro stole the show at 
Apple’s September event in 

San Francisco. It’s an incredible tablet – 
turn to page 10 to read all about it. 
As for the ‘normal’ iPad lineup, little has 
changed apart from the introduction of 
the iPad mini 4, a direct replacement 
for the iPad mini 3 – which finally puts 
the 7.9-inch iPad on par with the full 
size model again.

That’s good news in iOS 9, because 
both sizes of iPad can take advantage 
of its new (iPad-only) multitasking 
features, enabling you to slide a second 
app into view (say, to check email) 
without leaving the one you’re working 

in. The iPad Air 2 and iPad mini 4 also have Split View mode, 
which enables you to work in two apps side-by-side. Those two 
models also feature Touch ID, Apple’s fingerprint sensor.

iPad

R

R

R

R

Model Key specifications Price

iPad mini 2 
Wi-Fi (add 
£100 for 4G)

Resolution: 2048x1536 pixels
Processor: 64-bit A7+M7
Video recording: 1080p HD

16GB: £219
32GB: £259

iPad mini 4 
Wi-Fi (add 
£100 for 4G)

Resolution: 2048x1536 pixels
Processor: 64-bit A8+M8
Video recording: 1080p HD

16GB: £319
64GB: £399
128GB: £479

iPad Air
Wi-Fi (add 
£100 for 4G)

Resolution: 2048x1536 pixels
Processor: 64-bit A7+M7
Video recording: 1080p HD

16GB: £319
32GB: £359

iPad Air 2
Wi-Fi (add 
£100 for 4G)

Resolution: 2048x1536 pixels
Processor: 64-bit A8X+M8
Video recording: 1080p HD

16GB: £399
64GB: £479
128GB: £559

choose an iPad

Days since  
RefResh

UPDaTe LiKeLy?

9.7-inch in 2016?

BUy oR waiT?

6

Buy now

UPGRADE!
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UPDaTe LiKeLy?

BUy oR waiT?

Days since  
RefResh

Not until 2016

Buy now

Apple Watch
Apple Watch just got watchOS 2 
to go with iOS 9 on the iPhone. 

To accompany the update Apple has 
released some changes to the Watch 
line-up, although no new editions have 
been introduced; it’s still Sport, Watch 
and Edition you can choose from.

The biggest changes to the line-up 
are at the Sport end of things, as you 
might expect when they are the most 
affordable. Alongside the silver and 
black aluminium versions, you can now 
order Gold and Rose Gold watches 
(which have matte finishes as opposed 
to shiny ones). There’s a range of new 

Sport Bands to go along with the new Sport watches, including 
two versions of white! A Product(RED) band also joins the lineup.

144

choose a watch

Model Key Specifications Price

Apple Watch Sport 
(38mm)

Cases: Silver, Gold, Rose Gold, 
Space Grey Aluminium

£299

Apple Watch Sport 
(42mm)

Cases: Silver, Gold, Rose Gold, 
Space Grey Aluminium

£339

Apple Watch 
(38mm)

Cases: Stainless Steel,  
Space Black

£479

Apple Watch 
(42mm)

Cases: Stainless Steel,  
Space Black

£519

Apple Watch 
Edition (38mm)

Cases: 18-Carat Rose Gold, 
18-Carat Yellow Gold

£8,000

Apple Watch 
Edition (42mm)

Cases: 18-Carat Rose Gold, 
18-Carat Yellow Gold

£9,500
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Don’t miss it – subscribe today!
oN your mac
Read on the big screen:  
subscribe with Zinio at
zinio.com/macformat

IN prINt & oN your ipad
Our print and digital bundle gets you the real 

magazine as well as our enhanced iPad edition
myfavouritemagazines.co.uk/macformat

Enhanced interactive features are iPad-only, and not available when viewed on an iPhone.

El Capitan
masterclass
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Your Mac’s new OS is finally here and 
we’ve uncovered the secret features 
that make your Mac better than ever
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It’s safe to say that Apple’s earbuds have their 
critics. Some people reckon they sound rubbish; 
others, that they fall out too easily, making them 
useless for exercising. And some people, such as 
your humble correspondent, find them 

excruciatingly uncomfortable. Recently revealed patents show 
that Apple might be addressing all of those things, and adding 
some additional good ideas too.

In US Patent Application 20150245129, filed last year, Apple 
described a “System and method of improving voice quality in 
a wireless headset with untethered earbuds of a mobile device”. 
The earbuds – which would be wireless, connecting via 
Bluetooth – would use sensors to monitor the user’s voice, the 
ambient noise around them and noises such as wind, and then 
they would adjust the sound to compensate. It’s rather like 
noise‑cancelling circuitry but a lot more detailed.

That’s not the only thing Apple wants to stick in your ears. 
Twin patents filed in late 2012, “Ear Presence Detection in Noise 
Cancelling Earphones” and “Electronic Devices and Accessories 

with Media Streaming Control Features”, describe sensors that 
can tell whether they’re in your ear or out, starting and stopping 
playback accordingly to ensure you don’t waste power on playing 
things you aren’t listening to. Apple has also been granted a 
patent for a “Sports monitoring system for headphones, earbuds 
and/or headsets”, biometric headphones that can detect your 
body temperature, your heart rate and even how much you’re 
sweating. Apple patent applications on earbud‑based health 
sensors date back to 2007, which shows just how long the 
company has been thinking about all of this.

Of course, there’s no point in stuffing earbuds full of sensors 
if they fall out too easily or if they are so uncomfortable that you 
don’t want to wear them. That’s where US Patent Application 
US20140076657, “Invertible Ear Tips for an Ear Piece”, comes in. 
In the filing, Apple details how a ‘compliant element operative’ 
could be inserted in your ear “such that the compliant element 
deforms to retain the ear piece in the user’s ear.” In plain English, 
that means the earbuds would have a bendy bit so they don’t fall 
out. That sounds like a good idea to us.

SPY

Apple wireless 
earbuds

Gary Marshall goes panning in the  
river of rumour for nuggets of knowledge

There’s no point in stuffing 
earbuds full of sensors if 
they fall out easily or they’re 
too uncomfortable to wear.
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